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1.1 INTRODUCTION 

 

After studying this unit, you should be able to understand: 

⚫ Define a computer and its various parts. 

⚫ Classify computer according to purpose, technology used, size and capacity. 

⚫ Describe various characteristics of computer. 

⚫ Describe various Input and output devices. 

⚫ Understand the concept of Office Automation. 

⚫ Describe various components of a computer system. 

⚫ Describe various generations of the computer. 

Nothing has revolutionized modern life the way rapid progress of computers has. For better or worse, 

computers have infiltrated every aspect of our society. Today, computers do much more than simply 

compute. They make airline or railway reservation and teach on-line; some super store scanners 

calculate our grocery bills while keeping the store inventory; computerised telephone switching has 

greatly improved the telephone system and Automatic Teller Machines (ATM) let us conduct banking 

transactions from virtually anywhere in the world. 

As computers become more widespread in the workplace, new ways to harness their potential 

developed. As smaller computers become more powerful, they could be linked together, or networked, 

to share memory space, software, and information and communicate with each other. 

1.2 WHAT IS A COMPUTER?  

In a laymans language, a computer is a fast calculating device that can perform arithmetic operations. 

Although the computer was originally invented mainly for doing high speed and accurate calculations, it 

is not just a calculating device. The computer can perform any kind of work involving arithmetic and 

logical operations on data. It gets the data through an input device, processes it as per the instructions 

1.0 LEARNING OBJECTIVES 
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given and gives the information as an output. We can define computer as follows: 

Definition 

A computer is a fast electronic device that processes the input data according to the instructions given 

by the programmer/user and provides the desired information as an output. 

The terminology used in the above definition is summarized in Table 1.1. 

 

 

 

 

  

 

1.3 IMPORTANCE OF COMPUTERS (MAN VS. MACHINE) 

Computers play a vital role for processing of data in an organization. Computer: help in processing the 

volumes of data efficiently and accurately within a short time. A computer has the following 

characteristics which make it so important for an organization: 

1. Fast: A computer is so fast that it can perform the given task (arithmetical or logical) in few 

seconds as compared to man who can spend many months for doing the same task. A computer can 

process millions of instructions per second. 

2. Accurate: While doing calculations, a computer is more accurate than man can make mistakes in 

calculations but a computer does not make mistakes, if it is provided accurate instructions. 

3. Diligence: A computer does not suffer from the human traits of tiredness and boredom. Man will be 

tired and bored while doing millions of calculations but a computer, being a machine, does this job 

very efficiently and without any tiredness and boredom. 
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4. High Memory: A computer has much more memory or storage capacity than human being. It can 

store millions of data and instructions, which can be retrieved and recalled even after a number of 

years. This is not possible in case of human brain. 

5. No Intelligence: A computer is a machine and obviously has no intelligence of its own. Each and 

every instruction must be given to the computer for doing a task. Man has intelligence and it is the man 

who invented computer and gives it all the instructions and logic to work. A computer cannot take 

decisions on its own and it is the main drawback of computer. 

1.4 CLASSIFICATION OF COMPUTERS 

The classification of computers is based on the following three criteria: 

(a) According to Purpose 

(b) According to Technology used 

 (c) According to size and Capacity 

Based on these criteria, the classification of computers is illustrated in Figure 1.1 and discussed below: 

 

 

 

 

 

 

 

 

Figure 1.1 : Classification of Computers Based on Different Criteria 

According to Purpose 

According to the utilization of computer for different uses, computers are of following two types: 
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1. General Purpose Computers: Computers that follow instructions for general requirements such 

as sales analysis, financial accounting, invoicing, inventory, management information etc. are 

called General Purpose Computers. Almost all computers used in offices for commercial, 

educational and other applications are general purpose computers. 

 

2. Special Purpose Computers: Computers designed from scratch to perform special tasks like 

scientific applications and research, weather forecasting, space applications, medical diagnostics 

etc. are called Special Purpose Computers. 

According to Technology Used 

According to the technology used, computers are of following three types: 

1. Analog Computers: Analog computers are special purpose computers that represent and store 

data in continuously varying physical quantities such as current, voltage or frequency. These 

computers are programmed for measuring physical quantities like pressure, temperature, speed etc. 

and to perform computations on these measurements. Analog computers are mainly used for 

scientific and engineering applications. Some of the examples of analog computers are given 

below: 

(i) Thermometer: It is a simple analog computer used to measure temperature. In thermometer, 

the mercury moves up or down as the temperature varies. 

(ii) Speedometer: Car's speedometer is another example of analog computer where the position of 

the needle on the dial represents the speed of the car. 

2. Digital Computers: Digital computers are mainly general purpose computers that represent and 

store data in discrete quantities or numbers. In these computers, all processing is done in terms of 

numeric representation (Binary Digits) of data and information. Although the user enter data in 

decimal or character form, it is converted into binary digits (0's and l's). Almost all the computers 

used nowadays are digital computers and we will discuss the detailed working and components of 

these computers in subsequent sections of this unit. 
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3. Hybrid Computers: Hybrid computers incorporate the technology of both analog and digital 

computers. These computers store and process analog signals which have been converted into 

discrete numbers using analog-to-digital converters. They can also convert the digital numbers into 

analog signals or physical properties using digital-to-analog converters. Hybrid computers are 

mainly used in artificial intelligence (robotics) and computer aided manufacturing (e.g. process 

control). 

According to Size and Capacity 

According to the size and memory/storage capacity, computers are of following four types: 

1. Supercomputer: Supercomputer is the biggest and fastest computer, which is mainly designed for 

complex scientific applications. It has many CPUs (Central Processing Units - main part of 

computer) which operate in parallel to make it as a fastest computer. It is typically used for the 

following applications: 

⚫ Weather Forecasting 

⚫ Petroleum Exploration and Production 

⚫ Energy Management 

⚫ Defense 

⚫ Nuclear Energy Research 

⚫ Structural Analysis 

⚫ Electronic Design 

⚫ Real-time Animation 

⚫ Medicine 

Some of the examples of supercomputers are CRAY3, CRAY-XMP-14, NEC500, P ARAM 9000 and P 

ARAM 10000. 

2. Mainframe Computer: Mainframe computers are very large and fast computers but smaller and 

slower than supercomputers. These are used in a centralized location where many terminals 

(input/output devices) are connected with one CPU and thus, allow different users to share the 
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single CPU. They have a very high memory (several hundred Megabytes) and can support 

thousands of users. They are mainly used for following applications: 

⚫ Railway and Airline Reservations 

⚫ Banking Applications 

⚫ Commercial Applications of Large Industries/Companies 

Some of the examples of mainframe computers are IBM 3090, IBM 4381, IBM 4300 and IBM ES-

9000. 

3. Minicomputer: Minicomputers are medium-scale, smaller and generally slower than mainframe 

computers. Like mainframes, they have many terminals which are connected with one CPU and 

can support many users. The cost of minicomputer is very less as compared to mainframe. 

Therefore, it is mainly used in applications where processing can be distributed among several 

minicomputers rather than using a mainframe computer. 

Some of the examples of minicomputers are PDP-1, IBM AS/400 and DEC Micro VAX. IBM 

AS/400, which is actually a midicomputer (computer with performance between a mainframe and 

minicomputer) is becoming very popular among minicomputers. 

4. Microcomputer: A microcomputer is the smallest digital computer, which uses a 

microprocessor as its CPU. Microprocessor is a single chip (Integrated Circuit) CPU. 

Microcomputer is popularly called as Personal Computer (PC). It can be used both as a stand-alone 

machine and a terminal in a multi-user environment. Microcomputers are becoming very popular 

nowadays due to very high processing power and memory. Today, a powerful microcomputer may 

be used as a substitute for mini or mainframe computer. 

Microcomputers are either of desktop or portable model. Portable computers can be carried from 

one place to another. Some of the models are called as laptops while others as notebook computers. 

Notebook computers are smaller, lighter and costlier than laptops. Desktop computers fit on a 

desktop and are used widely in offices and homes. The pictures of some of the desktop and 

portable computers are shown in Figure 1.2. 
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Figure 1.2: Some Desktop and Portable Computers 

There are many types and models of microcomputers, which are summarized in Table 1.2. 

Table 1.2: Different Types of Microcomputers along with the Technical Specifications of CPU 

 

CPU Model 

Cl oc k 

(MHz) 

Date 

B u s 

Register 

(BIT) 

Max. 

M emory 

(RAM) C omme nt s 

8088 8 8 16 1 MB First 8 bit microprocessor 

     (Original PC) 

8086 8 16 16 1 MB First 16 bit CPU on a chip 

     (PC/XT )* 

80286 20 16 16 16 MB 5 times faster than PC/XT 

     (PC/AT )** 

80386 SX 33 16 32 16MB 80386 with an 80286 bus 

80386 DX 40 32 32 4 GB True 32 bit CPU on a chip 

80486 SX 40 32 32 4 GB Math co-processor disabled 
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80486DX2 66 32 32 4 GB More speed with Math 

     co-processor enabled 

80486 DX4 100 32 32 4 GB More speed than 486 DX2 

Pentium Pro 200 64 32 4 GB Superscope architecture 

(P5)     Able to execute 2 instructions 

     simultaneously 

Pentium II (P6) 266 64 32 64 GB Faster than Pentium Pro 

      

1.5 POPULARITY OF PERSONAL COMPUTERS (IBM PC VS. APPLE  MAC PC) 

IBM PC is the first personal computer, introduced in 1981 by the world's largest computer company - 

IBM (International Business Machines Corp., New York). This computer was based on Intel's 8088 

microprocessor or chip. It became a success almost overnight. In later years, IBM manufactured 80286, 

80386, 80486 and recently the Pentium PCs. Although IBM is still the largest supplier of PCs, the 

majority of PCs are manufactured by other companies as per the standards set by IBM. This whole 

family of PCs is known as IBM-compatible PCs. 

So, whenever we talk about a Pc, it usually means one of the IBM-compatible PCs. PS/2 and PS/1 (PS 

stands for Personal System) are IBM computer series introduced in 1987 and 1990 respectively. 

Apple Macintosh PC (popularly called as Mac) is another series of 32-bit personal computers, 

introduced in 1984 by one of the first microcomputer manufacturing company - Apple (Apple 

Computer, Inc.). Apple is the largest independent manufacturer of non-IBM-compatible PCs. Apple 

Mac PC uses the Motorola (a leading manufacturer of semiconductor devices) 68000 processor family 

and a proprietary operating system. As this PC comes with its own operating system, there is no need of 

DOS or other operating system for operating it. The method of operating a Mac PC is known as 

Macintosh user interface. All Mac PCs have graphics displays, as their operating systems provide 

Graphical User Interface (GUI). The Mac PC always displays a row of menu titles at the top of the 

screen, from which options are selected. 
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Although the first Mac PC was praised by many users due to its ease of use and low-cost system, it was 

not exciting for most corporate buyers due to its slow speed, small screen and closed architecture (a 

system whose technical specifications are not made public). In 1987, Apple manufactured Mac II, 

which offers full-size screens, high-speed and open architecture (a system whose technical 

specifications are made public). In 1991, IBM formed an alliance with Apple to fully integrate Macs 

into IBM enterprise networks for developing PowerPC with Motorola. 

IBM-compatible PCs are used as stand-alone machines or as workstations/ file servers in a local area 

network (we will discuss about local area network in later part of this unit). These PCs are very popular 

as stand-alone systems, which run under DOS. IBM-compatible PCs (80486 & above) are also popular 

for using as client/server systems (we will also discuss about client/server systems in later part of this 

unit). On the other hand, Apple/Macintosh PCs are rarely used as the primary client computers in 

client/server systems. Macintosh PCs are useful mainly for desktop publishing systems, due to 

graphical user interface. IBM compatible PCs, on the other hand, are useful for any kind of business 

applications. They have become very popular among all users in India and abroad. 

1.6 ARCHITECTURE OF A COMPUTER SYSTEM 

In last section, we discussed that there are many types of computers. The internal architectural design of 

computers differ from one model to another, however the basic components of a computer remains the 

same for all models. The diagram of a generalized architecture of a computer system is shown in Figure 

1.3. Before discussing the details of computer architecture, we would define the computer system as 

follows: 

Definition 

A complete computer installation including the central processing unit, the peripherals such as hard disk 

drives, floppy disk drives, monitor, printer, mouse and operating system which are designed to work 

and interact with each other and with the user is called a computer system. 
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Figure 1.3: Functional Diagram of a Generalised Architecture of a Computer System 

A computer system has following three main components: 

(a) Input/Output Unit 

(b) Central Processing Unit 

(c) Memory Unit 

Input/Output Unit 

We know that the computer is a machine that processes the input data according to given set of 

instructions and gives the output. Before a computer does processing, it must be given data and 

instructions. After processing, the output must be displayed or printed by the computer. The unit used 

for getting the data and instructions into the computer and displaying or printing output is known as an 

Input/Output Unit (I/O Unit). 

The Input Unit is used to enter data and instructions into a computer. There are many peripheral devices 

which are used as input/output units for the computer. The most common form of input device is known 

as a terminal. A terminal has a electronic typewriter like device, called keyboard along with a display 

screen, called Visual Display Unit (VDU) or monitor. Keyboard is the main input device while monitor 

can be considered both as an input as well as an output device. There are some other common input 

devices like mouse, punched card, tape, joystick, scanner, modem etc., which are explained in later part 

of this unit. Monitor, printer and plotter are the main peripheral devices used as output units for the 

computer. 

Central Processing Unit 
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Central Processing Unit (CPU) is the main component or "brain" of a computer, which performs all the 

processing of input data. Its function is to fetch, examine and then execute the instructions stored in 

main memory of computer. In microcomputers, the CPU is built on a single chip or Integrated Circuit 

(IC) and is called as Microprocessor. The CPU consists of following distinct parts: 

1. Arithmetic Logic Unit (ALU): The arithmetic and logic unit of CPU is responsible for all 

arithmetic operations like addition, subtraction, multiplication and division as well as logical 

operations such as less than, equal to and greater than. Actually, all calculations and comparisons 

are performed in the arithmetic logic unit. 

2. Control Unit (CU): The control unit is responsible for controlling the transfer of data and 

instructions among other units of computer. It is considered as a "Central Nervous System" of 

computer, as it manages and coordinates all the units of computer. It obtains the instructions from 

the memory, interprets them and directs the operation of the computer. It also performs the 

physical data transfer between memory and the peripheral device. 

3. Registers: Registers are the small high speed circuits (memory locations) which are used to store 

data, instructions and memory addresses (memory location numbers), when ALU performs 

arithmetic and logical operations. Registers can store one word of data (1 word = 2 bytes & 1 byte 

= 8 bit; details of BITS and BYTES are discussed in later part of this unit) until it is overwritten by 

another word. Depending on the processor's capability, the number and type of registers vary from 

one CPU to another. Registers can be divided into six categories viz. General Purpose Registers, 

Pointer Registers, Segment Registers, Index Registers, Flags Registers and Instruction. Pointer 

Registers, depending upon their function. The detailed functions of each and every register is 

beyond the scope of this book. 

4. Buses: Data is stored as a unit of eight bits (BIT stands for Binary Digit i.e. (0 or 1) in a register. 

Each bit is transferred from one register to another by means of a separate wire. This group of eight 

wires, which is used as a common way to transfer data between registers is known as a bus. In 

general terms, bus is a connection between two components to transmit signal between them. Bus 

can be of three major types viz. Data Bus, Control Bus and Address Bus. The data bus is used to 

move data, address bus to move address or memory location and control bus to send control signals 

between various components of a computer. 
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5. Clock: Clock is another important component of CPU, which measures and allocates a fixed time 

slot for processing each and every micro-operation (smallest functional operation). In simple 

terms, CPU is allocated one or more clock cycles to complete a micro-operation. CPU executes the 

instructions in synchronization with the clock pulse. 

The clock speed of CPU is measured in terms of Mega Hertz (MHz) or Millions of Cycles per 

second. The clock speed of CPU varies from one model to another in the range 4.77 MHZ (in 8088 

processor) to 66 MHz (in Pentium) CPU speed is also specified in terms of Millions of Instructions 

Per Second (MIPS) or Million of Floating Point Operations Per Second (MFLOPS). 

Memory Unit 

Memory Unit is that component of a computer system, which is used to store the data, instructions and 

information before, during and after the processing by ALU. It is actually a work area (physically a 

collection of integrated circuits) within the computer, where the CPU stores the data and instructions. It 

is also known as a Main/Primary/Internal Memory. It is of following three types: 

(a) Read Only Memory (ROM pronounced as “Ra-om”) 

(b) Random Access Memory (RAM pronounced as "R-aem") 

(c) Complementary Metal Oxide Semiconductor Memory (CMOS) 

(a) Read Only Memory: Read Only Memory is an essential component of the memory unit. We 

know that the computer, being a machine, itself has no intelligence or memory and requires the 

instructions which are given by man. Whenever the computer is switched on, it searches for the 

required instructions. The memory, which has these essential instructions, is known as Read Only 

Memory (ROM). This memory is permanent and is not erased when system is switched off. As 

appears with its name, it is read type of memory i.e. it can be read only and not be written by 

user/programmer. The memory capacity of ROM varies from 64 KB to 256 KB (1 Kilobyte = 1024 

bytes) depending on the model of computer. 

ROM contains a number of programs (set of instructions). The most important program of ROM is 

the Basic Input Output System (BIOS, pronounced as "bye-os") which activates the hardware 

(physical components of computer) such as keyboard, monitor, floppy disk etc. in communicating 
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with the system and application software (set of instructions or programs). 

Types of ROM: There are many types of ROM available for microcomputers like Mask ROM, 

PROM, EPROM, EEPROM and EAPROM. 

D e f i n i t i o n s 

Mask ROM: Mask ROM is the basic ROM chip. In this type of ROM, the information is 

stored at the time of its manufacturing. So, it cannot be altered or erased later on. 

PROM: PROM stands for Programmable Read Only Memory. In this type of ROM, the 

information is stored by programmers after its manufacturing. It cannot be altered or erased 

later on. 

EPROM: EPROM stands for Erasable Programmable Read Only Memory. It is similar to 

PROM, but its information can be erased later on by ultra violet light and it can be 

reprogrammed. 

EEPROM: EEPROM stands for Electrically Erasable Programmable Read Only Memory. 

It is similar to EPROM, but its information can be erased by using a high voltage current. 

EAPROM: EAPROM stands for Electrically Alterable Read Only Memory. As compared 

to EPROM and EEPROM, the information stored in EAPROM can be altered later. 

(b) Random Access Memory: Random Access Memory (RAM) is another important component of 

Memory Unit. It is used to store the data and instructions during the execution of programme. 

Contrary to ROM, RAM is temporary and is erased when computer is switched off. RAM is a 

read/write type of memory and, thus can be read and written by user/programmer. As it is possible 

to randomly use any location of this memory, therefore, this memory is known as random access 

memory. The memory capacity of RAM varies from 640 KB to several megabytes (1 Megabyte = 

1024 KB) with different models of Pc. 

Types of RAM: There are two types of RAM used in PCs - Dynamic and Static RAM. 

Dynamic RAM (DRAM): The information stored in Dynamic RAM has to be refreshed after 

every few milliseconds, otherwise it is erased. DRAM has higher storage capacity and is cheaper than 

Static RAM. 
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Static RAM (SRAM): The information stored in Static RAM need not be refreshed, but it 

remains stable as long as power supply is provided. SRAM is costlier but has higher speed than 

DRAM. 

(c) Complementary Metal Oxide Semiconductor Memory: Complementary Metal Oxide 

Semiconductor (CMOS) memory is used to store the system configuration, date, time and other 

important data. When computer is switched on, BIOS matches the information of CMOS with the 

peripheral devices and displays error in case of mismatching. 

1.7 COMPUTERS IN BUSINESS 

Computers can process vast quantities of business data at enormous speed with unfailing consistency 

and unimaginable flexibility. These capabilities of computers open new approaches to problem solving 

and data processing. 

Following six characteristics of computers make them indispensable for use in business: 

(a) Speed: Computers speed up data processing by many orders of magnitude as compared to the 

manual system. 

(b) Data Volume: Vast amount of data can be stored and processed very quickly. 

(c) Repetitiveness: The more repetitive the task, the more profitable it is to automate it. 

(d) Complexity: Problems with several interacting variables can be solved quickly and accurately. 

(e) Accurate Output: As high accuracy can be obtained as needed; also accuracy is not affected by 

boredom and fatigue and is not Subjective. ' 

(f) Declining Costs: There has been a steady decline in the cost of per unit of data processed. 

1.8 FACILITIES AVAILABLE IN COMPUTERISED SYSTEM 

For Data Capture 

Data capture is the identification of new data to be input. It is always best to capture the 

data as soon as possible after it is originated. The commonly used input device is a 

keyboard. Mouse, joy stick, light pen, touch screen, and trackballs are some of the devices 

which do not require typing of input information. 
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On-line Mode 

Following devices are used to capture data on-line. 

Keyboard 

• A computer keyboard is a sophisticated electromechanical component designed to 

create special standardized electronic codes when a key is pressed. 

• The codes are transmitted along the cable that connects the keyboard to the computer 

system unit or terminal, where the incoming code is analyzed and converted into the 

appropriate computer usable code. 

Light Pen 

• It is a pointing device, used to select a displayed menu option on the CRT. Light pens 

are frequently used by graphics designers, illustrators, and drafting engineers. 

• It is capable of sensing a position on the CRT screen when its tip touches the screen. 

• A user can draw directly on the CRT screen with the light pen if the computer system 

is provided with Computer Aided Design (CAD) package such as AutoCad 14. 

Mouse 

• A mouse is also a pointing device. 

• As the mouse is rolled across the desktop, the cursor moves across the screen. 

• The user can select menu or command by pushing a button on the mouse once or 

twice. 

Scanners 

Scanners are a kind of input device. They are capable of entering information directly into 

the computer. 

The main advantage of direct entry of information is that users do not have to key in the 

information. 
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This provides faster and more accurate data entry. 

Important types of scanners are: 

(i) Optical scanners 

(ii) Magnetic ink character readers 

Optical Scanners 

The following are the commonly used optical scanners: 

• Optical Character Readers (OCR) 

• Optical .Mark Readers (OMR) 

• Optical Bar-Code Readers 

Terminals 

Terminals can be "dumb", "smart", or "intelligent", and are used mainly by those who do 

their work on mini or mainframe computers (or supercomputers). 

A variety of computer terminals are used to enter data, including the following popular 

types: 

• Point-of-Sale (POS) terminals 

• Financial transaction terminals 

• Executive workstations 

• Portable terminals 

• Microcomputers used as terminals 

Smart Cards 

• It contains a build-in microcomputer chip. 

• In case of smart cards, there are less chances of fraud. 

• How much cash a customer has to his credit is stored in the chip before it is issued to 
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him. 

• When the customer uses the card to make purchases, the required amount is deducted 

from the balance by a special electronic machine used by merchants. 

• The electronic machine used by merchants communicates with the card issuing 

company's computer from time to time for money transactions. Thus, a card holder 

has the facility of keeping electronic money with him. 

• When his electronic money is used up, he can replenish electronic money by 

depositing money at automated banking machine of card-issuing company. 

• A record of purchases made by the customer can also be stored in a smart card. 

Off-line Mode 

Off-line data entry involves devices through which data are recorded on some media and 

then into the computer later. 

In almost 90% of the applications, data entry is done off-line. This saves the precious 

computer processing time. 

The following devices are used to capture data off-line. 

Key-to-tape 

A Key-to-tape device, also known as magnetic tape encoder, is designed to record keyed 

data directly onto magnetic tape. 

Key-to-floppy 

These data entry machines are used to store data directly on flexible disks, called diskettes 

or floppies. 

Key-to-disk 

Used as data recording stations in systems where data from different points has to be 

recorded for processing at one point. 

For Data Validation 
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The accuracy of input data should either be verified manually or by a computer program. 

Some of the techniques used for this purpose are described below: 

Using Control Totals 

In this technique, the verification program verifies the total. 

When business transaction occurs, it is noted down and calculated at the point of 

transaction (by clerk) and the same transaction data is entered by the computer operator in 

the computer system. 

The data entered by the operator are totaled by the computer. If the two entries do not 

match, then it is a clear indication that there is a mistake. 

In this manner only correct data will be passed to the machine before processing is done. 

Using Built-in Checks by the Computer Program 

There should be some control to make sure that no data are entered which is beyond a 

certain value. 

For example, the salary cheques for a particular organization may not exceed Rs. 20,000. 

If so, then if a cheque is made for an amount more than Rs. 20,000, then computer will 

point an error. 

For Storage and Retrieval 

Once the valid data has been entered in the system, it is essential that this data is stored 

securely for future use. 

Major types of external storage devices used in computerised systems are: 

• Magnetic tapes or cartridge 

• Hard disks 

• Floppy disks 

• Compact Disk (CD) 
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For Output 

There are two basic categories of computer-produced output: 

• Output for immediate use by people, and 

• Output that is stored in computer-usable form for later use by the computer. Output 

can be in either hardcopy or softcopy form. 

(a) Hardcopy Output Devices 

The commonly used hardcopy output devices are: 

(i) Printers 

(ii) Plotter 

(iii) Microfilm/microfiche 

Printers 

These are the most popular commonly used output devices. 

• Capable of printing characters, symbols, and sometimes graphics on paper. 

• Printers are categorized according to whether the image produced is formed by 

physical contact (impact printers) or not (non-impact printers) of the print mechanism 

with the paper. 

Plotters 

⚫ A plotter is a specialized output device designed to produce high-quality graphics in a 

variety of colors. 

⚫ There are two basic types of plotters: those that use pens and those that do not. 

Drum plotters and flatbed plotters both uses pens. Electrostatic plotters do not. 

Microfilm and Microfiche 

⚫ In this technique the output from the computer is recorded on a microfilm as 

microscopic film images. The information recorded on the microfilm can be read with 
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the help of a microfilm reader. 

⚫ A microfiche (pronounced as fish, French word, which means card) is a 4 x 6 inch 

film sheet. 

⚫ It can store up to 270 pages of information. 

⚫ It is easier to read a microfiche as compared to a microfilm. 

(b) Softcopy Output Devices 

Cathode Ray Tube (CRT) 

⚫ Probably, the most popular softcopy output device. 

⚫ Used with terminals connected to large computer systems and as a monitor for 

microcomputer system. 

⚫ The CRT's screen display is made up of small picture elements, called pixels for short. 

The smaller the pixels, the better the image clarity, or resolution. 

Voice Output Systems 

• Relatively new and can be used in some situations where traditional display screen 

softcopy output is inappropriate. 

• Two different approaches to voice output have evolved, speech coding and speech 

synthesis. 

• Used in applications such as automobiles, toys, and games. 

For Transmission 

The most exciting developments in data processing today is data communication. 

Communications, the transfer of information is the basis of office automation. 

Some examples of everyday data communication are: 

Airline Reservation 

Computer is usually located far from the agent; data communication must be used to relay 
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data from the terminal to the computer and back. 

Automated Banking 

ATMs are now widely used in most banks for better customer services. The user can make 

deposits and withdrawals, check balances, and even pay utility bills through the machines. 

Point-of-Sale Terminals 

Used in retail stores, instead of cash registers. These terminals send records of sales to a 

central computer, which maintains accounting and inventory records. 

Data communication takes on several forms. These are given below: 

(a) Data can be transferred between two geographically distant personal computers by 

using modems, the dial-up telephone system, and a communications program in each 

computer. 

(b) Data can be transferred between two side-by-side computers by hooking up a cable 

from one computer's serial port to the other computer's serial port. 

(c) PC can act like a remote terminal to a mini or mainframe computer. 

(d) PC can be part of a local area network, in which software and hardware resources can 

be shared among many user. 

1.9 INDIAN COMPUTING ENVIRONMENT 

Office work includes many administrative and management activities. The preparation, 

distribution, processing and review of documents are the common activities of an 

organization. Prior to the advent-of computers, these office activities were either performed 

manually or with the help of mechanical and electrical machines. During the past few 

decades the basic nature of office has changed remarkably. Office automation deals in 

application of latest technologies in improving the overall proficiency of the office. We 

may define office automation as follows: 

Office automation is the application of computer and related technologies like 

communication and networking to integrate the general office tasks so that the efficiency 
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of office work is improved. 

Office automation does not mean just to install computers and communication devices in 

an office, but it is much more than that. We will discuss in later part of this unit, how an 

office can be automated in a real sense. 

1.10 OFFICE AUTOMATION 

Needs for Office Automation 

Although all the work of a small or big office can be performed manually, but it is very 

difficult or even impossible today for an organization to compete in the market without 

office automation. There are many essential requirements of today's office environment, 

which are listed below: 

• To reduce cost of administrative overhead; 

• To increase the efficiency of office tasks; 

• To provide better service to the customers; 

• To provide accurate information to the management; 

• To provide best and fastest way of communication. 

The above requirements cannot be achieved without using latest technologies and 

therefore, office automation is needed for an organization. 

Office Functions Needed to be Automated 

Many types of functions are performed in an office. The basic functions, which are needed 

to be automated in any office are 

1. Document Generation: In all offices, many documents are needed to be prepared, 

typed and printed. Typewriters, computers and printers are widely used in automating 

this routine task of offices. 

2. Document Processing: Documents are also needed to be processed in order to extract 

useful information required for MIS and other official purposes. Many office 
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automation tools like word processing, desktop publishing etc. are used to perform 

this task. 

3. Document Distribution: All offices require an electronic distribution system for 

transferring documents and data within and outside the organization. The main office 

automation tools for distribution of documents are Photocopiers, Teletax and Fax 

machines. 

4. Archival Storage: The office documents are also needed to be stored for a long 

period, so that they can be retrieved when required. This task is achieved by the use of 

different storage devices like tapes, disks etc. 

Office Automation Systems 

For achieving the basic functions of an office, different types of office automation systems 

are used. These systems can be broadly classified into following four types: 

1. Document Management Systems: These systems include computerised tools for 

generation, storage, processing and distribution of documents. 

2. Communication Systems: These systems are used for sending messages, documents 

and data within and outside the organization. 

3. Teleconferencing Systems: An electronic means of communication for conducting 

seminars and training programmes in an organization is achieved through various 

teleconferencing systems. 

4. Support Systems: Besides the above major office automation systems, certain 

support systems for managing the activities of work groups are also used in some 

offices. 

1.11 SUMMARY 

A computer is an electronic device that can perform a variety of operations according to the 

instructions given by the programmer/user and provides the desired information as an 

output. Computers are fast, accurate, diligent, having high memory, but no intelligence. 

Computers are classified as general purpose or special purpose computers according to the 
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purpose of their requirement. According to the technology used, computers are classified as 

analog which are used for scientific and engineering application, digital which are 

considered as general purpose computers or hybrid computers. Which incorporate the 

technology of both analog and digital computers? According to their size, computer can be 

classified as super computer, mainframe computer, minicomputer and micro computer. 

The main components of computer are input/output units central processing unit and 

memory unit. Input unit is used to enter data and instructions into a computer. CPU 

performs all the processing of input data: Memory is used to store the data, instructions and 

information before during and after the processing by ALU. Output unit makes available 

output to the users. 

CPU consists of ALU (Arithmetic Logic Unit) which is responsible for all arithmetic and 

logical operations, CU (Control Unit) which controls the transfer of data and instructions 

among other units of computer Registers, which are used to store data, instructions and 

memory addresses when ALU performs arithmetic and logical operations, Buses which are 

used to transfer data between registers and clock which measures and allocates a fixed time 

slot for processing each and every micro operation. 

Memory is the internal storage area, which holds the data and instructions during 

processing. The three types of main memory or Internal memory are RAM (Random 

Access Memory), ROM (Read Only Memory) and CMOS (Complementary Metal Oxide 

Semiconductor Memory). 

1.12 KEYWORDS 

• ALU: Arithmetic Logic Unit of a computer which is used to perform arithmetic and 

logic operations. 

• Assembler: A program which translates an assembly language program to its machine 

language equivalent. 

• Assembly Language: A low-level language for programming a computer in which 

mnemonics are used to code operations and alphanumeric symbols are used for 

addresses. 
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• Cache Memory: A small high speed memory which is used to temporarily store a 

portion of a program or data from the main memory. The processor retrieves 

instructions or data from the cache memory. Instruction and data caching speeds up 

computation. 

• Chain Printer: A printer in which the characters to be printed are embossed on a 

chain or a band. The chain is fashioned as a loop and print heads are activated to print 

specified characters. 

• Communication Channel: A medium through which (electric) signal are transmitted 

and received. 

• Compiler: A system program to translate a high level language program to machine 

language. 

• Computer: This is a machine which executes an algorithm stored in its memory to 

process data fed to it and produces the required results. 

• Control Bus: A set of wires used to transmit signals to control the operation of 

various units of a computer. 

• CPU: Central processing unit of a computer. It consists of circuits to perform 

arithmetic and logic and also has circuits to control and co-ordinate the functioning of 

the memory and I/O units of a computer. 

• Data Entry Unit: A system which a keyboard to enter data and a magnetic medium 

such as a floppy disk to store the entered data. 

• Data (Digital Audio Tape): User 4 mm wide magnetic tape in a cartridge to store 

around 4 GB of data (1994). 

• Digital Channel: A communication medium through which information in binary 

(digital) form is transmitted. 

• Disk Memory: A back up or peripheral memory in which information is stored as 

magnetized spots on the surface of disks coated with magnetic material. In hard disks 
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the disks are not flexible. In floppy disks the disks is a circular platter made of flexible 

magnetic coated plastic sheet. 

• Floppy Disk: A circular magnetic disk made of flexible plastic sheet coated with 

magnetic material. 

• Fourth Generation: Fourth Generation computers:- Computers built between 1975 

and now. They use large scale integrated circuits, semiconductor memories and 

powerful high level languages and operating systems. 

• High Level Languages: Computer language in which each statement is translated into 

many machine language statements. 

• I C: Integrated circuit. An electronic circuit fabricated on a single chip of silicon. 

• Input Unit: A part of a computer used to feed programs and data. 

• Joy Stick: A stick mounted on a spherical ball which moves in a socket. Used to more 

the cursor on the screen of a display device. 

• Laptop: A portable computer which weighs around 2 kg and runs all PC applications. 

It used a liquid crystal display and is usable by the person while traveling. 

• Light Pen: A pen shaped devices which has a lens assembly. It is pointed towards an 

image displayed on a cathode ray screen. It picks up the right and determines the 

position of the picture element picked up. 

• Machine Language: A language which users numeric codes to represent operations 

and numeric addresses of operands. Each model of a computer has a unique machine 

language. 

• Memory: An organized collection of cells used and programs in a computer. 

• Microcomputer: A computer which is fabricated using a microprocessor, and other 

integrated circuits, namely, a ROM, RAM and I/O interface chips. 

• Output Unit: A unit of a computer used to print or display computed results. 
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• Printer: An output unit to print the results of computation. Line printers print one full 

line at a time using a character, chain or drum. Character printer print one character at 

a time serially. 

• Processor: A unit of a computer which interprets instructions, executes them using 

arithmetic and logic circuits and controls the operation of all the other units of the 

computer (also known as CPU). 

• RAM: Random Access memory. A memory used as the main memory of a computer 

in which the time to retrieve stored information is independent of the address where it 

is stored. 

• ROM: Read only Memory. A memory in which information is permanently written. 

The information can be read quickly but not change. 

• Second Generation Computer: Computer built during the period 1956-65 which 

used transistors in CPU, magnetic core main memories and high level language 

FORTRAN and COBOL for programming. 

• Software: Programs for a computer. 

• System Software: General programs written for a computer. These programs written 

for a computer. These programs provide the environment to facilitate the writing of 

application programs. 

• Third-generation Computer-Computer built between 1966 and 1975 which used 

integrated circuits in CPU, high speed magnetic core main memories, powerful high 

level languages and saw the advent of time sharing operating system. 

• VDU: A Video Display Unit. An I/O device which consists of a television tube for 

presenting outputs and a keyboard for entering inputs. 

• Volatile Memory: A memory in which the information stored is lost unless energy is 

continuously fed to it. 

1.13 REVIEW QUESTIONS 
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Unsolved Questions 

1. Fill in the blanks: 

(a) Computers can be classified according to _________and________ 

(b) _______computers incorporate the technology of both analog and digital 

computers. 

(c) CPU consists of ———, ———and ——. 

(d) ——is volatile in nature. 

(e) A plotter is a specialized output device designed to produce high-

quality——. 

(f) ———is also called as system board. 

(g) Joystick is mainly used in ——and ——. 

(h) ———printers print the characters without striking against the and onto 

the paper. 

(i) ———and ——are first program into machine code. 

(j) ——translate the entire programs into machine code. 

2. State: True or False: 

(a) Mainframe computers are the biggest and the fastest computers. 

(b) Registers are small high speed circuits used to store data, instructions and memory 

addresses. 

(c) CMOS memory is used to store the system configuration, data time and other 

important data. 

(d) Lightpen is rolled across the desktop to move the pointer on the screen. 

(e) A microfiche is a 4x6 inch film sheet. 

(f) Office automation deals in application of latest technologies in improving the 
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overall proficiency of the office. 

(g) CPU is called the heart of the computer. 

(h) OCR is used for reading bar codes. 

(i) Laser printers look and work like photocopiers . 

(j) High level languages are widely used for applications development. 

Answers (Unsolved Questions) 

1. (a) Purpose, technology used, size and capacity. (b) Hybrid (c) ALU, CU, registers 

(d) RAM (e) graphics (f) motherboard (g) CAD, playing computer games. (h) Non-

Impact (i) ENIAC, EDSAC (j) compiler. 

2. (a) False (b) True (c) True, (d) False (e) True (f) True (g) False (h) False (i) True (j) 

True. 

Detailed Questions 

1. What is the difference between general purpose and special purpose computers? 

2. What is the difference between analog and digital computers? 

3. Classify computers on the basic of their technology. 

4. What do you mean by the term diligence' respect to computers? 

5. List some application areas of super computers. 

6. What is the difference between minicomputer and microcomputer? 

7. Write a short note on personal computer? 

8. Describe the architectural of computer system. 

9. State the basic units of computer. Name the submits that make up the CPU, and give 

the function of each of the units. 

10. What is the function of memory? What are its measuring units? 

11. What are the major strengths and weaknesses of computer? 
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12. What is the difference between RAM and ROM? 

13. What is the function of bus in CPU? 

14. Define the following: 

(i) PROM 

(ii) EPROM 

(iii)EEPROM 

(iv) DRAM 

(v) SRAM 

15. What are optical scanners? Give example: 

16. Name some devices used to capture data of line. 

17. Differentiate between microfilm and Microfiche. 

18. Define point-of-sale terminals. 

19. Why do we need office automation? 

20. Describe various types of office automation system. 

21. List some basic hardware components of Micro computer. 

22. What are various components of Mother board? 

23. Define the following: 

(i) Mouse 

(ii) Joystick 

(iii)Touch screen 

(iv) Bar code 

(v) MICR 

24. What is voice input devices? 
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25. What are Monitors? Describe its various types. 

26. What are printers? Describe its various types. 

27. What is the difference between Impact and non-impact printers? 

28. Describe computer output Microfilm. 

29. What are storage devices? Give examples. 

30. What is function of Video disc? 

31. What is computer software? Describe its various types. 

32. Name some general purpose application software. 

33. What are characteristics of second generation computer? 

34. Describe fifth generation computers? 

35. What are computer languages? Describe its various types. 

36. What is the difference complier and Interpreter? 

 

1.14 FURTHER READINGS 

Peter C. Jurs, Computer Software Applications in Chemistry; Wiley-IEEE. 
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2.1 INTRODUCTION 

⚫ Describe various components of a computer system. 

⚫ Describe various types of software in computer. 

⚫ Describe various generations of the computer. 

As computers become more widespread in the workplace, new ways to harness their potential 

developed. As smaller computers become more powerful, they could be linked together, or 

networked, to share memory space, software, and information and communicate with each other. 

2.2 COMPONENTS OF A COMPUTER SYSTEM 

Computer components can be broadly divided into two categories - Hardware and Software. Hardware 

refers to any physical component of a computer. For example, CPU, Monitor, Keyboard, Hard Disk, 

Floppy Disk etc. are physical components and thus, are hardware. Software refers to the programmes 

which are required to operate the computer. For example, DOS (Disk Operating System), BASIC, 

COBOL, dBASE, An Accounting Software etc. are all software. An analogy of hardware can be the 

book which you are reading and then software would be the text written on this book. Another analogy 

could be - 'brain' is hardware but 'memory stored in brain' is software. 

Both hardware and software are dependent on each other. CPU, Memory Unit, Hard Disk etc. are 

useless until they are provided instructions and data for storage and processing. Similarly, BASIC or 

COBOL language has no use until it is stored and processed by hardware components of computer. 

2.3 HARDWARE COMPONENTS OF MICRO COMPUTER 

In today's computer industry, a wide variety of hardware components are available for microcomputers. 

Managers must be aware of the working and uses of different hardware components, so that they can 

make good decisions about purchase of computer systems. The hardware components of microcomputer 

can be classified into following types: 

(A) Motherboard 

(B) Input Devices 
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(C) Output Devices 

(D) Storage Devices 

(E) Cards 

(F) Ports and Cords 

(G) Power Supply 

All these hardware devices except motherboard are called peripheral devices, as they are connected to 

the motherboard. 

Motherboard 

Motherboard, also called as System Board, is the most important hardware component of a 

microcomputer. Motherboard is so called as all the other boards (printed circuit boards having chips or 

other electronic components) of the computer are connected to this board, hence it is like mother of all 

other boards. 

Input Devices 

Input devices are used to input data, information and instructions into the RAM, The common input 

devices of a PC are described below  

                   Keyboard: Keyboard (similar to a typewriter) is the main input device of computer. It 

contains 3 types of keys - alphanumeric keys, special keys and function keys. When a key is pressed, an 

electronic signal is produced. This signal is detected by a keyboard encoder that sends a binary code 

corresponding to the key pressed to the Cpu. There are many types of keyboards but 101 Keys 

Keyboard is the most popular one. 

                      Mouse: Mouse (similar to a mouse) is another important input device. It is a pointing 

device used to move cursor, draw sketches/diagrams, selecting a text/object/menu item etc. on monitor 

screen while working on windows (graphics based operating environment of computer). Mouse is a 

small, palm size box containing 3 buttons and a ball underneath, which senses the movement of the 

mouse and sends the corresponding signals to CPU on pressing the buttons. 

                 Trackball: A trackball looks like a mouse, as the roller is on the top with selection buttons 
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on the side. It is again a pointing device used to move the cursor and works like a mouse. 

                  Light Pen: Light pen (similar to a pen) is a pointing device which is used to select a 

displayed menu item or draw pictures on the monitor screen. It consists of a photocell and an optical 

system placed in a small tube. When its tip is moved over the monitor screen and pen button is pressed, 

its photocell sensing element detects the screen location and sends the corresponding signal to the CPU. 

                  Touch Screen: Touch screen is sensitive to human fingers. Using this device, the user can 

point to a selection on the screen instead of pressing keys. 

                  Joystick: Joystick is also a pointing device which is used to move cursor position on a 

monitor screen. It is mainly used in Computer Aided Designing (CAD) and playing computer games. 

                   Digitiser: Digitiser is used to create drawings and pictures using a digitiser tablet by a 

process called digitising. Digitising is a process by which graphic representations are converted into 

digital data. The user makes contact with the flat digitiser tablet with a pen-like stylus. As the stylus is 

connected to the tablet by a wire, the traced image is stored in RAM and displayed on monitor. 

                   Scanner: Scanner is mainly used in Desktop Publishing (DTP) applications. Scanner is 

used for digitising images such as photographs, forms, documents etc. into computer memory. Some 

scanners can also read text by converting them to digital code. These scanners are very useful for 

converting the typed pages into word-processing files. Graphics scanners convert a printed image into 

video image without converting it to digital code. 

                    Optical Mark Reader (OMR): It is a special type of optical scanner used to recognize the 

type of mark made by pen or pencil. It is used where one out of a few alternatives is to be selected and 

marked. It is specially used for checking the answer sheets of examination having multiple choice 

questions. 

                       Optical Character Reader (OCR): It is also an optical scanner, which is capable of 

detecting alphanumeric characters typed or printed on paper using an OCR font. OCR devices are used 

for large volume applications like reading of passenger tickets, computer printed bills of credit card 

companies and reading of ZIP codes in postal services. 

                          Bar Code Reader: This device is an optical scanner used for reading bar-coded data 
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(data in form of light and dark lines). Bar-coded data is generally used in labelling goods, numbering 

the books or encoding ID or A/c numbers. 

                       Magnetic Ink Character Recognition (MICR): MICR is used to recognize the 

magnetically-charged characters, mainly found on bank cheques. MICR is used by the banking industry 

for the processing of cheques. A special equipment is used to encode, decode and process the cheques. 

                          Voice-Input Devices: These devices can recognize the human voice. They seem to be 

very useful but are not popular due to storage of limited vocabularies and variations in way of 

pronouncing words by different persons. 

Output Devices 

Output devices are hardware components which are used to display or print the processed information. 

The common output devices are described below and shown in Figure 1.5. 

Monitor: Visual Display Unit (VDU), commonly called as monitor is the main output device of 

computer. It consists of a Cathode Ray Tube (CRT), which displays characters as an output. It forms 

images from tiny dots, called pixels, that are arranged in a rectangular form. The sharpness of the image 

(screen resolution) depends upon the number of the pixels. 

                           Types of Monitors: There are different kinds of monitors depending upon the number 

of pixels. Depending upon the resolution, monitors can be classified as follows: 

(a) CGA (Color Graphics Adapter) . 

(b) MDA (Monochrome Display Adapter). 

(c) HGA (Hercules Graphics Adapter) 

(d) EGA (Enhanced Graphics Adapter) 

(e) VGA (Video Graphics Adapter) 

(f) SVGA (Super VGA) 

Depending upon color of display, monitors can be classified as Monochrome (with single color 

black/white display) and Color (with all colors display) Monitors. 
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Printer: Printer is the most important output device, which is used to print information on papers. 

Printers are essential for getting output of any computer based application. 

Types of Printers: There are many types of printers which are classified on various criteria.  Printers 

can be broadly categorized into two types. 

(a) Impact Printers: The printers that print the characters by striking against the ribbon and onto the 

paper, are called Impact Printers. These printers are of two types 

(i) Character Printers: These printers print one character at a time. These printers are again of 

two types Daisy Wheel and Dot Matrix Printers. Daisy Wheel Printers these printers print the 

characters by a mechanism that uses a plastic or metal hub with spokes, called daisy wheel. 

The characters are embossed on the radiating spokes and printed by striking these spokes 

against the ribbon and paper. Daisy Wheel printers give a good quality but they are expensive 

than Dot Matrix printers. Dot Matrix Printers these printers print the characters by putting dots 

onto the paper. They do not give better printing quality than daisy wheel printers, but are faster 

in speed. The printing speed of a dot matrix printer can be upto 360 cps (characters per 

second). They are widely used with microcomputers in most of the offices. 

(ii) Line Printers: These printers print one line at a time. Their printing speed is much more than 

character printers. They are again of two types Drum Printers and Chain Printers. Drum 

Printers these printers print the line by a rotating drum having a ring of characters for each print 

position. The hammers strike each character of the drum simultaneously, so that entire line is 

printed for one full rotation of the drum. These printers are also called as Barrel Printers. The 

printouts obtained from these printers, have even character spacing but uneven line height. 

Chain Printers these printers print the line by a rotating chain having ring characters for each 

print position. Their printing mechanism is similar to drum printers. The printouts obtained 

from these printers, have uneven character spacing but even line height. 

 

(b) Non-Impact Printers: The printers that print the characters without striking against the ribbon and 

onto the paper, are called Non-Impact Printers. These printers print a complete page at a time, 

therefore, also called as Page Printers. Page printers are of three types 
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(i) Laser Printers: These printers look and work like photocopiers. They are based on laser 

technology, which is the latest development in high speed and best quality printing. In these 

printers, a laser beam is used to write the image on a paper. First, the image is formed by 

electrically charged thousands of dots on a paper by laser beam. Then, the paper is sprayed 

with a toner having the opposite 

charge and is passed over a heated roller to make the image permanent. Laser printers are very 

popular and have become an essential part of Desk Top Publishing (DTP). Although laser 

printers are costlier than dot matrix, they are generally preferred in all offices due to their best 

quality of printing. There are many models of laser printers depending upon the speed and 

number of dots printed. The latest model of laser printer is 1200 DPI (Dots Per Inch), which 

can print 10 pages/ minute. Some high speed laser printers give a speed of upto 100 

pages/minute. 

(ii) Inkjet Printers: These printers print the characters by spraying the paper with electrically 

charged ink. These printers give better quality than character printers but not better than laser 

printers. They are cheaper than laser printers, hence used widely in many offices. They also 

offer an option of using color cartridges for multi-color printing. 

(iii)Thermal Printers: These printers print the characters by melting a waxbased ink off a ribbon 

onto a special heat sensitive paper. They give letter-quality printing but are relatively expensive 

in maintenance than other printers. 

Plotter: Plotter is an important output device, used to print high quality graphics and drawings. 

Although the graphics can be printed on printers, the resolution of such printing is limited on printers. 

Plotters are generally used for printing/drawing graphical images such as charts, drawings, maps etc. of 

engineering and scientific applications. Some important types of plotters are discussed below: 

(i) Flatbed Plotters: These plotters print the graphical images by moving the pen on stationary flat 

surface material. They produce very accurate drawings. 

(ii) Drum Plotters: These plotters print the graphical images by moving both the pen and the drum 

having paper. They do not produce as accurate drawings as printed by flat bed plotters. 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  44 |`  

 

(iii) Inkjet Plotters: These plotters use inkjets in place of pens. They are faster than flatbed plotters 

and can print multi-colored large drawings. 

Computer Output Microfilm: Computer Output Microfilm (COM) is a technique to produce output on 

a microfilm media (microfilm reel or microfiche card) microfilm is a continuous film strip that can store 

several thousands miniaturized document pages. A microfiche card is a 4 by 6 inch film sheet, which 

can store several hundred pages. 

The process of producing microfilm or microfiche takes place on a special COM unit. The information 

recorded on the microfilm is read with the help of a microfilm viewing system. It is generally easier to 

read a microfiche than microfilm. Computer Output Microfilm is particularly useful for organizations 

which need to store and manipulate large amount of data. It helps them in tremendous savings in paper 

and document handling costs. 

Storage Devices 

In preceding part of this unit, we have discussed about the primary memory of computer. Primary 

memory (especially RAM) stores the data, instructions and informations temporarily during processing 

by CPU. When computer is switched off, this memory gets erased. How does a computer store the data, 

information and software permanently, so that they can be retrieved whenever required? Certainly, there 

must be some storage devices in computer. Now, we will discuss about different Storage Devices, 

sometimes also called as Secondary Memory Devices. 

There are many storage devices used with microcomputers. Some of the common storage devices are 

explained below. 

(i) Winchester Disk (Hard Disk): Winchester Disk is the most common storage device of present 

day microcomputers. It is popularly called as Hard Disk Drive (HDD) or sometimes as Fixed Disk 

Drive. It is fixed inside the computer and is not easily removable. It is used for storing the software 

and data inside computer. It is known as 'Winchester Disk', probably because this drive was first 

made by IBM at Hursley Laboratory, located near Winchester in England. 

Winchester Disk consists of one or more disk platters, an access mechanism and read/ write heads 

which are sealed in a case. Hard disk size depends upon the disk platter's diameter. There are many 

different platter sizes (such as 51/2, 31/2 , 21/2 inch etc.). The 31/2 inch size platter is common 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  45 |`  

 

with PCs and 21/2 inch with laptop/ portable computers. Read/ write head is used to write any 

information on the disk surface or to read it back. 

There are different types of hard disks depending upon their storage capacities. Storage capacities 

of hard disks range from 10 MB to 6.3 GB, but 4.3 GB are nowadays a common part of Pentium 

computers 

(ii) Floppy Disk: Floppy Disk (FD) is another common storage device which is small, flexible and 

easily removable. It is made of a plastic disk coated with magnetic material, which is sealed inside 

a square plastic jacket. It is called as 'Floppy' because it is soft having flexible physical property. 

Data can be written on or read from this floppy by a drive, called Floppy Disk Drive (FDD), which 

is fixed inside the computer. 

There are many types of floppies depending upon their sizes and storage capacities as illustrated in 

Table 1.3. The original floppy, developed by IBM, is an 8" floppy, but the most popular sizes 

available for present day PCs are 51/4" and 31/2". The storage capacity of floppies vary from 360 

KB to 1.44 MB. The floppies can store data on both sides (Double-sided Floppies) or on single 

side (Single-sided Floppies) depending upon the floppy drive. Double sided floppy drives are most 

frequently used in present day PCs. The latest floppy drive, that packs two high density floppy 

drives (5.25 & 3.5 inch) into a single package, is known as Combo Drive. 

(iii) Compact Disk: Compact Disk (CD) is the latest storage device, used to store data, information 

and software, which can be read only and not be changed or erased. It is an optical read only 

memory, made up of a resin. Therefore, it is actually called as Compact Disk Read Only Memory 

(CD-ROM). However, the information is stored on CDs by using an expensive drive, called CD-

ROM drive. 

Nowadays compact disks are very popular storage devices for microcomputers because a large 

number of software including multimedia, audio and graphics software are available only on these 

disks. Compact Disks can store a large volume of data (upto 680 MB), which is almost same a 

storage capacity of 630 MB Hard Disk. 

WORM (Write Once Read Many) is a type of compact disk which can be recorded only once and 

not erased. It can store more data than CD-ROM, generally measured in gigabytes. 
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(iv) Magnetic Tape: Magnetic tape is the oldest storage device available for microcomputers. It is 

generally used to store a large volume of data that is needed to be sequentially accessed and 

processed. The tape is made up of a plastic ribbon coated with an iron-oxide material, which can be 

magnetized. The data stored on tape can be read as well as erased and written again. 

Magnetic tape is a sequential access storage device, hence it is not possible to read the data 

randomly or directly. Therefore, magnetic tapes are suitable only for storing data for backups and 

batch mode applications and not for on-line applications. On the other hand, magnetic disks 

(floppy and hard disks), which are discussed above, are considered best storage devices for on-line 

applications. 

(v) Video Disk: Video disk is used to store text, video and audio data. It is widely used for training 

applications as it can be played like a phonograph record. 

(vi) Magneto Optical Drive: Magneto Optical (MO) drive is the latest of all storage devices. This 

drive uses both a laser and an electromagnet to record data on a removable cartridge. The surface 

of the cartridge contains tiny embedded magnets The unique feature of MO drive is that it has a 

very high storage capacity. Although MO drive is costlier and slower than HDD, it has a long life 

and is more reliable. 

(vii) DVD ROM/RAM Disk: DVD ROM and DVD RAM disks are optical disks having a storage 

capacity of 4.7 GB and 5.2 GB respectively. These disks are becoming the next generation's new 

standard for higher capacity removable media. They are ideal for storage of huge amount of 

information required for multimedia applications. One can put 133 minutes of high quality of video 

with digital sound on a DVD RAM Disk. 

Cards 

Cards are the printed circuit boards used to hold the chips (integrated circuits). There are many types of 

cards used in PC, the important ones are Video Card, Sound Card, I/O Card, Controller Card and 

Memory Card. Video card (Display Card) generates the text and graphic images for monitor while 

sound card generates the sound. Pentium computers, generally, use a PCI (Peripheral Component 

Interconnect) video card to speed up graphics. I/O Card provides a place for connecting mouse and 

printer. Cables of hard disk and floppy disk are connected to controller cards. Memory Card provides a 
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place for memory chips. 

Ports and Cords 

Besides the important hardware discussed above, the computer has several components which are used 

as pathway for flow of data. The rear of a PC has many empty holes or external sockets called ports or 

connectors. There are many types of ports in a PC, the most important ones are Serial Port, Parallel 

Port, Game Port and Video Port. Serial Port is used to connect a mouse, modem or scanner. Parallel 

Port is generally used to connect a printer. Game Port is used to connect the joystick while Video Port is 

a connector for monitor. 

Cords are the cables used to plug into the ports. There are different types of cables for connecting 

different types of input, output and storage devices. The important cords used in a PC are keyboard 

cords, power cords, monitor cords and printer cords. 

Power Supply 

Power supply is considered as the 'Heart' of a Pc. Computer requires a clean and steady power source 

for working properly. Power supply is that important hardware, which provides the power source to a 

computer. It provides a voltage range of 4.95 to 5.25 volts for the highest performance of the system. 

Power supplies vary in size and power (in watt). 

2.4 CLASSIFICATION OF SOFTWARE 

Software are broadly classified into following two types: 

(a) System Software 

(b) Application Software 

System Software 

Software, which are required to control the working of hardware and aid in effective execution of a 

general user's applications are called system software. These software perform a variety of functions 

like file editing, storage management, resource accounting, I/O management, database management, etc. 

Some of the examples of system software are DOS (Disk Operating System), Windows, BASIC, 

COBOL and PC TOOLS. These software are developed by System Programmers. 
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Types of System Software 

System software can be further categorized into following three types: 

(i) System Management Software 

(Operating Systems, DBMS, Operating Environments) 

(ii) System Development Software 

(Language Translators, Application Generators, CASE Tools) 

(iii) System Software Utilities 

Application Software 

Software which are required for general and special purpose applications like database management, 

word processing, accounting etc. are called as application software. Some of the examples of 

application software are dBASE, Word Star, Tally etc. Application software are developed using system 

software by Application Programmers. 

(i)   General Purpose Application Software (Database Management Packages, Word 

Processors, Spreadsheets, Office Automation Packages) 

(ii) Special Purpose Application Software (Desktop Publishing, Multimedia, Business 

Applications) 

2.5 GENERATION OF COMPUTERS 

The computer evolved as a result of man's search for a fast and accurate calculating device. Abacus was 

the first manual calculating device, which was invented in Asia many centuries ago. In 1617, John 

Napier, a scottish mathematician invented a mechanical calculator called the 'Napier's bones'. 

Thereafter, many kinds of computers have been designed and built during the evolution of the modern 

digital computer. In order to provide a framework for the growth of computer industry, the computer era 

has been referred in terms of generations. Computers are classified into following six types based on 

their historical advancement and electronic components used. 

Zeroth Generation Computers 

The zeroth generation of computers (1642-1946) was marked by the invention of mainly mechanical 
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computers. Pascaline was the first mechanical device, invented by Blaise Pascal, a French 

mathematician in 1642. In 1822, Charles Babbage, an English mathematician, designed a machine 

called Difference Engine to compute tables of numbers for naval navigation. Later on, in the year 1834, 

Babbage attempted to build a digital computer, called Analytical Engine. The analytical engine had all 

the parts of a modern computer, i.e.; it had four components the store (memory unit), the mill 

(computation unit), the punched card reader (input unit) and the punched/printed output (output unit). 

As all basic parts of modern computers were thought out by Charles Babbage, he is known as Father of 

Computers. In later years, Herman Hollerith invented a machine for doing counting for 1880 US census, 

which was called the Tabulating Machine. In 1944, Howard A. Eiken invented first American general 

purpose electro-mechanical computer, called Mark I and later on its successor, Mark II. The Zeroth 

generation of computers or the era of mechanical computers ended in 1946 when vacuum tubes were 

invented. 

First Generation Computers 

The first generation of computers (1946-1954) was marked by the use of vacuum tubes or valves for 

their basic electronic component. Although these computers were faster than earlier mechanical devices, 

they had many disadvantages. First of all, they were very large in size. They consumed too much power 

and generated too much heat, when used for even short duration of time. They were very unreliable and 

broke down frequently. They required regular maintenance and their components had also to be 

assembled manually. The first generation of computers became out-dated, when in 1954, the Philco 

Corporation developed transistors that can be used in place of vacuum tubes. 

Examples: 

• ENIAC (Electronic Numerical Integrator and Calculator) It was the first electronic 

computer using vacuum tubes. - 1946 

• EDSAC (Electronic Delay Storage Automatic Calculator) It was the first stored-program 

computer. - 1949 

⚫ EDVAC (Electronic Discrete Variable Automatic Computer) It was successor of EDSAC. 

- 1951 
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⚫ IAS machine (Princeton's Institute of Advanced Studies) It was a new version of the 

EDVAC, built by von Neumann. - 1952 

The basic design of IAS machine is now known as von Neumann machine, which had five basic parts 

the memory, the arithmetic logic unit, the program control unit, the input and the output unit. 

Second Generation Computers 

The second generation of computers (1954-64) was marked by the use of transistors in place of vacuum 

tubes. Transistors had a number of advantages over the vacuum tubes. As transistors were made from 

pieces of silicon, they were more compact than vacuum tubes. The second generation computers, 

therefore, were smaller in size and less heat generated than first generation computers. Although they 

were slightly faster and more reliable than earlier computers, they also had many disadvantages. They 

had limited storage capacity, consumed more power and were also relatively slow in performance. Like 

first generation computers, they also required regular maintenance and their components had also to be 

assembled manually. Manual assembly of components was very expensive and later many attempts 

were made to reduce such manual assembly. It was in 1964, when it was discovered that a number of 

transistors could be sealed up into a tiny package, called an Integrated Circuit (IC) or a Chip. Second 

generation computers became out-dated after the invention of ICs. 

Examples: 

• PDP-l, developed by DEC was the first minicomputer. 

• NCR 304 (National Cash Register), was first all-transistorized computer. 

Third Generation Computers 

The third generation of computers (1964-1980) was marked by the use of Integrated Circuits (ICs) in 

place of transistors. ICs were more compact than transistors, as hundreds of transistors could be put on 

a single small circuit. These computers removed many drawbacks of second generation computers. The 

third generation computers were even smaller in size which generated less heat and required very less 

power as compared to earlier two generation of computers. These computers required less human labor 

at the assembly stage. Although, third generation computers were faster and more reliable, they also had 

a few disadvantages. 
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They still had less storage capacity, relatively slower performance and thus could not fulfil the 

requirements of the users and programmers. The third generation computers became out-dated around 

the year 1978 when it was found that thousands of ICs could be integrated onto a single chip, called LSI 

(Large Scale Integration). 

Examples: 

• IBM 360, developed by IBM in 1964 was the first product line designed as a family. 

• PDP-8, developed by DEC in 1965 was the first mass-market minicomputer. 

• PDP-ll, developed by DEC in 1970 was the first highly successful minicomputer. 

• CRAY-l, developed by Cray in 1974 was the first supercomputer. 

• VAX, developed by DEC in 1978 was the first super minicomputer. 

Fourth Generation Computers 

The fourth generation of computers (1978-till date) was marked by use of Large Scale Integrated (LSI) 

circuits in place of ICs. As thousands of ICs could be put onto a single circuit, so LSI circuits are still 

more compact than ICs. In 1978, it was found that millions of components could be packed onto a 

single circuit known as Very Large Scale Integration (VLSI). VLSI is the latest technology of computer 

that led to the development of the popular Personal Computers (PCs), also called as Microcomputers. 

All present day computers belong to the fourth generation of computers. These computers are very 

powerful having a high memory and a fast processing speed. Today's PCs are even more powerful than 

mainframe computers. Although fourth generation computers offer too many advantages to users, the 

major drawback of these computers is that they have no intelligence on their own. Scientists are now 

trying to remove this drawback by making computers which would have artificial intelligence 

Examples: 

• IBM PC, developed in 1981 was the first industry standard personal computer, having Intel 8088 

memory chip. 

• IBM PC/AT, developed in 1982 was the first advanced technology PC, having Intel 80286 

memory chip. 
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• 386, developed in 1985, had Intel 80386 memory chip. 

• CRAY-2, developed in 1985, was the fourth generation supercomputer. 

• 486, developed in 1989, had Intel 80486 memory chip. 

• Pentium, developed in 1995, has pentium (80586) memory chip. 

Fifth Generation Computers 

The fifth generation computers (Tomorrow's computers) are still under research and development stage. 

These computers would have artificial intelligence. They will use ULSI (Ultra Large Scale Integration) 

chips in place of VLSI chips. One ULSI chip contains millions of components on a single IC. The most 

important feature of fifth generation computers is that they will use an intelligent software. This 

software will enable the user to tell computer 'What to do' and not 'How to do' by using intelligent 

programming and knowledge-based problem solving techniques. So, the programmers or users would 

not be required to give each and every instruction to the computer for solving a problem. These 

computers will also have user interface in form of speech in natural languages. 

Example: 

• Yet to develop but ROBOTS have few features of fifth generation computers. 

Student Activity 8 

1. What are system software? Give example. 

2. What are application software? Give example. 

3. What are first generation computers? 

4. What are the limitations of third generation computers? 

5. Describe fourth generation computers. 

2.6 COMPUTER LANGUAGES 

One man communicates with another in a language, which another man can understand. Similarly, man 

communicates with computer in a language, which machine can understand. This language which 

consists of a set of commands, understandable by computer directly or after translating, is known as 
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Computer Programming Language. There are many types of computer languages, which can be 

categorized into following four types 

(a) Low-level Languages (First and Second Generation Languages); 

(b) High-level Languages (Third Generation Languages); 

(c) User-Friendly Languages (Fourth Generation Languages); 

(d) Object Oriented Languages (Fifth Generation Languages). 

Low-level Languages: In early days of computers, only those languages were used for 

programming, which could be directly executed on computer. Languages, which computer can 

understand directly and are machine dependent, are called low-level languages. For example, 

Machine Language and Assembly Language are two important low-level languages. Machine 

language is the oldest and most difficult of all the languages. It is also known as First Generation 

Language. In machine language, all the instructions are given to computer in binary digits, and 

hence are directly understood by the computer. On the other hand, assembly language is easier 

than machine language, and is known as Second Generation Language. In assembly language, 

instructions are given using mnemonic operation codes (such as ADD, MUL etc.) instead of binary 

digits. 

Low-level languages are used for development of system software. As they are not used for 

applications development, managers or application programmers do not need to learn these 

languages. 

(b) High-level Languages: Development of applications using low level languages requires a deep 

understanding of the hardware. In order to facilitate the programmers to write programs without 

knowing the internal details of computer components, many languages were developed. These 

languages use common English words and are translated into low-level languages before 

processing by the computer. These languages which computer cannot understand directly and are 

not machine dependent, are called High-Level Languages (HLL). These languages are also known 

as Third Generation Languages. Some of the common high-level languages are 

(i) BASIC (Beginners All Purpose Symbolic Instruction Code); 
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(ii) COBOL (Common Business Oriented Language); 

(iii)FORTRAN (Formula Translator); 

(iv) PASCAL (Name of a Scientist); 

(v) C (it does not stand for anything). 

These languages were widely used for applications development, but most of them are outdated 

nowadays due to popularization of 4GLs. The uses of different 3GLs are summarized in Table 1.4. 

Table 1.4: Uses of 3GLs (Third Generation Languages) 

 L a n g u a g e U s e s 

BASIC 

(Beginner's All 

Purpose Used for all purposes (Commercial, Scientific, Educational, 

 Graphics Symbolic etc.) by beginners. 

 Instruction Code)  

COBOL (Common Business Mainly .used for development of commercial 

 Oriented Language) applications on all types Computers. 

FORTRAN (Formula Translator) 

Used for development of scientific (mathematical) 

applications. 

PASCAL (Name of a Scientist) Used for both commercial and scientific applications. 

C (No full form) Very powerful language for development of both system 

  and application software. 

 

(c) User-friendly Languages: Although high-level languages are simpler to codify than low-level 

languages, they still require a lot of time to learn their programming syntax. Hence, these 

languages are beyond the reach of many computer users (including MIS professionals), who do not 

want expertise in programming. Therefore, a new category of languages have been developed 

which are user-friendly, very easy to codify and simplest to learn. These languages are called as 
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User-friendly Languages and popularly known as 4GLs (Fourth Generation Languages). Some of 

the common 4GLs are dBASE, Foxbase, Foxpro, MS Access, Oracle, Sybase and Ingres. The uses 

of different 4GLs are summarized in Table 1.5. 

(d) Object-oriented Languages: We have discussed that the object-oriented programming is the 

latest approach in programming. The languages which are based on Object-Oriented Programming 

(OOP) approach, are called as Object Oriented Languages. They may be classified into Fifth 

Generation Languages. Object Oriented Languages are specially useful for development of GUI 

(Graphical User Interface) applications. These languages also offer a unique feature of Reusable 

Code. Some of the popular object-oriented languages are Smalltalk, C++ and Object COBOL, 

Object Pascal, Simula, Eiffel, Java & Visual J++. C++ and Visual J++ are widely used nowadays 

for development of windows-based applications. The uses of different object-oriented languages 

are summarized in Table 1.6. 

  Table 1.5: Uses of 4GLs (Fourth Generation Languages) 

Languag e  Us es 

  

dBASE Used for development of mainly single user DOS based database appliactions. 

Foxbase Used for development of both single and multiuser DOS based database applications. 

Foxpro Used for development of both DOS and Windows based database opplications. 

Oracle Used for development of relational database applications on any operating environment. 

Sybase Mainly used for development of on-line applications such as Decision Support Systems 

 and Transaction Processing. 

Ingres Used for development of relational database applications of VAX/UNIX operating 

 System. 

Table 1.6: Uses of Object Oriented Languages (Fifth Generation Languages) 

Languag e  Us es 
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Smalltalk  Used for development of mainly graphical applications. 

C++  Used for development of all types of object oriented applications. 

Object COBOL Used for development of object oriented applications on mainframe computer. 

Object 

PASCAL Used for general object oriented applications. 

Simula  Mainly used in research environment. 

Eiffel  Used for general object oriented applications. 

Visual J++  Very popular for development of Windows based applications. 

2.7 LANGUAGE TRANSLATORS 

Regardless of the programming language used (except machine language), the symbolic instructions 

have to be translated into a form, that can be executed by computer. The software, which convert the 

codes of other languages into machine code, are collectively called as Language Translators. 

Types of Language Translators 

Language Translators are categorized into three types 

(a) Assemblers: Assemblers translate the assembly language code (source program) into machine 

language code (object program). After assembling, a linker program is used to convert the object 

program into an executable program. The Microsoft Assembler Program (MASM) and Borland 

Turbo Assembler Program (TASM) are two popular assemblers. Assemblers are used mainly in 

development of system software. 

(b) Interpreters: Instructions of a high-level language are coded in many statements. At the time of 

their execution, they are converted into machine code statement by statement, by using system 

software, called Interpreters. For example, programs written in BASIC language are executed by 

using BASIC A or GWBASIC interpreters. Programs written in some fourth generation languages, 

like dBASE III plus are also executed using dBASE interpreter. There are certain disadvantages of 

interpreters. As instructions are translated and executed simultaneously using interpreters, they are 
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very slow for executing large programs. Hence, interpreters are not suitable for most of 

applications development. 

(c) Compilers: In contrast to interpreters, compilers provide faster execution speed. Compilers do not 

translate and execute the instructions at the same Time. They translate the entire program (source 

code) into machine code (object code). Using linker, the object code is converted into executable 

code. Compilers are widely used in translating codes of high level languages (e.g. COBOL, 

FORTRAN, PASCAL, Turbo/ Quick BASIC, Turbo/ Microsoft C etc.) and fourth generation 

languages (dBASE IV, Foxpro etc.). As compared to interpreters or assemblers, they are preferred 

in development of application software. 

2.8 SUMMARY 

Computers are used in business for data capturing in on-line as well as off-line mode, for storage and 

retrieval of information, for output and for transmission. Offices are needed to be automated to reduce 

cost of administrative overhead and to increase efficiency of office tasks and staff. The hardware 

components of microcomputer can be classified into motherboard, Input devices, output devices, 

storage devices, cards, ports and cords and power supply. Various Input devices are keyboard, mouse 

back ball, light pen, touch screen, Joy stick, digitizer, Scanner, Optical Mark Reader (OMR), Optical 

Character Reader (OCR) Bar Code Reader (BCR), Magnetic Ink Character Recognition (MICR) and 

voice input devices various output devices include monitor printer plotter and computer output micro 

file. Storage devices include hard disk, floppy disk, compact disk, Magnetic tape, video disk, Magneto 

optical drive, DVD ROM/RAM disk, etc. 

Computer software as classified as system software which are required to control the working of 

hardware, and software which are required for general and special purpose applications. 

Computers are classified into six types based on their historical advancement and electronic components 

used, from fourth generation to fifth generation computers. Computers languages are categorized into 

four types, low level, high-lever, user friendly and object oriented language. 

Language translators are used to convert are codes of other languages into machine code. 

Various categories of language translators include Assemblers, compilers and Interpreters 
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2.9 KEYWORDS 

• ALU: Arithmetic Logic Unit of a computer which is used to perform arithmetic and logic 

operations. 

• Assembler: A program which translates an assembly language program to its machine language 

equivalent. 

• Assembly Language: A low-level language for programming a computer in which mnemonics are 

used to code operations and alphanumeric symbols are used for addresses. 

• Cache Memory: A small high speed memory which is used to temporarily store a portion of a 

program or data from the main memory. The processor retrieves instructions or data from the 

cache memory. Instruction and data caching speeds up computation. 

• Chain Printer: A printer in which the characters to be printed are embossed on a chain or a band. 

The chain is fashioned as a loop and print heads are activated to print specified characters. 

• Communication Channel: A medium through which (electric) signal are transmitted and 

received. 

• Compiler: A system program to translate a high level language program to machine language. 

• Computer: This is a machine which executes an algorithm stored in its memory to process data 

fed to it and produces the required results. 

• Control Bus: A set of wires used to transmit signals to control the operation of various units of a 

computer. 

• CPU: Central processing unit of a computer. It consists of circuits to perform arithmetic and logic 

and also has circuits to control and co-ordinate the functioning of the memory and I/O units of a 

computer. 

• Data Entry Unit: A system which a keyboard to enter data and a magnetic medium such as a 

floppy disk to store the entered data. 

• Data (Digital Audio Tape): User 4 mm wide magnetic tape in a cartridge to store around 4 GB of 
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data (1994). 

• Digital Channel: A communication medium through which information in binary (digital) form is 

transmitted. 

• Disk Memory: A back up or peripheral memory in which information is stored as magnetized 

spots on the surface of disks coated with magnetic material. In hard disks the disks are not flexible. 

In floppy disks the disks is a circular platter made of flexible magnetic coated plastic sheet. 

• Floppy Disk: A circular magnetic disk made of flexible plastic sheet coated with magnetic 

material. 

• Fourth Generation: Fourth Generation computers:- Computers built between 1975 and now. 

They use large scale integrated circuits, semiconductor memories and powerful high level 

languages and operating systems. 

• High Level Languages: Computer language in which each statement is translated into many 

machine language statements. 

• I C: Integrated circuit. An electronic circuit fabricated on a single chip of silicon. 

• Input Unit: A part of a computer used to feed programs and data. 

• Joy Stick: A stick mounted on a spherical ball which moves in a socket. Used to more the cursor 

on the screen of a display device. 

• Laptop: A portable computer which weighs around 2 kg and runs all PC applications. It used a 

liquid crystal display and is usable by the person while traveling. 

• Light Pen: A pen shaped devices which has a lens assembly. It is pointed towards an image 

displayed on a cathode ray screen. It picks up the right and determines the position of the picture 

element picked up. 

• Machine Language: A language which users numeric codes to represent operations and numeric 

addresses of operands. Each model of a computer has a unique machine language. 

• Memory: An organized collection of cells used and programs in a computer. 
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• Microcomputer: A computer which is fabricated using a microprocessor, and other integrated 

circuits, namely, a ROM, RAM and I/O interface chips. 

• Output Unit: A unit of a computer used to print or display computed results. 

• Printer: An output unit to print the results of computation. Line printers print one full line at a 

time using a character, chain or drum. Character printer print one character at a time serially. 

• Processor: A unit of a computer which interprets instructions, executes them using arithmetic and 

logic circuits and controls the operation of all the other units of the computer (also known as CPU). 

• RAM: Random Access memory. A memory used as the main memory of a computer in which the 

time to retrieve stored information is independent of the address where it is stored. 

• ROM: Read only Memory. A memory in which information is permanently written. The 

information can be read quickly but not change. 

• Second Generation Computer: Computer built during the period 1956-65 which used transistors 

in CPU, magnetic core main memories and high level language FORTRAN and COBOL for 

programming. 

• Software: Programs for a computer. 

• System Software: General programs written for a computer. These programs written for a 

computer. These programs provide the environment to facilitate the writing of application 

programs. 

• Third-generation Computer-Computer built between 1966 and 1975 which used integrated 

circuits in CPU, high speed magnetic core main memories, powerful high level languages and saw 

the advent of time sharing operating system. 

• VDU: A Video Display Unit. An I/O device which consists of a television tube for presenting 

outputs and a keyboard for entering inputs. 

• Volatile Memory: A memory in which the information stored is lost unless energy is continuously 

fed to it. 
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2.10 REVIEW QUESTIONS 

Unsolved Questions 

2. Fill in the blanks: 

        (a)  A plotter is a specialized output device designed to produce high-quality——. 

(k) ———is also called as system board. 

(l) Joystick is mainly used in ——and ——. 

(m) ———printers print the characters without striking against the and onto the paper. 

(n) ———and ——are first program into machine code. 

(o) ——translate the entire programs into machine code. 

3. State: True or False: 

(a) Mainframe computers are the biggest and the fastest computers. 

(b) Registers are small high speed circuits used to store data, instructions and memory addresses. 

(c) CMOS memory is used to store the system configuration, data time and other important data. 

(d) Lightpen is rolled across the desktop to move the pointer on the screen. 

(e) A microfiche is a 4x6 inch film sheet. 

(f) Office automation deals in application of latest technologies in improving the overall 

proficiency of the office. 

(g) CPU is called the heart of the computer. 

(h) OCR is used for reading bar codes. 

(i) Laser printers look and work like photocopiers . 

(j) High level languages are widely used for applications development. 

Answers (Unsolved Questions) 

1    (a) graphics (b) motherboard (c) CAD, playing computer games. (d) Non-Impact (e) ENIAC, 
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EDSAC (h) compiler. 

3. (a) False (b) True (c) True, (d) False (e) True (f) True (g) False (h) False (i) True (j) True. 

Detailed Questions 

12. What is the difference between general purpose and special purpose computers? 

13. What is the difference between analog and digital computers? 

14. Classify computers on the basic of their technology. 

15. What do you mean by the term diligence' respect to computers? 

16. List some application areas of super computers. 

17. What is the difference between minicomputer and microcomputer? 

18. Write a short note on personal computer? 

19. Describe the architectural of computer system. 

20. State the basic units of computer. Name the submits that make up the CPU, and give the function 

of each of the units. 

21. What is the function of memory? What are its measuring units? 

22. What are the major strengths and weaknesses of computer? 

37. What is the difference between RAM and ROM? 

38. What is the function of bus in CPU? 

39. Define the following: 

(i) PROM 

(ii) EPROM 

(iii)EEPROM 

(iv) DRAM 

(v) SRAM 
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40. What are optical scanners? Give example: 

41. Name some devices used to capture data of line. 

42. Differentiate between microfilm and Microfiche. 

43. Define point-of-sale terminals. 

44. Why do we need office automation? 

45. Describe various types of office automation system. 

46. List some basic hardware components of Micro computer. 

47. What are various components of Mother board? 

48. Define the following: 

(i) Mouse 

(ii) Joystick 

(iii)Touch screen 

(iv) Bar code 

(v) MICR 

49. What are voice input devices? 

50. What are Monitors? Describe its various types. 

51. What are printers? Describe its various types. 

52. What is the difference between Impact and non-impact printers? 

53. Describe computer output Microfilm. 

54. What are storage devices? Give examples. 

55. What is function of Video disc. 

56. What are computer software? Describe its various types. 

57. Name some general purpose application software. 
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58. What are characteristics of second generation computer? 

59. Describe fifth generation computers? 

60. What are computer language? Describe its various types. 

61. What is the difference complier and Interpreter? 

2.11 FUTURE READING 

Peter C. Jurs, Computer Software Applications in Chemistry; Wiley-IEEE. 

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, Editions De L’Ocean 

Indien. 
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3.1 INTRODUCTION 

 

⚫ Describe about tool bar. 

⚫ Describe about installation. 

⚫ Describe about removing. 

In this section we will study about Operating system- Definition and functions, basics of Windows, 

Basic components of windows, icons, types of icons, taskbar, activating windows, using desktop, title 

bar, running applications, exploring computer, managing files and folders, copying and moving files 

and folders. Control panel- display properties, adding and removing software and hardware, setting date 

and time, screen saver and appearance. 

3.2 OPERATING SYSTEM 

An operating system is a program on which application programs are executed and acts as an 

communication bridge (interface) between the user and the computer hardware. 

The main task an operating system carries out is the allocation of resources and services, such as 

allocation of: memory, devices, processors and information. The operating system also includes 

programs to manage these resources, such as a traffic controller, a scheduler, memory management 

module, I/O programs, and a file system. 

Important functions of an operating System: 

1. Security  

The operating system uses password protection to protect user data and similar other techniques. it 

also prevents unauthorized access to programs and user data. 

2. Control over system performance 

Monitors overall system health to help improve performance. records the response time between 

service requests and system response to have a complete view of the system health. This can help 

improve performance by providing important information needed to troubleshoot problems. 
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3. Job accounting  

Operating system Keeps track of time and resources used by various tasks and users, this 

information can be used to track resource usage for a particular user or group of user. 

4. Error detecting aids  

Operating system constantly monitors the system to detect errors and avoid the malfunctioning of 

computer system. 

5. Coordination between other software and users  

Operating systems also coordinate and assign interpreters, compilers, assemblers and other 

software to the various users of the computer systems. 

6. Memory Management  

The operating system manages the Primary Memory or Main Memory. Main memory is made up 

of a large array of bytes or words where each byte or word is assigned a certain address. Main 

memory is a fast storage and it can be accessed directly by the CPU. For a program to be 

executed, it should be first loaded in the main memory. An Operating System performs the 

following activities for memory management: 

It keeps tracks of primary memory, i.e., which bytes of memory are used by which user program. 

The memory addresses that have already been allocated and the memory addresses of the memory 

that has not yet been used. In multi programming, the OS decides the order in which process are 

granted access to memory, and for how long. It Allocates the memory to a process when the 

process requests it and deallocates the memory when the process has terminated or is performing 

an I/O operation. 

7. Processor Management  

In a multi programming environment, the OS decides the order in which processes have access to 

the processor, and how much processing time each process has. This function of OS is called 

process scheduling. An Operating System performs the following activities for processor 

management. 

Keeps tracks of the status of processes. The program which perform this task is known as traffic 
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controller. Allocates the CPU that is processor to a process. De-allocates processor when a process 

is no more required. 

8. Device Management  

An OS manages device communication via their respective drivers. It performs the following 

activities for device management. Keeps tracks of all devices connected to system. designates a 

program responsible for every device known as the Input/Output controller. Decides which 

process gets access to a certain device and for how long. Allocates devices in an effective and 

efficient way. Deallocates devices when they are no longer required. 

9. File Management  

A file system is organized into directories for efficient or easy navigation and usage. These 

directories may contain other directories and other files. An Operating System carries out the 

following file management activities. It keeps track of where information is stored, user access 

settings and status of every file and more… These facilities are collectively known as the file 

system. 

Moreover, Operating System also provides certain services to the computer system in one form or the 

other. 

The Operating System provides certain services to the users which can be listed in the following 

manner: 

1. Program Execution: The Operating System is responsible for execution of all types of programs 

whether it be user programs or system programs. The Operating System utilises various resources 

available for the efficient running of all types of functionalities. 

2. Handling Input/Output Operations: The Operating System is responsible for handling all sort of 

inputs, i.e, from keyboard, mouse, desktop, etc. The Operating System does all interfacing in the 

most appropriate manner regrading all kind of Inputs and Outputs. 

For example, there is difference in nature of all types of peripheral devices such as mouse or 

keyboard, then Operating System is responsible for handling data between them. 
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3. Manipulation of File System: The Operating System is responsible for making of decisions 

regarding the storage of all types of data or files, i.e, floppy disk/hard disk/pen drive, etc. The 

Operating System decides as how should the data should be manipulated and stored. 

4. Error Detection and Handling: The Operating System is responsible for detection of any types 

of error or bugs that can occur while any task. The well secured OS sometimes also acts as 

countermeasure for preventing any sort of breach to the Computer System from any external 

source and probably handling them. 

5. Resource Allocation: The Operating System ensures the proper use of all the resources available 

by deciding which resource to be used by whom for how much time. All the decisions are taken 

by the Operating System. 

6. Accounting: The Operating System tracks an account of all the functionalities taking place in the 

computer system at a time. All the details such as the types of errors occurred are recorded by the 

Operating System. 

7. Information and Resource Protection: The Operating System is responsible for using all the 

information and resources available on the machine in the most protected way. The Operating 

System must foil an attempt from any external resource to hamper any sort of data or information. 

3.3 BASIC COMPONENT OF WINDOWS 

Windows is an essential part of a Computer. It’s the most commonly used Operating System all around 

the world both individually and commercially. Since the beginning of the creation of Windows, there 

are many versions of Windows like Windows XP, Vista, 8, 10, etc. 

Windows consists of the following components: 

• Desktop: 

The desktop is the very first screen we see after windows start. Here, we can see folders like My 

Computer, Documents, etc. It is the main working area of many of your computer operations. You keep 

your special files on the desktop so you can access them easily and it gives access to other important 

functionalities as well such as search bar, taskbar, and file explorer. 

• Taskbar: 
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The taskbar is a simple row at the very bottom of the screen where all currently opened files or 

applications are listed. It helps you select what you want to keep opened and what you want to close. 

• Start Menu: 

By clicking the start menu, in the bottom left corner of the screen, a vertical window consisting of the 

recently opened applications and saved locations will pop-up. Although the Start Menu was a major 

component of Windows before Windows 8, It was removed from Windows 8 and then brought back in 

Windows 10. 

• Maximize/Minimize/Close Buttons: 

These buttons are located at the top right corner of our opened documents, and the area used to close, 

minimize or maximize the document window. They help us jump from one task to another fast and let 

us decide either we want to close an application or resize it’s area on the screen or just hide it for a few 

moments. 

• My Computer: 

When we double click on My Computer, We find ourselves looking at a window where we can navigate 

between Computer Drives and Control Panel tools. It also gives us access to different drives on our 

computer and the data which lies in those drives. 

• My Computer Right Click Menu: 

When we right-click on My Computer or any other file or folder, We get a menu where we can look 

into different options related to that specific file, for example, Properties, etc. 

• Recycle Bin: 

When we delete a file or folder, It goes into the Recycle Bin from where It can either be restored or 

permanently deleted from the Computer. Once, a file or folder is deleted from the Recycle Bin, It is 

very difficult to recover it again. Therefore, the utility of the recycle bin is very essential to use properly 

if you deal with important documents and files on a day to day basis. 

• Shortcut: 

http://www.wiki-security.com/wiki/Parasite/WindowsProWebHelper/
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A shortcut creates a button or icon which typically is located on the Desktop. By clicking on this 

Shortcut, We can quickly open the document or application of which it is a shortcut. It helps us save the 

tedious task of going to the main directory again and again and saves our time. 

• Mouse Functions: 

The mouse is an input device which is essential in the working of a computer. It performs several 

important functions on Windows like Scrolling, Right and Left Clicks, etc. It performs another very 

important function of modern windows which is pointing towards different things and giving special 

instructions whenever needed. 

• Highlight: 

When we have opened a document, we can easily highlight the required portion of our document by 

using Mouse. It is essential for documents and helps keep track of useful information. 

• Copy/Cut/Paste: 

These options are one of the most essential components of Windows. The copy is used to copy a portion 

of a document from one document to another or a file or folder from one location to another. The paste 

is used to paste the copied item on the desired location. While Cut is used to move an item to our 

desired location in the Computer. 

• Toolbar: 

The toolbar is a simple row where we can see different options to customize the look of our opened 

window. It has two types, Formatting Toolbar, and Standard Toolbar. The standard toolbar consists of 

options like new documents, save a document, etc. While Formatting Toolbar consists of options like 

font size, font type, etc. 

• Drag/Drop: 

Dragging an object means to move an object (file or folder) from one location to another and when we 

reach our desired location, then we can drop the object to that location. It is one of the most used 

features of windows as you have to move files from one location to another. 

• File Extensions: 
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File extensions are used to define the type of the file. For example an image file will have an extension 

of .jpg, .jpeg and a Word document will have an extension .docx, .xls, .txt etc. You could have different 

types of extensions and these extensions help you decide the type of software that will be used to access 

these files. 

• Multitasking: 

The term Multitasking means to run more than one file or application on Windows at the same time. It 

is a very important component of Windows which saves our time as well as allow us to perform more 

tasks at the same time. 

3.4 ICON  

Desktop icons for file/data transfer, clock/awaiting, and running a program. 

In computing, an icon is a pictogram or ideogram displayed on a computer screen in order to help the 

user navigate a computer system. The icon itself is a quickly comprehensible symbol of a software tool, 

function, or a data file, accessible on the system and is more like a traffic sign than a 

detailed illustration of the actual entity it represents.[1] It can serve as an electronic hyperlink or file 

shortcut to access the program or data. The user can activate an icon using a mouse, pointer, finger, or 

recently voice commands. Their placement on the screen, also in relation to other icons, may provide 

further information to the user about their usage. In activating an icon, the user can move directly into 

and out of the identified function without knowing anything further about the location or requirements 

of the file or code. 

Icons as parts of the graphical user interface of the computer system, in conjunction 

with windows, menus and a pointing device (mouse), belong to the much larger topic of the history of 

the graphical user interface that has largely supplanted the text-based interface for casual use. 

Types of Icon: 

1. Standardized electrical device symbols 

A series of recurring computer icons are taken from the broader field of standardized symbols used 

across a wide range of electrical equipment. Examples of these are the power symbol and the USB icon, 

which are found on a wide variety of electronic devices. The standardization of electronic icons is an 

https://en.wikipedia.org/wiki/Computer_icon#Desktop_metaphor_icons
https://en.wikipedia.org/wiki/Computing
https://en.wikipedia.org/wiki/Pictogram
https://en.wikipedia.org/wiki/Ideogram
https://en.wikipedia.org/wiki/Computer_screen
https://en.wikipedia.org/wiki/Computer_system
https://en.wikipedia.org/wiki/Software
https://en.wikipedia.org/wiki/Data_file
https://en.wikipedia.org/wiki/Traffic_sign
https://en.wikipedia.org/wiki/Illustration
https://en.wikipedia.org/wiki/Icon_(computing)#cite_note-BusinessWeek-1
https://en.wikipedia.org/wiki/Hyperlink
https://en.wikipedia.org/wiki/File_shortcut
https://en.wikipedia.org/wiki/File_shortcut
https://en.wikipedia.org/wiki/Voice_command
https://en.wikipedia.org/wiki/Graphical_user_interface
https://en.wikipedia.org/wiki/Window_(computing)
https://en.wikipedia.org/wiki/Menu_(computing)
https://en.wikipedia.org/wiki/Pointing_device
https://en.wikipedia.org/wiki/History_of_the_graphical_user_interface
https://en.wikipedia.org/wiki/History_of_the_graphical_user_interface
https://en.wikipedia.org/wiki/Text-based_interface
https://en.wikipedia.org/wiki/Power_symbol
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important safety-feature on all types of electronics, enabling a user to more easily navigate an 

unfamiliar system. As a subset of electronic devices, computer systems and mobile devices use many of 

the same icons; they are corporated into the design of both the computer hardware and on the software. 

On the hardware, these icons identify the functionality of specific buttons and plugs. In the software, 

they provide a link into the customizable settings.  

System warning icons also belong to the broader area of ISO standard warning signs. These warning 

icons, first designed to regulate automobile traffic in the early 1900s, have become standardized and 

widely understood by users without necessity of further verbal explanations. In designing software 

operating systems, different companies have incorporated and defined these standard symbols as part of 

their graphical user interface. For example, the Microsoft MSDN defines the standard icon use of error, 

warning, information and question mark icons as part of their software development guidelines.  

Different organizations are actively involved in standardizing these icons, as well as providing 

guidelines for their creation and use. The International Electrotechnical Commission (IEC) has defined 

"Graphical symbols for use on equipment", published as IEC 417, a document which displays IEC 

standardized icons. Another organization invested in the promotion of effective icon usage is the ICT 

(information and communications technologies), which has published guidelines for the creation and 

use of icons. Many of these icons are available on the Internet, either to purchase or as freeware to 

incorporate into new software. 

2. Metaphorical icons 

An icon is a Signifier pointing to a Signified. Easily comprehendible icons will make use of 

familiar visual metaphors directly connected to the Signified: actions the icon initiate or the 

content that would be revealed. Metaphors, Metonymy and Synecdoche are used to encode the 

meaning in an icon system. 

The Signified can have multiple natures: virtual objects such as Files and Applications, actions within a 

system or an application (e.g. snap a picture, delete, rewind, connect/disconnect etc...), action in the 

physical world (e.g. print, eject DVD, change volume or brightness etc...) as well as physical objects 

(e.g. monitor, compact disk, mouse, printer etc...). 

https://en.wikipedia.org/wiki/Signifier
https://en.wikipedia.org/wiki/Signified
https://en.wikipedia.org/wiki/Signified
https://en.wikipedia.org/wiki/Metaphors
https://en.wikipedia.org/wiki/Metonymy
https://en.wikipedia.org/wiki/Synecdoche
https://en.wikipedia.org/wiki/Signified
https://en.wikipedia.org/wiki/Computer_file
https://en.wikipedia.org/wiki/Application_software
https://en.wikipedia.org/wiki/Computer_monitor
https://en.wikipedia.org/wiki/Compact_disk
https://en.wikipedia.org/wiki/Mouse
https://en.wikipedia.org/wiki/Printer_(computing)
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3. The Desktop metaphorA  

subgroup of the more visually rich icons is based on objects lifted from a 1970 physical office 

space and desktop environment. It includes the basic icons used for a file, file folder, trashcan, 

inbox, together with the spatial real estate of the screen, i.e. the electronic desktop. This model 

originally enabled users, familiar with common office practices and functions, to intuitively 

navigate the computer desktop and system. (Desktop Metaphor, pg 2). The icons stand for 

objects or functions accessible on the system and enable the user to do tasks common to an 

office space. These desktop computer icons developed over several decades; data files in the 

1950s, the hierarchical storage system (i.e. the file folder and filing cabinet) in the 1960s, and 

finally the desktop metaphor itself (including the trashcan) in the 1970s.  

Dr. David Canfield Smith associated the term "icon" with computing in his landmark 1975 PhD thesis 

"Pygmalion: A Creative Programming Environment". In his work, Dr. Smith envisioned a scenario in 

which "visual entities", called icons, could execute lines of programming code, and save the operation 

for later re-execution. Dr. Smith later served as one of the principal designers of the Xerox Star, which 

became the first commercially available personal computing system based on the desktop metaphor 

when it was released in 1981. "The icons on [the desktop] are visible concrete embodiments of the 

corresponding physical objects." The desktop and icons displayed in this first desktop model are easily 

recognizable by users several decades later, and display the main components of the desktop metaphor 

GUI. 

This model of the desktop metaphor has been adopted by most personal computing systems in the last 

decades of the 20th century; it remains popular as a "simple intuitive navigation by single user on single 

system." It is only at the beginning of the 21st century that personal computing is evolving a new 

metaphor based on Internet connectivity and teams of users, cloud computing. In this new model, data 

and tools are no longer stored on the single system, instead they are stored someplace else, "in the 

cloud". The cloud metaphor is replacing the desktop model; it remains to be seen how many of the 

common desktop icons (file, file folder, trashcan, inbox, filing cabinet) find a place in this new 

metaphor. 

https://en.wikipedia.org/wiki/Desktop_metaphor
https://en.wikipedia.org/wiki/David_Canfield_Smith
https://en.wikipedia.org/wiki/Xerox_Star
https://en.wikipedia.org/wiki/Cloud_computing
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4. Brand icons for commercial software  

A further type of computer icon is more related to the brand identity of the software programs 

available on the computer system. These brand icons are bundled with their product and 

installed on a system with the software. They function in the same way as the hyperlink icons 

described above, representing functionality accessible on the system and providing links to 

either a software program or data file. Over and beyond this, they act as a company identifier 

and advertiser for the software or company.  

Because these company and program logos represent the company and product itself, much attention is 

given to their design, done frequently by commercial artists. To regulate the use of these brand icons, 

they are trademark registered and are considered part of the company intellectual property. 

In closed systems such as iOS and Android, the use of icons is to a degree regulated or guided  to create 

a sense of consistency in the UI. 

5. Overlay icons 

On some GUI systems (e.g. Windows), on an icon which represents an object (e.g. a file) a certain 

additional subsystem can add a smaller secondary icon, laid over the primary icon and usually 

positioned in one of its corners, to indicate the status of the object which is represented with the primary 

icon. For instance, the subsystem for locking files can add a "padlock" overlay icon on an icon which 

represents a file in order to indicate that the file is locked. 

3.5 ACTIVATING WINDOWS 

1 

1. Steps to activate Windows 10 with a product key 

STEP 1 

For installation of Windows 10, enter your product licence key. 

STEP 2 

Press the Windows key, go to Settings > Update and Security > Activation. 

STEP 3 

https://en.wikipedia.org/wiki/Brand
https://en.wikipedia.org/wiki/Logo
https://en.wikipedia.org/wiki/Trademark
https://en.wikipedia.org/wiki/IOS
https://en.wikipedia.org/wiki/Android_(operating_system)
https://en.wikipedia.org/wiki/User_interface
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Press the Change Product key. 

STEP 4 

Enter your product key into pop-up box and press Next. 

STEP 5 

Press Activate. 

2 

2. Steps to activate Windows 10 with a digital licence 

STEP 1 

While beginning activation, select 'I don't have a product key' option. 

STEP 2 

Setup and login into Windows 10 with your linked Microsoft account. 

The Windows 10 will be automatically activated at this point. In case you had made hardware changes, 

follow the next steps: 

STEP 3 

Press the Windows key, then go to Settings > Update and Security > Activation. 

STEP 4 

If Windows is not activated, search and press 'Troubleshoot'. 

STEP 5 

Select 'Activate Windows' in the new window and then Activate. Or, select 'I changed hardware on this 

device recently', if applicable. 

STEP 6 

If you get sign in prompts, follow them using Microsoft account linked to your digital licence. 

STEP 7 

Select the device you're using and check 'This is the device I'm using right now' next to it. 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  77 |`  

 

STEP 8 

Press Activate. 

Your digital licence should be there and your copy of Windows 10 will be activated.  

3.6 TITLE BAR 

The title bar is a horizontal bar located at the top of a window in a GUI. It displays the title of 

the software, name of the current document, or other text identifying the contents of that window. For 

example, in the picture below, the title bar displays the program name "TextPad" and the document 

name "Document1" that is currently being edited. 

 

Besides giving a description of the open program or window, the title bar may also contain other useful 

features that depend on the operating system and program showing the title bar. 

Basic features of the title bar 

As illustrated in the picture above, the standard title bar has a minimize, maximize, and close button, 

usually on the right side. Also, in the top-left corner of a program's window, there is an icon that shows 

these options when clicked. 

https://www.computerhope.com/jargon/w/window.htm
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Tip 

In Microsoft Windows, pressing Alt+Spacebar shows you the window menu options, as shown in the 

picture. Using this keyboard shortcut, you can perform any of the title bar options without using a 

mouse. 

Extra features and functions of a title bar 

Below is a list of some of the functions of the title bar. Keep in mind that not all of these are available in 

all operating systems and programs. 

1. Press and hold the mouse button on the title bar to move the window. 

2. Double-click the title bar to maximize the window or set the window into window mode. 

3. Windows 7 introduced side-by-side windows, a feature that "snaps" windows to the side of the 

screen. To use side-by-side windows, click-and-drag the title bar to any edge of the screen. 

 

3.7 EXPLORING WINDOWS 

Windows Explorer is the file management application in Windows. Windows Explorer can be used to 

navigate your hard drive and display the contents of the folders and subfolders you use to organize your 

files on your hard drive. Windows Explorer is automatically launched any time you open a folder in 

Windows XP. 

https://www.computerhope.com/jargon/a/alt-space.htm
https://www.computerhope.com/jargon/k/keyboard-shortcut.htm
https://www.computerhope.com/jargon/o/os.htm
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You can also right-click on a folder and select Explore to open that folder using Windows Explorer. 

 

You may already have some shortcuts on your desktop that point to locations on your hard drive you 

will frequently use with Windows Explorer, such as My Computer and My Documents. 
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My Computer shows you a list of all the drives installed on your system, including floppy drives and 

USB drives. The drive on which Windows is installed is usually displayed as the C: drive when you 

double-click on My Computer to open it using Windows Explorer. 

 

My Documents shows the location where Windows saves documents by default when you save them 

from an application such as Microsoft Word. Windows XP is a multi-user system, meaning that several 

users can use the same computer and each will have their own My Documents Folder. You can view the 

folders for all the users who have accounts on your computer by opening the folder Documents and 

Settings, which is on the root (or upper-most level) of your C: drive. 
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Under Documents and Settings, Windows creates a folder with the login name of each user who has an 

account on your computer. Each user’s folder will have a subfolder named My Documents used to save 

any files they create. 

 

If you do not see these shortcuts for My Computer and My Documents on your desktop, you can make 

them visible by right-clicking on an empty area of your desktop and selecting Properties, then clicking 

on the Desktop Tab, and finally the Customize Desktop button. 
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At the top of the window, you will see a series of checkboxes you can check to make the My Computer 

and My Documents shortcuts visible on your desktop. 

 

To launch Windows Explorer, simply click on one of these shortcuts once they are visible on your 

desktop or right-click and select Explore. 
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The Windows Explorer interface has several parts to it: 

 

1. The Title Bar: shows you the folder you are currently in. You can also set the title bar to display 

the full path to your folder (choose Tools, Folder Options, View and then check the box next to Display 

the full path in the title bar). 
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The path tells you the drives, folders and subfolders you would have to open to get to this folder, 

beginning with the root of the drive. For example, the path to your My Documents folder might be 

C:\Documents and Settings\yourusername\My Documents. 

2. The Menu Bar: this area of the interface includes the menu options you will use while working 

with your files and folders. One of the menus you will use the most is the View menu. You can use the 

options listed under this menu option to change how the contents of your folders are displayed in the 

main Explorer window. 

 

You can display thumbnails (useful if your folder contains a lot of pictures), icons (which are listed 

from left to right), a list (which contains smaller icons displayed in columns from top to bottom), and 

details (which displays columns with additional information about each file or folder such as the time it 

was last modified and its size). You can also use the Arrange Icons by option to change the way your 

files and folders are sorted in the main Explorer Window. 

3. The Standard Toolbar: contains buttons that duplicate many of the tasks you can perform using 

the options in the Menu Bar. For example, you can click on the Views button to change the display in 

the main Explorer window. 
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4. The Address Bar: like the Title Bar, the Address Bar can be set to display the full path to a 

folder (Tools, Folder Options, View and then check the box next to Display the full path in the address 

bar). You can enter the path to a folder or subfolder in the Address Bar and Explorer will open it for you 

in the main Window. 

5. The Status Bar: the bottom portion of the Explorer window displays information about the folder 

you have open, such as the number of objects (the number of files and subfolders in that folder) and the 

size. 

The main Explorer window is divided into two panes. The contents of your folders are displayed on the 

right. By default, the pane on the left displays a list of common tasks you might want to perform when 

you open a folder, such as moving, renaming, and copying. You can also set this pane to display a 

hierarchical list of the folders on your hard drive. You can do this by clicking on the Folders button in 

the Standard Toolbar or by selecting View, Explorer Bar, Folders. 

 

Any folders that have a plus sign next to them have subfolders in them. To view the subfolders, just 

click on the plus sign and the folder will expand to reveal the subfolders below the folder’s name. The 

plus sign then turns to a minus sign to allow you to collapse the contents of the folder. 
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When you select a folder, its contents are displayed on the right pane. 

 

You can then use drag and drop to move and copy files on your hard drive. You can drag files or folders 

from one location to another to move them, while holding down the Control key when dragging copies 

the files or folders. 

You can select multiple files or folders using two handy keyboard shortcuts. To select several 

contiguous files, select the first file then hold down the Shift key and select the last file. All the files in 

between will be selected so you can copy or move them. To select several non-contiguous files, hold 

down the Control key while you select each file or folder. 

3.8 MANAGING FILES: 

Copying and Moving Files and Folders 

Sometimes you will need to move a file from one folder to another, or copy a file from one folder to 

another, leaving the file in the first location and placing a copy of it in the second. You can move or 

copy a file or folder using a variety of methods. If the file or folder and the location where you want to 
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move it are visible in a window or on the desktop, you can simply drag the item from one location to the 

other. Moving a file or folder on the same disk relocates it whereas dragging it from one disk to another 

copies it so that it appears in both locations. When the destination folder or drive is not visible, you can 

use the Cut (to move), Copy, and Paste commands on the Edit menu to move or copy the items. 

Copy a File or Folder 

•  Open the drive or folder containing the file or folder you want to copy. 

•  Select the files or folders you want to copy. 

•  Click the Organize button on the toolbar, and then click Copy. 

•  Display the destination folder where you want to copy the files or folder. 

•  Click the Organize button on the toolbar, and then click Paste. 

Did You Know? 

You can arrange files and folders in an Explorer window by using Auto Arrange or Align to 

Grid. The Auto Arrange option keeps icons in a window organized so they don’t overlap each 

other, while the Align to Grid option aligns icons in a window according an invisible grid to keep 

them organized. To turn either of these options on, click the View menu in folder you want to 

modify, and then click Auto Arrange or Align to Grid. To display the menu bar, click Organize on 

the toolbar, point to Layout, and then click Menu Bar. 

For Your Information: Sending Files and Folders 

When you right-click most objects on the desktop or in Computer or Windows Explorer, the Send To 

command, located on the shortcut menu, lets you send, or move, a file or folder to a new location on 

your computer. For example, you can send a file or folder to a removable disk to make a quick backup 

copy of the file or folder, to a mail recipient as an electronic message, or to the desktop to create a 

shortcut. You can also use the Send To command to move a file or folder from one folder to another. To 

send a file or folder, right-click the file or folder you want to send, point to Send To on the shortcut 

menu, and then click the destination you want. 

Move a File or Folder 
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•  Open the drive or folder containing the file or folder you want to move. 

•  Select the files or folders you want to move. 

•  Click the Organize button on the toolbar, and then click Cut. 

•  Display the destination folder where you want to move the files or folder. 

•  Click the Organize button on the toolbar, and then click Paste. 

Copy or Move a File or Folder Using Drag and Drop 

•  Open the drive or folder containing the file or folder you want to copy or move. 

•  Select the files or folders you want to copy or move. 

•  In the Navigation pane, point to a folder list to display the expand and collapse arrows. 

•  Click the arrows to display the destination folder, and then click the destination folder. 

• Right-click the selected files or folders, drag to the destination folder, and then click Copy 

Here or Move Here. 

3.9 CONTROL PANEL 

The Control Panel is a component of Microsoft Windows that provides the ability to view and change 

system settings. It consists of a set of applets that include adding or removing hardware and software, 

controlling user accounts, changing accessibility options, and accessing networking settings. Additional 

applets are provided by third parties, such as audio and video drivers, VPN tools, input devices, and 

networking tools. 

The Control Panel has been part of Microsoft Windows since Windows 1.0, with each successive 

version introducing new applets. Beginning with Windows 95, the Control Panel is implemented as 

a special folder, i.e. the folder does not physically exist, but only contains shortcuts to various applets 

such as Add or Remove Programs and Internet Options. Physically, these applets are stored as .cpl files. 

For example, the Add or Remove Programs applet is stored under the name appwiz.cpl in 

the SYSTEM32 folder. 

In Windows XP, the Control Panel home screen was changed to present a categorized navigation 

structure reminiscent of navigating a web page. Users can switch between this Category View and the 
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grid-based Classic View through an option that appears on either the left side or top of the window. 

In Windows Vista and Windows 7, additional layers of navigation were introduced, and the Control 

Panel window itself became the main interface for editing settings, as opposed to launching separate 

dialogs. 

Many of the individual Control Panel applets can be accessed in other ways. For instance, Display 

Properties can be accessed by right-clicking on an empty area of the desktop and choosing Properties. 

The Control Panel can be accessed from a command prompt by typing control; optional parameters are 

available to open specific control panels.[2] 

On Windows 10, Control Panel is deprecated in favor of Settings app, which was originally introduced 

on Windows 8 as "PC settings" to provide a touchscreen-optimized settings area using its Metro-style 

app platform. Some functions, particularly the ability to add and remove user accounts, were moved 

exclusively to this app on Windows 8 and cannot be performed from Control Panel. 

Display Property: 

Allows the user to change the display characteristics of their computer; 

• Allows users to change the desktop background (wallpaper) to a picture of their choice and specifies 

how it should be shown. 

• Allows the user to change or disable the screensaver, and specify how long it takes to activate and 

whether to ask for a password on resume 

• Allows the user to specify the color styles of all elements within the system, primarily whether to 

use the Windows XP / Vista styles (blue by default in XP) or to use the classic Windows 

98 / Me styles, this also allows the user to change the My Computer and Recycle Bin icons. 

• Allows the user to change the screen resolution and colour quality, and provides trouble shooting 

advice for displays. 

Adding/Removing S/W & H/W: 

The Add/Remove Programs dialog allows the user to manipulate software installed on the system in a 

number of ways; 
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• Allows users to uninstall and change existing software packages, as well as indicating how much 

space individual programs take and how frequently they are used. 

• Allows users to manually install software from a CD-ROM or Floppy Disk, and install add-ons 

from Windows Update. 

• Allows users to change which Windows components are installed, via the Windows setup Wizard, 

which includes Internet Explorer, Windows Media Player and Windows Messenger 

• Finally, it allows users to specify the default applications for certain tasks, via the 'set program 

access and defaults' wizard, such as internet browsers, media players and email programs and 

whether access to these programs is available (since Windows 2000 Professional Service Pack 3 

and Windows XP Service Pack 1) 

Setting Date & Time: 

1. From the Windows menu, click Start and select Control Panel. 

2. Go to Clock, Language, and Region and click Date and Time. 

3. Click the Date and Time tab, and then click Change Date and Time. (Enter your password if 

prompted.) 

4. Choose your current day and time. 

5. Click the Change time zone tab and choose your current time zone. 

6. To observe daylight savings time, check the box next to "Automatically adjust clock for daylight 

savings time". 

7. Click OK to save and then click OK to finish. 

Screen Saver & appearance: 

Setting the Screen Saver 

A screen saver is a utility that causes a monitor to blank out or display images after a specified time 

passes without keyboard or mouse activity. (Pressing a key or moving the mouse deactivates the screen 

saver.) Screen savers were developed to prevent hardware damage to your monitor, but today's monitors 
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don't need that protection, so modern screen savers provide decoration or entertainment instead. A 

screen saver also can password-protect your computer and hide your screen when it takes effect. 

To set a screen saver: 

1. Choose Start > Control Panel > Appearance and Personalization > Personalization > Screen Saver  

 Set your screen saver's wait time carefully so your boss won't realize how long it's been since you 

did anything.   Or  Right-click an empty area of the desktop and choose Personalize > Screen 

Saver. 

2. Choose a screen saver from the drop-down list. 

(To turn off the screen saver, choose None from the list, click OK, and then skip the remaining 

steps.) 

3. Specify how long your computer must be idle before the screen saver activates. Try 15 to 20 

minutes. 

4. Click Settings to see any options for the selected screen saver—to change color or animation style, 

for example. 

5. (Optional) Check On Resume, Display Logon Screen to display a logon window when you begin 

using your computer after screen-saver activation. 

6. Click Preview to see a full-screen preview of the screen saver. 

Press a key or move your mouse to end the test. 

7. Click OK (or Apply). 

3.10 SUMMARY 

By Using windows we perform all tasks in computer. This chapter explains how beginners 

can start on computer using windows. Windows is the operating system which allow user to 

work. 

Language translators are used to convert are codes of other languages into machine code. 

Various categories of language translators include Assemblers, compilers and Interpreters 
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3.11 REVIEW QUESTIONS 

23. What is the OS? Explain its function. 

24. Explain Control panel. 

25. Explain managing files. 

26. What are basic component of windows? 

3.12 FUTURE READING 

Peter C. Jurs, Computer Software Applications in Chemistry; Wiley-IEEE. 

Manoj Kumar, M. Shamir Bhudookan, Information Technology 
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4.1 INTRODUCTION 

After studying this unit, you should be able to understand: 

⚫ Disk operating system, its internal and external commands. 

⚫ Windows, its working and windows accessories. 

⚫ MS-Word as a word processor. 

In this unit, we are discussing all the important software concepts and providing you the latest 

knowledge of all the software available in the market. Many types of software are available for 

various applications. The software development field is so advanced that day by day existing 

software are becoming outdated and new software are coming in the market. So we must get 

aware of the latest developments in the software industry. 

Here, we discuss following software packages which are required for general and special purpose: 

 Disk Operating System 

 Windows 

 Word Processor 

4.2 DISK OPERATING SYSTEM (DOS) 

An Operating System (OS) is an integrated set of specialized programs that is used to control and 

manage the resources and overall operation of a computer system. It is a class of software, which 

controls the execution of other programs. 

DOS is the most commonly used operating system. The full form of DOS is Disk Operating System. 

It is a single user operating system which means that only one application can be made to run at one 

time. DOS provides a 'Platform' or an 'Environment' which lets the application program to interact 

with CPU and I/O devices. Many application software requires DOS for running. The common 

among these are word processors like Wordstar, Professional write; spreadsheet programs like Lotus 

123, VP Planner Plus; accounting software like Tally, EX, etc. Each software package has a specific 

command to get itself running on DOS. For example, in order to run the spreadsheet program, Lotus 
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123, you will have to enter 123 at the DOS prompt, DOS will run Lotus 123 for you. On any 

application software shuts down, the control again has to come back to DOS and the DOS prompt 

can be seen again on the screen. Now, DOS is ready to accept more commands from you. 

MS DOS (Microsoft Disk Operating System), a product of Microsoft Corporation of USA, is the 

most popular operating system for PCs. Another operating system available in the market is the PC 

DOS, a product of IBM, which is almost similar to MS DOS. Whether you use MS DOS or PC DOS, 

the basic commands of DOS remains the same. 

Loading DOS 

The booting happens automatically when the computer is switched on, provided DOS is available to 

it. DOS can be present on both hard disk as well as the floppy disk. So, when the system is turned on, 

a search for DOS is done on floppy drive first. If it is not present on the floppy drive, the DOS is 

searched for on the hard disk. Thus, for booting to happen, the DOS must be present either on the 

floppy or on the hard disk. So, if DOS is not present on the hard disk, insert the floppy carrying DOS 

software in the A drive before switching on the system. If the system boots from floppy, the 

following prompt comes on the screen: 

A:\> 

where underscore character '- ' indicates the cursor (blinking mark) of the screen. However, if booting 

has been done from the hard disk, then the following prompt will come: 

C:\> 

C:\> or A:\> is the DOS Prompt. Looking at DOS Prompt, you can easily make out the currently 

active drive. If you want to switch yourself over to the another drive, then simply type its drive letter 

after the prompt and hit the <Enter> key as shown below: 

C:\>A: <Enter> 

A:\> 

Now again if you want to go back to the C drive, then type in C: and hit the <Enter> key. 

Files and Directories in DOS 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  96 |`  

 

File is a collection of related information. Any kind of text, data or program that is entered, is stored in 

a file. Now, it is very essential to organize your files in an ordered manner. This makes file search 

easier otherwise, it can really be a difficult and time consuming job to search for a particular file out of 

the whole lot of files stored on the disk. An example of library can make the explanation of the concept 

more clear. As you must have already observed, the books in a library are put in big cabinets. Each 

cabinet is divided into many shelves and sub-shelves. Each shelve or sub-shelve contains books on a 

particular subject. So, the required book on a particular subject can be found out very easily without 

wasting much time and effort. 

On similar grounds, all the files that are related to each other are clubbed at one place. This is known as 

a Directory Structure or simply a Directory. A directory structure resembles an inverted tree. The main 

directory becomes the Root directory. The directories and files become the branches of this directory 

tree. Any number of files and directories can be added to it thus, making the tree grow big downwards. 

Let us take an example: 

Suppose we wish to store two kinds of files on our disk: ACCOUNT and EXPENSE. Further, we wish 

to keep two more kinds of files (say CASHSALE and CREDSALE) under ACCOUNT sub-directory. 

DOS can very much help you in organizing your files through directory structure which is shown in 

Figure 2.1. 

 

 

 

 

 

 

 

 

Figure 2.1: Example of Directory Structure 
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It is clear from the figure that: 

(c) On the top of the directory structure, there is a Root directory. This directory is always present and 

is shown by \(backslash) for referencing. Any file or directory that is created is always under the 

Root directory. 

(d) EXPENSE is the sub-directory of the Root Directory. 

(e) ACCOUNT is the parent directory of the directories CASHSALE and CREDSALE. It can also be 

said that the CASHSALE and CREDSALE are the sub-directories of the ACCOUNT directory. 

Thus, a directory under a directory is called a sub-directory. 

It can be clearly seen that the files relating to a particular subject can be put under a directory. For 

example, all the files relating to expenses can be put under EXPENSE sub-directory whereas all the 

files relating to cash sales can be stored under the sub-directory CASHSALE. 

Referencing Files 

It's time to learn, as to how to locate a file? The directory structure shown in Figure 2.2 has two sub-

directories under the Root directory. The sub-directory EXPENSE has two files under it. 

 

 

 

 

                                       Figure 2.2: Referencing Files 

DOS allows you to go from one directory to another by following a certain path. In the beginning, the 

user is always resident in the Root directory. While travelling from one directory to another, certain 

rules have to be followed. A user cannot go directly from ACCOUNT sub-directory to EXPENSE 

sub-directory. To go from one sub-directory to another, you have to first go to its parent directory or 

the Root directory. Thus, for going from ACCOUNT sub-directory to EXPENSE subdirectory, you 

first have to go to Root directory. Similarly, for going from the file EAST.TXT to WEST.TXT, you 

have to go to the EXPENSE sub-directory first. Thus, in other words, while moving from one 
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directory to another, you have to go to its parent directory first. 

Now, in order to reach out to the file WEST.TXT the following path has to be followed: 

C:\>Expense\ West.txt 

1 3 4 5 

 

2 

Here, 

3. is the drive name where the file is resident in; 

4. is the path which DOS takes to reach for a file; 

5. is the directory under the Root; 

6. is the primary name of the file that is to be accessed; and 

7. is the extension name of the same file. 

The backslash (\) has to be used for tracing out the path. The first backslash takes you to the Root 

directory. The subsequent backslashes separate the directories, sub-directories and the filename that 

are given in the whole path. 

File Naming Conventions 

There are certain rules that have to be followed while giving names to your files. A file name has two 

parts Primary Name and Extension (Secondary Name). A dot (.) separates a primary name from an 

extension. Let as see the two parts of the file named DRAGON.TXT. 

DRAGON.TXT 

 

Primary Extension 

 

Name 
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A primary name cannot have more than eight characters and an extension cannot have more than 

three characters. A file name having only the primary name and no extension is absolutely valid 

because it is optional to give an extension to a file name. An extension is generally given by the 

language or software used. For example, if you are entering a BASIC or PASCAL program, its file 

name would have extension BAS or PAS respectively. A file name can contain the following 

characters: 

4. An Alphabet (A-Z) or (a-z) 

2. A number (0-9) 

3. Special characters such as: $, #, &, @, !, %, (, ), -, { , }, " A, etc. except *, ?, 

full stop (.) and space ( ). 

It is a good practice to give meaningful names to your files. However, no two files can have exactly the 

same name on the disk. Thus, a name given to a file on a disk has to be unique. 

A look at a few valid and invalid file names: 

VALID INVALID 

MYHUNT MY BOOK.DOC 

Dragon.Txt B.R. Arora 

Uphill.up S?JAIN.BAS 

VIJAYA EXCELBOOKS 

Employee.Emp ANARAG.** 

157.IN VICKY.MEHTA 

The rules for naming a directory are the same as that of naming files. 

Student Activity 1 

2. What is an operating system? 

3. Define MS-DOS. 

4. What is booting? 
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5. What is a file and a directory? 

6. Describe the file naming conventions in MS-Dos. 

DOS Commands 

DOS offers a variety of commands to perform various functions. With the help of DOS commands, you 

can display the list of files and directories that are present on the disk, create new files and directories, 

remove unwanted files and directories and much more. DOS commands can be entered either in 

uppercase or lowercase letters. The format of a DOS command is called syntax. All DOS commands 

begin with command name. When DOS carries out the instructions given by you, it is called the 

execution of DOS command. Let us discuss some of the DOS commands in detail. (The commands 

which you should issue, are written as bold letters throughout this unit). 

Directory Commands of DOS 

The directory commands help you to create new directories and remove existing ones. They also allow 

you to travel from one directory to another. You can also view the listing of files and directories that are 

present on the disk. 

1. Displaying a List of Files on the Disk: DIR command 

This particular DOS command helps you in displaying a list of files or directories that are present on 

hard disk as well as floppy disk. Thus, to see the contents of your hard disk, issue the following 

command: 

C\>DIR <Enter> 

The above command displays the primary name, extension and size of files in bytes. It also displays the 

date and time when the file was created or modified last. If you wish to view the contents of the floppy 

drive, then you first switch yourself to the floppy drive and then issue the DIR command as shown 

below: 

C\> A: <Enter> 

A:\>DIR <Enter> 

C\>DIR \EXPENSE <Enter> 
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Let us assume that there is one more sub-directory by the name BUSINESS existing under EXPENSE. 

To view the contents of this sub-directory, issue the following command: 

C:\>DIR \EXPENSE\BUSINESS <Enter> 

If you have a large number of files on the disk, then on issuing, DIR command, the screen scrolls up 

and only a few file names are shown. In such a case, issue the following command: 

C:\>DIR/P <Enter> 

The above command will show the contents of the disk pagewise or screenwise. Now, if you are 

interested only in seeing the file names, then issue the following command: 

C:\>DIR/W <Enter> 

The above command shows the names of files and directories widthwise. So, in one line only five 

names of files and directories are shown. The other details like the size of file, the date and time of 

each file creation are not shown. The directories are shown in square ([]) brackets. 

2. Making a Directory: MD Command 

In the earlier part of this unit, we discussed that all the related files should be clubbed at one place, 

called a directory or sub-directory. So, to club all the related files under one head, new directories 

and sub-directories have to be created. Let us create a new sub-directory by the name INCOME 

under the Root directory. 

The following command can achieve this: 

C:\>MD INCOME <Enter> 

where MD stands for Make Directory. Further, let us create another sub-directory by the name 

HOSPITAL under the sub-directory Income. 

C:\>MD INCOME\HOSPITAL <Enter> 

3. Removing a Directory: RD command 

With time, certain directories grow old and are no more needed. It is better to delete such directories 

because they can save us many precious bytes on the disk. So, let us delete the sub-directory 
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HOSPITAL with the following command: 

C:\>RD INCOME\HOSPITAL <Enter> 

where RD stands for Remove Directory 

A directory or a sub-directory has to be essentially empty before removing it. For example, in order 

to remove the sub-directory HOSPITAL, there should not be any directories and files under it. So, 

you must first delete all the files and remove all the sub-directories present under the sub-directory 

HOSPITAL before removing it. We will discuss the method for deleting files in subsequent part of 

this unit. 

4. Changing Directory: CD command 

Let us again refer to the Figure 2.2. Suppose you are under the EXPENSE sub-directory and you 

want to access the files or directories in the ACCOUNT sub-directory. This would involve the 

changing of directory from EXPENSE to ACCOUNT. This will make the ACCOUNT directory 

active. The task of changing directories can be accomplished with the help of CD command.  

Look at the following example: 

C:\>CD ACCOUNT <Enter> 

where CD stands for Change Directory 

The above command will take you to the sub-directory ACCOUNT as shown by the following prompt: 

C: \ACCOUNT> 

If you want to go to the sub-directory CASHSALE straight from the sub-directory EXPENSE, issue the 

following command: 

C:\>CD ACCOUNT\CASHSALE <Enter> 

After the above command, the following prompt will come: 

C:\ACCOUNT\CASHSALE> 

The command for going to the root directory from the above prompt is: 

C:\ACCOUNT\CASHSALE>CD\ <Enter> 
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But, the command for going to the parent or previous directory (whether it is root or sub-directory) 

is: 

C: \ACCOUNT\ CASHSALE>CD.. <Enter> 

If you are in the sub-directory CASHSALE, the above command will take you to ACCOUNT sub-

directory as shown below: 

C: \ACCOUNT> 

File Commands of DOS 

DOS offers a number of file commands for performing various operations on your file like copying, 

deleting and renaming the files. 

1. Copying Files: The COPY Command 

At times, you may have to work on some other machine. So, this involves copying files from one disk 

to another. Copying of files can happen from hard disk to floppy or vice-versa. Files can also be copied 

onto the same disk with a different name. The COPY command helps us to accomplish all these tasks. 

The syntax of the copy command is: 

COPY <Source drive>: (File spec 1) <Target drive>: (File spec 2) 

Where 

Source drive refers to the drive from where the file has to be copied. It can be 

A, B or C. 

'File Spec l' refers to the path from where the file that has to be copied. 

'Target drive' refers to the drive where the file is going to be copied. 

'File Spec 2' refers to the destination where the file is going to be copied. 

3. Copying a file to another drive under the same name: A file can have the same name if it is 

stored on different disks. Thus, to copy a file by the name SCENE from hard disk to floppy disk, 

issue the following command: 

C: \> COPY C:SCENE A:SCENE <Enter> 
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As the file is copied from the active drive, then there is no need to specify the source drive in the 

above command. On similar grounds, if the file name remains unchanged then there is no need 

specify it after the target drive. Thus, the above command can also be given in the following way: 

C:\>COPY SCENE A: <Enter> 

5. Copying a file to another disk under a different name: The name of the file can be changed 

very easily while copying. The following command copies the file SCENE from the hard disk onto 

floppy disk by the name SERENE. 

C: \>COPY SCENE A:SERENE <Enter> 

(iii) Copying a file with a new name on the same disk: The file can be copied with a different 

name and stored on the same disk. Proceeding with the above example, let us save the file 

SCENE with a new name, SERENE and copy it onto the same disk. 

C:\>COPY SCENE SERENE <Enter> 

Once this command is executed, we have the same file under two different names, stored on the 

same disk. 

(iv) Copying files from one directory to another: Suppose you have placed all your files under the 

root directory. Now, at later point of time, you wish to club all the related files at one place. This 

can be easily done. Create a directory and copy the required files from the root directory to this 

newly created directory. DOS allows you to copy files from one directory to another. 

Let us assume that you have a file by the name NORTH.TXT in the root directory and you wish to 

copy this file in the newly created Area sub-directory. The following command will do this: 

C:\>COPY NORTH.TXT \AREA <Enter> 

Similarly, you can copy files from any directory to any other directory. DOS only needs the 

specification of full path from you. Let us copy a file OLD.TXT which exists under the sub-directory 

DATA to the sub-directory INFO which is resident in the floppy disk. 

C:\>COPY DATA \OLD.TXT A:\INFO <Enter> 

2. Deleting Files: DEL Command 
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With time, certain files grow old which are no longer required. So, it is desirable to delete such files 

because unwanted files occupy precious space on the disk. Suppose there is a file on the hard disk by 

the name TRYPRG which is no longer required. The following command deletes this file: 

C:\> DEL TRYPRG <Enter> 

If the file SALE.PRG exists on the floppy disk, first you go to the A: prompt and then delete the file 

as shown below: 

C:\>A: <Enter> 

A:\>DEL TRYPRG <Enter> 

While deleting any file of a sub-directory, its full path should be given as illustrated in the following 

example. Let us assume that the TRY.PRG file exists under a subdirectory MANAGE on the hard 

disk. To delete this file-issue one of the following commands: 

C:\>DEL C:\MANAGE\ TRYPRG <Enter> 

OR 

C:\>DEL MANAGE\TRYPRG <Enter> 

You can also delete the IMT.PRG file by first changing to that sub-directory and then issuing the 

DEL command as given below: 

C:\>CD\MANAGE <Enter> C:\MANAGE>DEL TRY.PRG <Enter> 

3. Renaming Files: REN Command 

DOS allows you to give new names to your files. Assume that there is a file by the name OLD.TXT 

and now you wish to give a new name NEW.TXT to it. Carry out one of the following commands to 

get your work done. 

C:\>REN OLD.TXT NEW.TXT <Enter> 

OR 

C:\>REN DATA \OLD.TXT NEW.TXT <Enter> 

The file OLD.TXT which resides under the sub-directory DATA now has a new name NEW.TXT. 
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Wildcards 

Often you may need to do a similar kind of job on a number of files. If these files have something in 

common, then we can save the effort of performing repetitive job. So, these files can be referred 

collectively by using the wildcard facility provided by DOS. The use of wildcards in a DOS command 

gives greater flexibility when using similar type of file names. DOS offers two wildcards 

(d) ? and *. Each? can be replaced by exactly one character or none, if it is given at the end of the 

filename. As and when the? wildcard is specified in the middle of a filename, it has to necessarily match 

one character. The * wildcard can match eight or less characters in the primary name and three or less 

characters in the extension part. 

Let us take an example to make the concept of wildcards clear. Suppose the following files are present 

onto your disk: 

Old.Txt INCOME. pro Alpha Page.in 

Go.Exe OLDl Dragon.Exe KOMAL 

Expense.prg. OLD20.bas Over.prg 

Annual. 

doc 

New. doc Zee.com Old.doc 

Paper. 

com 

The following commands illustrate the concept of wildcards: 

5. If you wish to see all the files that start with the letter 0 and any extension, then give the following 

command: 

C:\>DIR 0 *.* <Enter> 

The above command will list the files OLD.TXT, OLDl, OVER.PRG, OLD20 and OLD.DOC 

6. Now, let us copy all the files with any number of characters in the primary name and the extension 

EXE with the following command. 

C:\>COPY *.EXE A: <Enter> 

The above command will copy the files GO.EXE and DRAGON.EXE onto the floppy disk. 
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7. To delete all the files beginning with OL, having two more characters in the primary name and any 

extension, issue the following command. 

C:\>DEL OL??* <Enter> 

With this command, the files OLD.TXT, OLD.DOC and OLDl are going to be deleted because 

these are the only files present on the disk which match the given wildcard pattern. The above 

command will not delete the files OVER.PRG and OLD20, because the former does not start with 

OL and the latter has 5 characters primary name. 

8. Similarly, to copy all files starting with P and an extension comprising of two characters ending 

with N issue the following command: 

C:\>DEL P*.?N <Enter> 

This will delete the file P AGE.IN because this is the only file matching the given wildcard 

pattern. 

9. For copying all the files having primary name OLD and any extension from floppy to EXPENSE 

sub-directory of hard disk, issue the following command: 

A:\>COPY OLD.* C:\EXPENSE <Enter> 

The above command will copy only two files OLD.DOC and OLD.TXT. 

10. To copy all the files with primary name anything and no extension from EXPENSE sub-directory 

of hard disk to floppy, issue the following command: 

C:\>COPY \EXPENSE\*. A: <Enter> 

The above command will copy .the files ALPHA, OLDl and KOMAL. 

11. To delete all the files of floppy, issue the following command: A:\>DEL 

*.* <Enter> 

After giving the above command, the following message will come on the screen: 

Are you Sure (Y /N)? _ 

Press 'Y' if you really want to delete all files otherwise press any key. Never try the above command 
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on root directory of hard disk, otherwise your most important DOS file COMMAND. COM will also 

be deleted and thereafter you will not be able to boot the system from the hard disk. Therefore, 

wildcards with DEL command should be used with great caution. 

Student Activity 2 

(d) List some directory commands of DOS. 

(e) What is the difference between RD and MD command? 

(f) What is the function of CD Command? 

(g) How will you copy files in Ms-Dos? 

(h) How will you rename a file in MS-Dos? 

(i) What is the advantage of wild cards? 

Some More DOS Commands 

You have already been introduced to the directory and file commands of-DOS. Now, let us make 

ourselves familiar with other commonly used commands. 

(A) Displaying and/or changing date: The DATE Command 

DOS allows you to show as well as change the current date once you are on the DOS prompt. 

Issue the following command to see or change the today's date: 

C:\>DATE <Enter> 

After issuing the above command the following screen appears: 

Current date is Thu 11-12- 

Enter new date (mm-dd-yy):_ 

So, key in the new date in 'month-date-year' format. However if you do not want to change this date 

simply hit the <Enter> key. The current date will be taken as new date. 

(B) Displaying and/or changing the current time: The TIME Command The 

TIME command is used to display and change the current time. 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  109 |`  

 

C: \> TIME <Enter> 

On issuing this command, the following screen appears: 

Current time is 11:05:10:01 

Enter new time: 

Enter the new time in hours: minutes: seconds format. Hit the <Enter> key if you do not want to 

change the time. The new time can also be specified along with TIME command. 

(C) Clearing screen: The CLS Command 

In order to clear the cluttered and clumsy screen, issue the CLS command. This will remove the 

contents shown on your screen thus making it look neater and cleaner. The CLS command is given in 

the following manner. 

C:\>CLS <Enter> 

(D) Creation 01 a new file: The COPY CON Command 

Text Files can be created by COPY CON command. Look at the following example: 

C:\>COPY CON HELLO.TXT <Enter> 

This command tells DOS to copy the information from the keyboard or Console and put it in the file 

HELLO.TXT. On issuing the command the following screen appears: 

C:\>COPY CON HELLO.TXT 

You will find a blinking cursor in the second line. Enter the text and terminate : each line by pressing 

<Enter> key as illustrated below: 

My first DOS file. The name given to this file is Hello.Txt.<Enter> 

It is very easy to create files in DOS. <Enter> 

Once all the required text is entered, hit the <Ctrl+Z> keys together to mark the end of Text. 

<Ctrl+Z> keys tell DOS that no more text is going to be entered now. Again hit the <Enter> key. 

(E) Displaying contents of files: The TYPE Command 
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The contents of any file can be viewed very easily by giving the TYPE command followed by the file 

name. Let us see the contents of file HELLO.TXT that we have just created by issuing the following 

command. 

C:\>TYPE HELLO.TXT <Enter> 

You can also send the output of a file to the printer. The following command starts the printing job 

provided the printer is on. 

C:\>TYPE HELLO.TXT >PRN <Enter> 

(F) Displaying a message on the screen: The ECHO Command 

At times, you may require to display a text on the screen while executing a set of commands. The 

ECHO command helps you to display a meaningful message on the screen. This command is issued as 

illustrated below: 

C:\>ECHO Please insert floppy in drive A: <Enter> 

The ECHO command is a special DOS command used exclusively in batch files (the files containing a 

set of DOS commands). There is one more form of ECHO command i.e., ECHO OFF as shown below: 

C:\>ECHO OFF <Enter> 

The above command tells DOS not to display other commands in the batch file. 

(G) Displaying the currently logged sub-directory: The PROMPT Command 

Users always prefer to see the prompt for currently logged sub-directory. The PROMPT command tells 

DOS to include the sub-directory, greater than (>) sign or any text as a part of the prompt. The various 

forms of PROMPT command are discussed below: 

(b) To display the path designation (e.g., \ACCOUNT\EXPENSE) and the greater than sign as a 

DOS prompt, issue the following command: 

C:\> PROMPT $p$g <Enter> 

After giving the above command, if you are logged to EXPENSE sub-directory of ACCOUNT 

sub-directory in the root directory, then the following prompt will come on the screen: 
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C: \ACCOUNT\EXPENSE>_ 

(c) To display a text “1 Love India” along with path designation and greater than prompt, issue the 

following command: 

C:\>PROMPT I Love India $p$g <Enter> 

The above command will display the following prompt: 

I Love India C: \>_ 

(c) To display just greater than sign without path designation, you can give the following 

command: 

C:\>PROMPT <Enter> 

The command will display the following prompt: C >_ 

(H) Specifying a sub-directory PATH: The PATH Command 

By this time, you must be familiar with the directory structure of DOS. Suppose your program (say 

PRINCE.COM file) lies on the GAME sub-directory of the root directory and you want to execute it 

from any other sub-directory (say WINDOWS). To execute PRINCE.COM file, first you will have to 

make GAME as the currently active sub-directory and then issue the following command: 

C:\GAME>PRINCE <Enter> 

DOS provides a shortcut way to locate and run the above program from any other sub-directory by 

specifying the path as illustrated below: 

C:\ WINDOWS> PATH C:\GAME <Enter> 

The above command tells DOS that GAME sub-directory is in the current search path of DOS. DOS 

will first search the required program file in the currently logged drive and then GAME sub-

directory. Thus, the PRINCE.COM file can be executed directly from WINDOWS or any sub-

directory as shown below: 

C:\WINDOWS>PRINCE <Enter> 

The PATH command is generally used in batch files. 
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Student Activity 3 

(d) How will you set date and time of system in Ms-Dos? 

(e) What is the function of CLS command? 

(f) How will you create a new file in MS-Dos? 

(g) What is the function of Type command? 

(h) What is the function of path command? 

(i)  

Internal and External Commands 

All DOS commands can be classified into two categories: Internal Commands and External 

Commands. 

Internal Commands 

The commands which are a part of the main files of DOS (i.e., COMMAND. COM and two hidden 

files) are known as Internal Commands. They are loaded in the RAM as soon as the computer is 

switched on. The important internal commands are: DIR, COPY, DEL, REN, MD, CD, RD, TYPE, 

COPY CON, DATE, TIME, CLS, ECHO, PROMPT and PATH. We have already discussed all these 

commands quite in detail. These commands are very frequently used. 

External Commands 

External commands are those commands which are stored on disks as separate program files. These 

files have the same primary name as the command name. The extension of these files is either COM 

or EXE. So, at the time of execution of these commands, the corresponding program file should be 

present in the DOS sub-directory of the harddisk and DOS sub-directory should also be in the path 

search. The commonly used external commands are: FORMAT, DISKCOPY, CHKDSK, XCOPY 

and LABEL. Let us learn about these commands. 

1. Making the disk usable: FORMAT Command 

Before discussing the format command in detail, let us first see what is meant by the term 'Formatting'. 

Generally when you purchase a diskette from the market, it is unformatted. It can be compared with a 
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notebook which has blank pages without any ruler lines. You would prefer to put lines, write page 

numbers and categories the pages into equal parts so that an index can be made and the required topic 

can be searched very easily. Similarly, DOS organizes the disk into concentric circles which are called 

tracks. Tracks are further divided into triangular regions. Each such region is called a sector. The 

organization of disk into tracks and sectors is called Formatting. The Figure 2.3 makes the formatting 

concept more clear. 

FORMAT command is used for formatting a hard disk or floppy disk. As FORMAT is an external 

command, a file by the name FORMAT. COM should be present on your disk. In order to format the 

floppy disk, issue the following command: 

C: \> FORMAT A: <Enter> 

 

 

 

 

 

Figure 2.3: Process of Formatting 

Once the above command is executed, the following message appears: 

Insert new diskette in drive A: 

and strike ENTER when ready 

Insert a floppy disk in drive A and hit the <Enter> key. When the formatting of the disk is done, the 

following message appears on the screen. 

Enter Volume Label (upto 11 characters):_ 

Here, you can give a name to the disk for its easy identification. A label upto 11 characters can be given 

to the disk after it is formatted. If you don't want that your disk should carry any label, simply press 

<Enter> key. Now, the following message will come: 
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Format Another (Y/N)?_ 

Now, if you want to format another disk, then hit 'Y' (for Yes) and insert that disk in the drive otherwise 

type in 'N' (for No) or press any key to end the format program. 

New disks should always be formatted for using them. But old disks can also be formatted. Formatting 

will make the disk blank by erasing all its data. You may require to format an old disk if it has bad 

sectors and is needed again for usage. However, the FORMAT command should be used with extreme 

caution. Any disk whether hard disk or floppy disk will lose all data stored on it once the formatting 

operation is done. Therefore, you should not try the FORMAT command for formatting the hard disk. If 

you format the hard disk, all the contents stored on it are going to be removed permanently and new 

tracks and sectors will be created. 

FORMAT command also provides a method for making your disk bootable. The following command is 

used for this purpose: 

C:\>FORMAT A:/S <Enter> 

With the help of above command, all the operating system files (COMMAND. COM and two hidden 

files) are copied from the hard disk to the floppy disk. This floppy can now be used to load DOS in the 

computer's memory if you are unable to boot the system from the hard disk. The COPY command 

cannot serve the above purpose because it cannot copy the two hidden files of DOS in the boot sector. 

2. Checking a disk: The CHKDSK Command 

The command CHKDSK helps to check the status of the disk. After checking the disk, CHKDSK 

displays several items of information. However to get executed, this command needs the program file 

CHKDSK.COM. Let's check the status of the disk in drive A through the following command: 

C:\>CHKDSK A: <Enter> 

On successfully checking the disk, the following status is shown on the screen: 
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If no drive letter is specified with CHKDSK command, then the currently active drive is checked for. 

3. Giving volume label to disk: The LABEL Command 

Although, you have seen that a volume label to the disk is given at the time of formatting the disk, 

DOS also provides LABEL command to change, delete or give new label. This command needs a 

program file LABEL.COM. Let us give a label to the floppy disk by the following command: 

C:\>LABEL A: <Enter> 

Once the above command is executed the following screen appears: 

Volume label in drive A has no label 

Volume label (11 characters, ENTER for none) _ 

So hit the <Enter>key if you want to delete the volume label without typing in anything. You can 

also provide volume label directly with the following command. 

C:\>LABEL A:MANOJ <Enter> 

4. Copying contents of one the floppy disk to another: The DISKCOPY Command 

The DISKCOPY command helps you to copy all the contents of one disk onto the other in such a 

way that both disks become identical. It copies the contents of the floppy disk present in source drive 

onto the disk present in the destination drive. If you have a single drive on your computer, then the 

same drive can act as source as well as the destination drive. The command to copy the contents of 

one floppy onto the other is given here: 
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C:\>DISKCOPY A: A: <Enter> 

When you issue the above command a screen like the one shown below appears: 

Insert SOURCE diskette in Drive A 

Press any key to continue 

At this point, insert the diskette whose contents are to be copied and then hit any key. Another message 

appears on the screen as shown below: 

Insert TARGET diskette in drive A 

Press any key to continue 

So, after this message appears, insert the diskette into which the files are to be copied. Thereafter, press 

any key to continue the process. Once the process of copying is completed, the following screen 

appears: 

Copy Complete 

Copy Another (Y/N)?_ 

Press the 'Y' (for Yes) key if you want to copy the contents of some other diskette. DOS will again 

prompt you to enter the source diskette. However, if you want to stop the DISKCOPY process, press 'N' 

(for No). DISKCOPY command first formats the target diskette if it is unformatted and then copies files 

onto it. So, if any contents exist on the target diskette, they are all going to be removed. The 

DISKCOPY command needs the program file DISKCOPY.COM for execution. 

5. Copying files and directories: XCOPY Command 

The XCOPY command is used to copy the files present in sub-directories. The command 'COPY *.*' 

copies the files of the currently working directory and DISKCOPY command copies the entire contents 

from one floppy to another. So, they are not helpful in copying files selectively. The XCOPY command 

offers three special advantages: 

a) It prompts you to specify the files that you want to copy. 

b) It can also copy directories and other lower level directories. 
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c) It can be used to copy files from the hard disk to the floppy disk. 

Now, let us explore the XCOPY command. If you wish that DOS should ask for your confirmation for 

copying a file, then use the /P option along with the XCOPY command. Consider the following 

example: 

C:\>XCOPY C:ACCOUNT A:ACCOUNT /P <Enter> 

If you want to copy the directories and lower level directories, then use the /S option alongwith the 

XCOPY command. Look at ,the following example: 

C:\>XCOPY C: ACCOUNT A:ACCOUNT /S <Enter> 

This command will copy the directory and all the sub-directories onto the A disk. However, if the /S 

option is not specified, then the XCOPY command works within the single directory. You can also use 

/P and /S option simultaneously with the XCOPY command as shown below: 

C:\>XCOPY C:ACCOUNT A:ACCOUNT /P/S <Enter> 

The whole path can be specified with the XCOPY command. This command again needs the program 

file XCOPY.EXE in order to get executed. 

BATCH Files 

Very often, you keep keying in the same sequence of commands to do a repetitive job. For example, 

everyday, when you start your work on the computer, you first see the listing of files present on the hard 

disk. Then, you copy all the files with extension EXE and TXT from the floppy disk to hard disk. Thus, 

for achieving your task, you have to issue the following commands everyday. 

C:\>DIR/P <Enter> 

C:\>COPY A: *.EXE C: <Enter> 

C:\>COPY A: *.TXT C: <Enter> 

DOS can really simplify your task. All the sequence of commands can be put in a file which is called 

a batch file. This file offers a great advantage. Any number of commands given in a batch file can be 

executed by just giving a single command at the DOS prompt. DOS executes all these commands one 

by one. All the batch files can have any primary name but the extension given to these kinds of files 
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is BAT. The method of creating a batch file is exactly similar to that of creating any other file on 

DOS. Let us see it, through an example: 

(g) \>COPY CON MY. BAT <Enter> 

DIR/P <Enter> 

COPY A: *.EXE C: <Enter> 

COPY A: *.TXT C: <Enter> <CTRL+Z> 

<Enter> 

In the above example, a batch file by the name MY.BAT has been created. If you want to execute 

this file, simplify type in the name of the file at the DOS prompt as shown below: 

C:\>MY.BAT <Enter> 

or C:\>MY <Enter> 

The commands given in this batch file are going to be executed one by one in the sequence specified. 

The AUTOEXEC. BAT File 

The AUTOEXEC.BAT is an autoexecutable batch file. It is a special kind of a batch file. This file is 

executed as soon as the operating system is loaded in the computer's memory. The 

AUTOEXEC.BAT file is needed when you want it to be executed automatically each time the system 

is switched on. Now, as soon as the computer is switched on, DOS searches for the 

AUTOEXEC.BAT file in the Root directory of the bootable disk. If the system finds this file, then all 

the commands given in it are executed one by one instantly without even asking for date and time. 

The AUTOEXEC.BAT file is created like any other batch file. Look at the following example: 

A:\>COPY CON AUTOEXEC.BAT <Enter> 

ECHO OFF <Enter> 

CLS <Enter> 

ECHO My first Autoexec.bat file successfully executed <Enter> 

PROMPT $P$G <Enter> 
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PATH C:\DOS;C:\ WINDOWS <Enter> 

<CTRL+Z> <Enter> 

Enter the above commands on the root directory of bootable floppy disk. Reset your system. You will 

notice the above created batch file being executed automatically. 

Student Activity 4 

• What are Internal and external DOS commands? 

• What is the function of FORMAT commands? 

• What is the function of CHKDISK command? 

• What is the difference between DISKCOPY and XCOPY? 

• What are batch files? 

• Describe AUTOEXEC.BAT file. 

4.3 WINDOWS 

Windows is an another popular software. Windows 98, a product of Microsoft is the latest upgrade of its 

earlier versions (Windows 3.0, 3.1, 3.11 and 95). It is a Graphical User Interface (GUI) which has been 

designed to make your work more intuitive and easy. There is no more need of remembering the exact 

syntax of commands to get your work done. Everything is provided in the form of pictures and graphics. 

Windows 98 is a full fledged operating system. The program files and other resources are generally 

accessed with the help of mouse. The Windows 98 desktop acts as the primary media for organizing 

your programs, files and resources. 

Hardware Requirements 

The minimum hardware configuration required to run Windows 98 is given below: 

• 486 or Pentium CPU 

• At least 4 MB of RAM 

• 10 MB to 40 MB of free disk space 
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• SVGA monitor 

• Mouse 

• Keyboard 

Features of Windows 98 

We will briefly discuss some of the features of Windows 98: 

• It provides a graphical operating environment. All the programs and other resources are provided 

in the form of Icons. 

• It is a full fledged operating system with an in-built copy of DOS. DOS programs can be safely run 

on Windows 98. 

• It is a multi-threaded and preemptive multi-tasking operating system which means that more than 

one application can be made to run simultaneously and more smoothly. 

• It supports long file names upto 255 characters, thus, breaking the DOS naming convention where 

you can give primary file name upto 8 characters. 

• The plug and play feature of Windows 98 automatically adapts itself to the hardware it is running 

on. It can detect hardware and then install all the proper drivers without taking any help from you. 

• It gets you organize all your work on the desktop or in folders. You can safely click at any folder to 

open it up. 

• It is more effective in cleaning up after crash of a faulty application. At any time, if a program 

crashes, you can remove it safely from the tasklist without disturbing other running application. 

The memory and other resources that the application was using are altogether freed. 

• It contains a disk compression program which can essentially double your hard disk space, thus, 

preventing you from buying a new hard disk. 

The Windows 98 Desktop 

So, as and when you switch on your computer, Windows 98 is loaded in the RAM and a desktop 

appears on the screen as shown in Figure 2.4. This desktop contains folders, files, applications, taskbar 
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and shortcuts. 

The objects labelled 'My Computer', 'My Briefcase' and 'Network Neighbourhood' are examples of 

folders. A folder is similar to a directory in DOS. A folder can contain other folders and 

 

 

 

 

 

 

                                              Figure 2.4: The Windows Desktop 

individual files under it. Thus, to open a folder just double-click it. All the files and folders are shown 

graphically. Looking at the filename icon, you can easily make out the application to which it is 

associated. In order to open a file within a folder, simply double-click it. It will open the file with the 

correct application. Multiple objects can be selected by clicking at the object and then holding down 

the <Ctrl> key on the keyboard and clicking on another object. You can select as many files and 

folders as you want. 

Now, to open the folder 'My Computer' just double-click it. All the resources on your computer are 

shown in it as can be seen in Figure 2.5. Now, if you want to see the files and folders present on your 

floppy disk, click the object 3 1/2 Floppy (A:) Icon. 

 

 

 

 

 

Figure 2.5: The ‘My Computer’ Window 
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The Taskbar 

Taskbar is located at the bottom of the Windows 95 desktop. It contains a 

start button on the left side. On the extreme right side, the taskbar shows the 

current time. The taskbar also shows all the applications that are currently 

opened. You can switch between applications using the taskbar. The Figure 

2.6 shows that Paint and Aldus Pagemaker 5.0 are the applications that are 

currently running, The button of the application that is running in the 

foreground appears depressed. The button that appears raised tells us that the 

application is running in the background. However, if you want to run any 

particular application in the foreground, then simply click at that button 

appearing on the taskbar. 

 

Figure 2.6: The Taskbar 

The Start Button 

The Start Button is a new and much useful feature of Windows 95. Click on it 

once to display the start menu. From the start menu many other menus can be 

seen. You can select any of the menu option by taking your mouse pointer on 

that particular menu can be seen in Figure 2.7. 

 

 

 

 

 

 

 

Figure 2.7: The Start Menu 
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1. The Program Menu 

The program menu of Windows 95 as shown in Figure 2.8 is exactly similar to the program group found 

in Windows 3.1. It contains program groups and individual programs. Thus, to launch any program, 

simply take your mouse pointer at that particular program and click it. In order to open 'Accessories' 

program group, move the mouse pointer to that group and a cascading menu will appear on the screen. 

It contains Windows 98 accessory programs such as WordPad, Paint, Notepad, etc. 

 

 

 

 

 

 

 

 

 

figure 2.8: The Accessories Group 

2. The Document Menu 

This menu shows you the document that you recently opened or worked upon. This offers a short way 

of opening a document. It launches the application in which the document was created. The document 

menu keeps tracks of the latest fifteen documents that you have used and it puts them in an alphabetical 

order. 

3. The Setting Menu 

This menu is used for changing the default system setting. You can fiddle with the control panel, printer 

folder and taskbar setting from here. 

4. The Find Command 
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The Find option of the start menu helps in locating a particular file or a folder. It offers a quick way of 

finding a file. In the 'Named' box type in the file name you want to search. Accordingly, Windows 98 

will return you the full details about the file. 

5. The Help Command 

Windows 98 has got very smart help to offer. In case you find yourself stuck on any issue simply select 

the Help option from the Start Menu. Above all, you can type in your query in your own words. 

Windows 98 will display you the related information. 

6. The Run Command 

The Run option of the Start Menu helps you to run your file or application straightway. Simply type in 

the full path and the filename in the 'Open' box and click at 'OK' button. You can also make use of the 

'Browse' button in order to locate appropriate files. 

7. The Shutdown Command 

This command is used for shutting down the system. It offers three options. You can shut down your 

system, restart your system in windows mode itself or you can switch yourself to DOS mode 

temporarily. Select appropriate option depending upon your requirement. 

Student Activity 5 

(iii) Why is windows called GUI based operating system? 

(iv) What are the minimum hardware requirements to run windows 98? 

(v) What are the features of windows 98? 

(vi) What is a desktop? 

(vii) What is the taskbar? What does it hold? 

Windows Explorer 

The File Manager of Windows 3.x is replaced with Windows 95 explorer. It helps you to manage and 

organize your files and folders. In order to start explorer click at the start menu. Select Programs and 

then the Windows Explorer option. The 'Windows Explorer' windows comes up on the screen as 

shown in Figure 2.9. This screen lets you to explore anything on your desktop. The left part of the 
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explorer screen shows the desktop at the highest level. All the components of the desktop like 'My 

Computer' ,'Network Neighbourhood', 'Recycle Bin', etc., are shown under it. You must have 

observed that some components of the desktop have a plus sign (+) before them. It shows that there 

are deeper level of components under it. On clicking at the plus sign, the next level of the hierarchy is 

shown. 

 

 

 

 

 

 

 

Figure 2.9: The Windows Explorer 

This layering of components continues as long as there is deeper level of folders or components 

underneath. The right side of the Explorer Screen shows the contents of the folder or the components 

that are selected in the left part of the explorer window. In the right part of window only, the major 

actions are performed. Now, we will learn some of the important functions that are performed 

frequently. 

(A) Renaming a file or a folder 

In order to rename a file or a folder, follow the steps given below: 

• Select the file or the folder that has to be renamed. 

• Right click the mouse button and select the Rename option. 

• Type in the new name that you wish to give to the file. 

(B) Deleting a file or folder 

A file or a folder can be safely deleted by following the steps given below: 
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1. Select the file or folder that has to be deleted. 

• Hit the <Del> key or from the File menu, select the Delete option. 

• Windows 98 will confirm before deleting the file. 

(C) Moving a file 

Windows 98 allows you to move files from one place to another. A file can be moved from one folder 

to another by simply performing the following drag and drop procedure: 

• Select the file that you want to move from the right pane. 

2 Click the file or the folder on the left pane and drag it in the new destination. 

(D) Copying a file to a floppy 

In order to copy a file to the floppy disk, follow the steps mentioned below: 

• Select the file that has to be copied to the floppy disk. 

• Right click the mouse button and select the Send To option. 

• Select the floppy disk to which the file has to be copied. 

(E) Creating a new folder 

A new folder can be created by following the steps given below: 

• Select the parent folder that will contain the new folder. 

• From the File menu, select the New option. From the cascading menu, select the Folder option. 

• Windows 98 will ask you the name that has to be given to the new folder. 

(F) Restoring from the Recycle Bin 

In Windows 98, deleting a file is a two step process. Once the file is deleted, it is put in the 'Recycle 

Bin'. The 'Recycle Bin' appears on the desktop. It is of immense use if you have accidently deleted your 

files. The files once deleted can be restored from the 'Recycle Bin'. However, if the file is deleted from 

the 'Recycle Bin' also, then you cannot in any case recover your file. So, the Recycle Bin helps you to 

retrieve deleted files. In order to restore a file from the 'Recycle Bin', follow the steps given below: 
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• Double Click the 'Recycle Bin' icon available on the desktop. A dialog box opens up as shown in 

Figure 2.10. 

• This window shows all the files that have been deleted. Select the file that you wish to restore. 

• From the File menu, select Restore option. 

 

 

 

 

 

 

 

 

                                    Figure 2.10: The Recycle Bin 

 

(G) Emptying the Recycle Bin 

If you wish to delete all the files from the Recycle Bin also, then follow the steps given below: 

(iv) Double-click the 'Recycle Bin' icon on the desktop. 

(v) From the File menu, select the Empty Recycle Bin option. 

(vi) Windows 98 will ask you to confirm before deleting all the files. 

Windows 98 Accessories 

Windows 98, like its predecessors, contains several built-in accessories which make your computer 

easier and more convenient to use. In order to access Windows 98 accessories, click on the Start 

button, move the mouse cursor to programs and then click at the Accessories option of the cascading 

menu. We will learn a few of the commonly used built-in accessories of Windows 98. 
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(A) WordPad 

Microsoft WordPad for Windows 98 is a very simple word processing program which allows you to 

create, read and modify simple documents. It is more or less similar to Windows 3.x Notepad 

program but contains more features and is capable of opening a wider variety of documents. It 

contains basic file manipulation, editing, viewing and formatting tools that are essential for creating 

simple documents. It contains standard menu items. The Wordpad can be seen in Figure 2.11. 

 

 

 

 

 

 

 

figure 2.11 : The WordPad Application Window 

(B) Microsoft Fax 

The Microsoft Fax program of Windows 98 helps you to send and receive faxes. It can help you to 

send the documents that have been created on your computer. You can also send documents directly 

from compatible applications without ever leaving the application e.g., using Word for Windows, 

you can use the File menu's Send command to direct the output of that application directly to a fax 

telephone number rather than a printer. 

(C) System Tools 

Windows 98 contains a number of useful system tools to help you see and configure your system. Let 

us briefly discuss a few system tools. 

Backup: This program helps you to perform backups of your computer system. 

Disk Difragmenter: This system tool reconfigures files on your hard disk so as to speed up disk 
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access times. 

Scan Disk: This utility is more or less similar to the old DOS checkdisk utility. It scans your disk and 

gives you the disk status by finding out the used, unused and bad sectors. 

Drive Space: This utility is a disk compression program that can double up the space on a disk drive. If 

you need some extra space on your disk, you can use this facility. 

(D) Multimedia 

Windows 98 contains utilities that can control your CD-ROM player and multimedia abilities. You can 

use it to control various aspects of your multimedia system. 

(E) Calculator 

Windows 98 has a desktop calculator that can perform simple calculations. It contains both the standard 

as well as the scientific calculator. The calculator has been shown in Figure 2.12. 

 

 

 

 

 

 

 

 

 

Figure 2.12: The Standard Calculator 

(F) Paint 

If you are a graphics lover, Windows 98 can fulfil your desire. It contains 'Paint' utility which can create 

simple graphics. You can create, open, view and edit graphics files such as bitmaps, PC Paintbrush files, 

etc. A typical Paint can be seen in Figure 2.13. 
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                                          Figure 2.13: The Paint Application Window 

Student Activity 6 

• What is the function of windows Explorer? 

• How will you rename a File or a folders? 

• How will you delete a file or folder? 

• How will you copy a file to a floppy in windows? 

• What is the function of Recycle bin? 

• How will you restore a file from recycle bin? 

• List some windows 98 accessories. 

4.4 WORD PROCESSOR 

Word processing includes typing in text and manipulating it so as to give a very systematic and 

organized look to your document, which enables easy reading. The application software or program 

which helps us in processing the text is called a 'Word Processing Software, or simply a 'Word 

Processor'. So, you can say that a word processor is nothing but a computer program that helps you 
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to: 

⚫ type your text 

⚫ correct spelling mistakes and grammatical errors 

⚫ align text within margins 

⚫ offer a variety of font styles and font sizes 

⚫ see a preview of the text that you have typed in. 

Popular Word Processing Packages 

The commonly used word processing packages are: 

⚫ MS-WORD 

⚫ Word Star 

⚫ Word Perfect 

⚫ Professional Write 

Uses of Word Processing 

Normally, a word processor can accomplish the following tasks: 

⚫ Brochures 

⚫ Newsletters 

⚫ Reports 

⚫ Advertisement 

⚫ Resumes and Cover letters 

⚫ Books 

⚫ Directories 

⚫ World Wide Web Pages 

There is absolutely no end to what a word processor can do. By now you must have realized that the 
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word processing applications have become much more sophisticated than before. 

4.5 STARTING WORD 2000 

To startup Word in Windows 95 or Windows 98, do the following steps: 

• Click at the Start button which lies at the bottom left corner of the screen. 

• Click at the 'Programs' option. A cascading menu appears on the screen.  

• Click at 'Office 2000' option. Again, a cascading menu appears. Select 'Microsoft Word' option of 

the cascading menu. Word will be loaded in the computer's memory. 

The menu options might not exactly resemble with those seen on your computer. So, in that case you 

might need search where actually MS-Word is installed on your computer. 

Alternatively, you can start MS-Word in the steps given below: 

• Click at the START button. 

• Select 'New Office Document' as shown in Figure 2.15. 

 

 

 

 

 

 

 

 

                      Figure 2.15: Alternative Method to Start Word 2000 

This would bring up Word with a new document opened up for you. Your computer screen will match 

closely to the Figure 2.16. This blank page is nothing but an empty file created automatically by 

WORD. This file by default gets the name - Document l. The extension given to a Word document is 
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'doc'. 

Screen Elements 

When Word opens up, you will notice two windows on the screen, one nested closely within the 

other. The larger among these is called the Application Window, which frames the entire screen. The 

smaller window is called the Document Window, which fits in the application window. Both these 

windows serve a different purpose. The application window helps the user to communicate with the 

Word program, whereas, the document window is used for creating as well as modifying the Word 

documents. So, as you keep typing, the words displayed on the monitor or screen, are actually shown 

in the document window. The different elements of the screen are shown in Figure 2.16. The different 

elements of this screen are outlined in Table 2.1. 

 

 

 

 

 

 

 

 

Figure 2.16: Screen Elements of Word 

 

 Table 2.1: Description of Screen Elements 

Screen Element Description 

  

Title Bar Located at the top of the screen; it displays the name of the application (here 

 'Microsoft Word') and the active document name (here 'Document l '). 

Menu Bar It shows menu options of Word and is located under title bar. 

Standard Located exactly below the menu bar and gives access to WORD's most 

Toolbar frequently used commands and utilities. 
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Formatting Lies below the standard toolbar; it offers commonly used formatting 

Toolbar commands. 

Ruler Line Located below the formatting toolbar and provides ongoing page measurement 

 and quick access to margins, tabs and indents. 

Status bar Located at the bottom of the screen; it displays important and varied 

 information about the currently opened document like page number, column 

 number, line number, etc. 

View Buttons Located towards the left side of the horizontal scroll bars(above status bar); 

 

they show the documents in different views like normal view, page layout 

view, 

 outline view etc. 

Horizontal Help the user to move in the left or right side of the document. 

Scroll Bars  

Vertical Help the user to go up or down in the same document. 

Scroll Bars  

Maximise Located in the upper right corner of the screen; it controls the size of the 

Button application window. 

Minimise Located in the upper right corner of the screen, towards left of maximise 

Button button; it helps to mini mise the whole application and show it in the reduced 

 form on the taskbar. 

Close Button Located in the upper right corner of the screen, towards right of maxi mise 

 button; it helps to shut down the opened application; it also allows the user to 

 save the opened files before quitting Word. 

Contents of Menu Bar 

All the menu pads located on the menu bar can be pulled down by clicking at them or by pressing <Alt 

+ key> where 'key' is the underlined character of the menu name. At one time only one menu pad can 

be activated and pulled down. From the pull down list, any entry can be selected with the help of 

mouse. In all the pull down menus, you would find that a few entries are shown in light color. These 

entries are called 'ghosted' entries and are inaccessible, These ghosted entries become solid only when 
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the features they support become accessible. For example, the cut, copy, paste entries become active 

from the 'Edit' menu only when some text is selected and is made available on the clipboard. When the 

text is no more selected, these entries again become inactive. 

Now, we will explore the contents of different menu pads briefly. 

5. File: Pull down the 'File' menu by pressing either <Alt + F> keys together or by clicking it with the 

help of mouse. This menu is used for performing file operations like creating a new file, opening 

an existing file and then closing it. The 'Save' options help to save the files. The 'Properties' option 

gives information about the current document. The 'Page Setup' option allows to set page size, 

margins and paper orientation etc. Document can be previewed with the 'Print Preview' option. The 

printing operations can be carried out using 'Print'. 'Exit' option closes the Word application. At the 

bottom of 'File' menu, the names of all recently saved files are displayed. The 'File' menu has been 

shown in Figure 2.17. 

 

 

 

 

 

 

 

 

 

Figure 2.17: The File Menu 

4. Edit: The 'Edit' menu helps you to delete, copy and move chunks of text. The 'Paste Special' option 

helps you to link your text with other applications. 'Find' option tries to help you by searching a 

particular word or phrase. In case you want to replace the selected word with some other word or 

phrase, then use the 'Replace' option. The 'Edit' menu can be seen in Figure 2.18. 
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                                            Figure 2.18: The Edit Menu 

5. View: The 'View' menu can be used to show your document in a variety of ways like Normal, 

Outline, Page Layout, Master Document and Full Screen. Through the 'Toolbars' option, you 

can also decide the toolbars that you want to see on your screen. 'Ruler' option turns on or off 

the ruler line. Headers and footers are added to the document through 'Header and Footer' 

option. You can see the 'View' menu in Figure 2.19. 

 

 

 

 

 

 

 

 

                                 Figure 2.19: The View Menu 
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(H) Insert: The 'Insert' menu helps to insert page numbers, the current date and time, symbols, 

footnotes, cross-references, tables, section-breaks, files, bookmarks, pictures, objects including 

equations, databases and different varieties of captions. The 'Insert' menu has been shown in 

Figure 2.20. 

 

 

 

 

 

 

Figure 2.20: The Insert Menu 

5. Format: The 'Format' menu is basically used for enhancing the look of the document. It can 

make your document’s look beautiful by adding a variety of font types and sizes, paragraph 

formats, tabs, borders and columns, drop caps, bulleted and numbered lists and style settings. 

The 'Format' menu can be seen in Figure 2.21. 

 

 

 

 

 

 

Figure 2.21: The Format Menu 

(c) Tools: The 'Tools' menu can be used to check for spelling and grammatical errors through the 

'Spelling and Grammar' option. The 'Word count' option tells you the number of words, characters, 

lines, etc., in the whole document. Envelopes and labels can be prepared using 'Envelopes and 
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Labels' option. 'Macros' option is used to create and run macros. The 'Tools' menu can be seen in 

Figure 2.22. 

 

 

 

 

 

 

 

figure 2.22: The Tools Menu 

(g) Table: The 'Table' menu adds and edits the tables in your document. A row and a column can be 

safely selected using the 'Select Row' and 'Select Column' options respectively. 'Select Table' 

option selects the whole table. The table entries can be sorted using the 'Sort' option. 'Gridlines' 

option turns on or off the gridlines of the table. The 'Table' menu can be seen in Figure 2.23. 

 

 

 

 

 

 

 

Figure 2.23: The Table Menu 

(c) Window: The 'Window' menu allows you to add, arrange and select document windows in a case 

where more than one document is open. The 'Window menu can be seen in Figure 2.24. 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  139 |`  

 

 

 

 

 

 

 

Figure 2.24: The Window Menu 

(iv) Help: The 'Help' menu can be used to look for specific information. It also gives some knowledge 

about Microsoft Word itself. If you find yourself in a difficult situation anytime, then do not 

hesitate taking help from Word through this particular menu. 

Student Activity 7 

(ii) List some Windows 98 accessories. 

(iii) What is a word processor? Name some words processing packages. 

(iv) What is the use of word processing? 

(v) How will you start MS-Word? 

(vi) Describe various screen elements of MS-Word. 

(vii) Describe various menus available on Menu bar. 

Enhancements in Word 2000 

Word 2000 has come up in a new loop before us. It has not many new tools and features with which 

it is fastly gaining popularity among users. Each kind of user can get some new spice of his taste 

added to the new Word 2000. Let us make ourselves acquainted with some of the new in-things of 

World 2000. 

1. The animated paperclip on the screen always keeps smiling at you as shown in Figure 2.26. 

Clippit is a new office assistant, which is there on the screen the first time you start Word 2000. 
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It tried to help you in every way whenever and wherever you are stuck, It can also be 

customized according to your special needs and requirements. 

2. Some new dimensions are added to the intelligent features of Word 2000. When you are 

working in Word, it tries to figure out what it can do more easily and efficiently than you. Many 

of the intellisense options start with the word 'Auto' like Autocomplete, Autocorrect, 

Autoformat, Autotext and Autosummary. 

 

 

 

Figure 2.26: Paperclip 

(iii) Word 2000 offers the facility of 'Document Map' with the help of which you can move easily 

from one place to another in your document. One clicking at the 'Document Map' icon on the 

standard toolbar, a sidebar to the left of the screen is seen. It shows major headers in the 

document. Click at any of headers and Word will take you there instantly. 

(iv) Word 2000 has also made a mark in offering shortcuts to Web Browser such as Microsoft 

Internet Explorer or Netscape Navigator. With the help of Web Browser, connectivity to the 

world wide web has been made possible. You can also create your own documents that can be 

seen on Web. Regular Word documents have to be converted into a format called HTML which 

is done automatically by Word 2000. 

(v) The new Word 2000 can be seen with expanded graphic capabilities. It has the ability to act as a 

full fledged desktop publishing program. Advancements like text rotation tool, special 

photoshop-type effects, 3D objects etc., have been made to it. Tables can be very easily made 

with the 'Draw Table' option of Word 2000. 

This is not end of the road. The enhancements done to Word 2000 as discussed above are just a small 

chunk. 

Working with Documents 

It's time to familiarize ourselves with the various important concepts like creation of new files, opening 
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existing files, saving and finally closing them. 

Creation of a New Document 

At times, you might need create a new document from scratch. So, for creating a new document, click at 

the 'File' menu and then select the 'New' option as shown in Figure 2.27. Now, Word is ready to accept 

text as well as other related commands from you. 

You can also open a new document by clicking at the 'New' button available on the standard toolbar. 

Look for the 'New' icon in Figure 2.29 shown on the next page. Remember to save your document 

before quitting. ('Saving a Document' is being discussed in the subsequent part). 

 

 

 

 

 

 

Figure 2.27: The 'New' Option of File Menu 

Opening a Document 

If your document is stored on any of the storage devices like hard disk or floppy disk, then it becomes 

possible to retrieve that document and the user can manipulate it the way he/she wants. Word offers a 

variety of ways to open your document which are discussed below: 

Method 1: Opening a document from desktop 
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             Figure 2.28: The 'Open Office Document' Option of Start Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click at the Start button. Point at 'Open Office Document' and click it as can be seen in Figure 2.28. 

Alternatively, click at the option 'Open Office Document' of the Office shortcut bar available on the 

desktop. 

Method 2: Opening a document from Word's startup screen 
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Click at the 'File' menu and select the option 'Open' as can be seen in Figure 2.30. 

 

 

 

 

 

 

 

 

 

 

 

 

 

figure 2.30: The 'Open' Option of the File Menu 

Alternatively, for opening a document, just doubleclick at the 'Open' button from the standard toolbar. 

This icon looks exactly similar to a file folder and has been shown in Figure 2.30. 

One very important thing to observe here is that - an 'Open' dialog box appears on the screen after 

employing any of the above mentioned methods of opening a document. The 'Open' dialog box has been 

shown in Figure 2.31. In this 'Open' dialog box you would notice a 'look in' box which is used for 

selecting the drive as well as the folder where your required document is resident in. Then, there is 

'Files of Type' box which helps you to select the kind of file that you want to open. Suppose you want 

that only the Word documents should be shown in the file list, then click at the pull down arrow and 

from the drop down list, select 'Word Documents' option. In case you want to see all the files in the 

selected drive, then select' All Files' option from the drop down list. Finally click the filename in the file 
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list and click at the <Open> button or double click the filename to open up the file. 

 

 

 

 

 

 

 

 

 

 

 

 

                                   Figure 2.31: The 'Open' Dialog Box 

Saving a Document 

For future retrieval of the document, it needs to be saved on hard disk or floppy disk. Once all the 

text is entered, save the document with any of the following methods: 

Method 1 

Click at the 'File' menu and then select 'Save' option. You would notice a screen that looks like the 

Figure 2.32. When the file is being saved for the very first time, the 'Save as' dialog box comes up 

because Word needs some additional information from you. 

First, Word wants you to give a name to your file. This has to be given in the 'Filename 'box. 

Secondly, the kind of file you are trying to save, should be given in the 'Save as type' box. Thirdly, 

the place where you want to save your document should be given in the 'Save in' box. After giving all 

this information, click at the <Save> button. Your file is finally saved onto the disk. 
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The 'Save as' dialog box is displayed only once till the time you don't give a name to your document. 

Once the document has a name, next time if you try to save your file after making a few changes in it, 

then the 'Save as' dialog box will not appear on the screen. 

 

 

 

Save Button 

 

 

 

 

 

 

 

 

 

 

Figure 2.32: The 'Save As' Dialog Box 

Method 2 

The other way of saving your files is by clicking at the 'Save' button available on the standard 

toolbar. You can see the 'Save' button in Figure 2.32. 

It's a good idea to keep saving your documents after every few minutes. The reason is if the computer 

goes down or a power failure occurs, then the chances of recovering some contents in the document 

are high. Unsaved new documents are the most vulnerable. 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  146 |`  

 

Closing a Document 

Word offers a very handy method of closing documents. Like, you would prefer to close and remove 

the office files that are no more required on your table, in the similar manner you may want to close 

Word documents too. So, for closing a file, click at the 'File' menu and select the 'Close' option as 

shown in Figure 2.33. This will close the file that is recently opened. As many documents are opened 

in WORD, you are required to issue 'File - Close' commands for those many times to close all the 

files one by one. 

Word will also prompt you to save your files before closing them as shown in Figure 2.34. If you 

want that your file should be saved before it is closed, then click at <Yes> button otherwise hit the 

<No> button. A case may arise when you want to continue working in the same document after 

issuing 'File Close' command. Select the <Cancel> button. It will allow you to work again in your 

document thus cancelling the issued command. 

 

 

 

 

 

 

 

 

 

 

 

                    Figure 2.33: The 'Close' Option of File Menu 

 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  147 |`  

 

 

 

 

 

 

 

 

 

 

                        Figure 2.34: Word Prompts to Save  

Files before Closing them Exiting Word 2000 

To quit Word or to close the Word application program, click at 'File\Exit' options as shown in Figure 

2.35. With this command, all the currently opened documents are also closed automatically. Word will 

again prompt you to save your files before quitting. 

Student Activity 8 

How will you create a new document in MS-Word? 

How will you open a pre-exiting file in MS-Word? 

How will you save a document in MS-Word? 

How will you exit from MS-Word? 

4.6 EDITING DOCUMENTS IN WORD 2000 

Editing means modifying or making changes in your document. It would involve: 

⚫ Inserting new text 

⚫ Copying text from one part of the document to another part 

⚫ Moving text from one part of the document to another part 
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⚫ Deleting unwanted text. 

 

 

 

 

 

 

 

                    Figure 2.35: The 'Exit' Option of File Menu 

Before exploring all these editing features of Word 2000 in detail let us discuss the word-wrapping 

feature first. Incomplete words or the words that exceed right margin look very clumsy. With the help 

of word wrap feature, Word automatically wraps around the word in next line, when the cursor 

reaches the right margin. So, every time when you reach at the end of line, you don't need take care 

of hitting the <Enter> key. The only time, you need press the <Enter> key is, when you want to end a 

paragraph or insert a blank line. 

Selecting Text 

Text needs be selected for performing various block operations (like Copying/ Moving/ Deleting) on 

it and for easing our work. Selection of text can be done both by mouse as well as by keyboard. 

Selecting Text by Mouse 

First of all, let's learn how to select text using a mouse. The various methods of selecting text by 

mouse are discussed below: 

(c) Hold your mouse button from where you want your selection to start and drag the mouse either 

rightways or downwards. Release the mouse button at the place where you want your selection 

to end up. 
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(d) If you want to select a single word, then take your mouse pointer at that word and double click 

it. 

(e) Paragraphs can be very easily selected by triple clicking anywhere within the paragraph. 

Selecting Text by Keyboard 

Keyboard can also be used to select text. The method of selecting text by keyboard is discussed 

below: 

(iv) Take the cursor at a place where you want your selection to start. 

(v) Hold down the <Shift> key and move the cursor with arrow keys in the direction required. Release 

the keys at a place where you want your selection to end up. In this way, your text would be 

highlighted. 

Inserting Text 

Generally, when you startup WORD, it is in the Insert Mode, which means as text is typed in, the 

following text is pushed towards the right side. So, wherever you need put in new text in your 

document, take your cursor at that particular location and start typing in. The method is exactly the 

same for inserting either a single character, word, line or a couple of lines. 

 

At times, you also might need overwrite the pre-written text. For that matter, press the <INS> key from 

the keyboard once. This would put Word in overwrite mode and the word 'OVR' will be displayed on 

the status bar at the bottom of the screen. Now, when the new text is typed in, the existing contents at 

the current cursor location are going to be overwritten by the new text. If you want to put yourself back 

in the insert mode, press the <INS> key once again. 

Copying Text 

Copying means duplicating the contents of the document at some other desired place. The procedure for 

copying text is almost the same as that of moving text with a little difference which is being discussed 

in the following steps: 
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• Select the text that has to be copied. 

• Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu. 

• Take the cursor wherever you want the text to be pasted. 

• Hit <Ctrl + V> keys. Alternatively select the 'Paste' option from the 'Edit' menu. 

You can also use the 'Copy' and 'Paste' button (shown in Figure 2.29) available on the standard toolbar 

for copying and pasting text. With the above procedure, you would notice the same text appearing at 

two places in the same document. 

Moving Text 

Moving text means removing text from one portion of the document and placing it at some other 

location. For moving text, do the following steps: 

• First, select the text that you want to move. 

• Then, click at the 'Edit' menu and select the 'Cut' option. Alternatively you can also cut the selected 

text by pressing <Ctrl + x> keys. Once the text is cut, you will notice that the marked text 

disappears from the screen. Don't feel worried, your text is put on the windows clipboard 

(temporary portion, of memory) from where it can be pasted anywhere. 

• Look for the place, where you want your text to be placed. Take the cursor at that location and hit 

the <Ctrl + v> keys or alternatively select the 'Paste option from the Edit menu. 

You can also make use of the 'Cut' and 'Paste' button (shown in Figure 2.29) from the standard toolbar 

for cutting and pasting the selected text respectively. 

Deleting Text 

A passage of text can be very easily erased off by selecting it and pressing <Del> key on the keyboard. 

A single character can also be deleted very easily by positioning the cursor at that particular character 

and hitting the <Del> key. 

If you want to scrap off only a single word from your document, select the word by double clicking it 

and hit the <DEL> key. You can also delete words by following commands: 
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⚫ Press <Ctrl + Del> keys to delete next word 

⚫ Press <Ctrl + Backspace> keys to delete previous word. 

Student Activity 9 

• What do you mean by editing a document? 

• How will you insert text in a document? 

• How will you make the duplicate of some portion of text in a document? 

• How will you delete text in a document? 

4.7 FORMATTING DOCUMENTS 

Each one of us has a hidden desire that the reader should feel interested in whatever we are trying to 

convey. So, for achieving this, a special effort on our front is required. We must give a refined look 

to the document. The formatting features like fonts, bullets and numbering, font type etc. can be used 

very intelligently to create the whole impact. Now, let us proceed further learning about these special 

features smartly. 

Defining Font Type and Size of Text 

A font can be defined as a set of letters that has a common or the same typeface. Different font types 

and sizes can be applied using the formatting toolbar or the Format menu. Let's discuss them one by 

one. 
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Using Formatting Toolbar 

The formatting toolbar is designed very artistically as shown in Figure 2.36. It contains most of tools 

that need be used to give a complete and wholesome look to your document. The toolbar also shows 

you the font type and size as applied to your text. It also displays the effects (Bold, Italic or Underline) 

as given to the text. For applying a font type and size to your text, use the formatting toolbar in 

following steps: 

• Select the text. 

• Click at the arrow beside the font type box and select a font type of your choice from the drop 

down list. 

• Again, click at the arrow beside the font size box and select an appropriate font size from the drop 

down list. 

Using Format Menu 

The required font type and size can also be applied to the text by using 'Formal menu as described in 

following steps: 

• Select the text. 

• From the 'Format' menu, select the 'Font' option. The 'Font' dialog box appears on the screen as 

shown in Figure 2.37. 

• Choose appropriate font type from the 'Font' box. You can move up or down in the 'Font' box with 

the help of up and down arrow keys. 

• Similarly, choose the required font style and size for your text from the 'Font style' and 'Size' boxes 

respectively. 
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Figure 2.37: The 'Font' Dialog Box 

• The preview of the selected text can be seen in the 'Preview' window with the applied formatting 

features. 

• Click <OK> button. 

You will find the look of your text changing with the application of new font type, style and size. 

Making Text Bold, Italic and Underlined 

Using Formatting Toolbar 

If you have given a keen look at the formatting toolbar: then you must have observed three buttons 

showing the letters B, I and U. The letter 'B' stands for Bold, 'I' for Italic and 'U' for 

Underline (Refer Figure 2.36). In order to make your text look a bit darker than the rest of the 

document, concentrate on the following steps: 

6. Select the text. 

7. Click at the 'B' button. 

On carrying out these steps, the 'B' button becomes depressed or lightened. If you do not want the 

text to be bold select the text again and click at the 'B' button. This button on the toolbar again 

becomes prominent and your text is not bold anymore. 

At times you would like to see your text in italics or would like to underline it. To do this, do the 

following steps: 

(e) Select the text. 

(f) Click at 'U' button to underline and 'I' button to italicise it. 

Using Format Menu 

Alternatively, the same work can also be done using the 'Format' menu by following steps: 

1. Select the text. 

2. Click at the 'Font' option of the 'Format' menu. 
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3. In the 'Font' dialog box, activate the 'Bold' option or 'Italic' option from the 'Font style' box to 

show your text in bold or italics. (Refer Figure 2.37) 

4. In order to underline the text, select the required option from the 'Underline' box drop down list. 

If you are a keyboard person, you can also use one or more of the following key sequences to achieve 

the same, after selecting the text: 

Press <Ctrl + B> keys to bold the text 

Press <Ctrl + 1> keys to italics the text 

Press <Ctrl + U> keys to underline the text 

Changing Case of Text 

Word offers a quick and handy way to change the case of your text. Lowercase characters can easily 

be changed to uppercase by hitting <Shift + F3> keys. To achieve the contrary effect, press the <Shift 

+ F3> keys again. This would convert uppercase characters to lowercase. 

Alignment of Text 

Text alignment means placement of text between the margins. Your text can be left, right, centre 

aligned or it can be justified within the margins. Left alignment of text would mean the arrangement 

of text evenly in a straight line at the left side of the document but with uneven edges on the right 

side. Right aligned text is just the opposite of left aligned text with text evenly arranged at the right 

edge of the document but uneven from the left side. Justified text would involve even edges of text 

along both margins. Centre aligned text means that the text is placed exactly in the centre of the page. 

Centre aligned text is most suitable for giving titles, headings etc. Generally and most frequently the 

text is left aligned because then the text becomes easily readable and understandable. Now, let us find 

out how text can be aligned using the formatting toolbar. 

(e) Select the text (it could be a single line or a paragraph or the whole document). 

(f) Click at any of the alignment buttons from the formatting toolbar to get the desired result. (Refer 

Figure 2.36). 

If you are more in the habit of using keyboard, then give the following keyboard shortcuts after 
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selecting the text: 

 Press <Ctrl + L> keys to left align the text 

 Press <Ctrl + R> keys to right align the text 

 Pres8 <Ctrl + J> keys to justify the text 

 Press <Ctrl + E> keys to show the text in the centre 

Formatting Paragraphs 

Formatting means deciding alignment of the paragraph. It also includes the spacing that is to be put in 

between the lines. In order to carry out formatting on Paragraph, it needs be selected first. Then go to 

the 'Format' menu and do the lowing steps: 

1. From the 'Format' menu, select 'Paragraph' option. A 'Paragraph' dialog box shoots up on the 

screen as shown in Figure 2.38. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.38: The ‘Paragraph’ Dialog Box 
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• You can set the alignment i.e. decide the placement of text on the screen by clicking on the 

dropdown arrow of the ‘Alignment’ box. Your whole of the paragraph can be left, right or centre 

aligned. 

• Go to the 'Line Spacing' box and click at the drop down arrow to make a choice. Finally click at 

the <OK> button. In the 'Line Spacing' box there are many options that need a bit of elaboration. 

Let us find them. For the options 'At least', 'Exactly' and 'Multiple', a number has to be given in the 

'At' box. In these cases, the space is measured (between the lines) in terms of print size. The ‘At 

least’ option uses the space as given in point size but it can also use some extra space in a case 

where it needs accommodate some text. 'Exactly' option gives exactly the same space as defined in 

the ‘At’ box. If word needs extra space to adjust some more text, then it cannot get it. 'Multiple' 

option allows you to specify the line spacing of your own choice. If you want the lines to be triple 

spaced, then type '3' in the 'At' box. 

Bullets and Numbering 

It is always advisable to put the text entries which are separated by commas in the bulleted or the 

numbered form. Adding bullets to the text makes it easy to read and understand. Major points can be 

very well emphasized through this technique. Points put in the order of preference are long remembered 

by the reader. Moreover, in our day to day life, we prefer to make our daily list in the numbered manner 

rather than putting it in a paragraph. The only idea is that the chances of forgetting are turned low and 

visibility of important points is clearer. You can put bullets or numbers in an existing list by using either 

the formatting toolbar or the 'Format' menu. 

Using Formatting Toolbar 

• Select the text. 

• Click at either the 'Bullets' button or the 'Numbers' button on the formatting toolbar. (Refer 

Figure 2.36). 

In case you decide that you don't require 'numbers' or 'bullets', you can very easily put them off by 

repeating the above steps. 

Using Format Menu 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  157 |`  

 

This method perhaps offers a wider choice of symbols other than the typical black circle. Let us 

discuss this method: 

2 Select the text. 

3 Select the 'Format Bullets and Numbering' option. 

 

 

 

 

 

 

 

 

 

 

Figure 2.39: The 'Bullets and Numbering' Dialog Box 

A 'Bullets and Numbering' dialog box appears on the screen as shown in Figure 2.39. Select the 

'Bulleted' tab in case you want bullets in your document. If you wish to put numbers then select the 

'Numbered' tab. Choose any of the bullets or numbers and apply it onto your document by clicking 

<OK> button. You see how easy it is to place bullets and numbers in your document. 

Find and Replace Commands 

'Find' and 'Replace' commands have been presented in a new and different look in Word 97. 'Find' 

and 'Replace' do not have their own separate dialog boxes. Instead they have been presented in the 

tab form in the same window. On finding a word, you can replace it with some other word using 

'Replace' straightaway. Carry out the following steps for finding a word or group of words: 
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4. From the 'Edit' menu, select the 'Find' option. A 'Find and Replace' dialog box appears on the 

screen as shown in Figure 2.40. 

5. Enter the word or phrase you want to search for in the 'Find what' box. 

6. Click at 'Find Next' button. It will show you the first appearance of word or phrase. Keep hitting 

the 'Find Next' button until you find the required word or phrase in your document. 

 

 

 

 

 

               Figure 2.40: The 'Find and Replace' Dialog Box 

Once your word is located, you may want to replace it with some other suitable word. At times, global 

replacements of a word in the whole document has to be carried out. For example, you have entered a 

word ‘component’ many a times in your document. Now at later point of time, you may want to change 

it to 'part'. Replace can help you in making the required changes by carrying out the following steps: 

4. Select 'Edit - Replace' option. A 'Find and Replace' dialog box comes on the screen as shown in 

Figure 2.41. 

5. Enter the word 'component' in the 'Find what' box. 

6. Enter 'part' in the 'Replace with' box. 

7. Click 'Find Next' if you want to see the first occurrence of the word. Click the 'Replace' button if 

you want to change it. In case you do not want to make the change, then click 'Find Next' again to 

locate for the next appearance of the word. 

8. The 'Replace All' button will change all the occurrences of the word 'component' to 'part' in the 

whole document in a single command. 
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                          Figure 2.41: The 'Find and Replace' Dialog Box 

Numbering Pages 

A long document certainly needs proper page numbering done for easy and quick reference. Adding 

numbers to each and every page manually cannot only become tedious but also confusing and time 

consuming work. Word can really automate your task. To add numbers to your document, follow the 

steps given below: 

27. Click at the 'Page Numbers' option of the 'Insert' menu. A 'Page Numbers' dialog box appears on 

the screen. This dialog box resembles Figure 2.42. 

 

 

 

 

 

                                    Figure 2.42: The 'Page Numbers' Dialog Box 

28. In the 'Position' box, click at down arrow and select the desired position where you want your 

page number to appear. It can come either at the top or bottom of the page. 

29. From the 'Alignment' box, decide the alignment of the page number. You can place your page 

number either on the left, right or in the centre of the page. 
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30. If you want that the page number should be shown on the first page also then check the box on. 

In case you check the box off, then the page number is only going to be hidden but is certainly 

counted as 1. 

31. Click at the 'Format' button. A 'Page Number Format' dialog box appears on the screen as shown 

in Figure 2.43. Select the style of page numbers that you want for your document from the 

'Number Format' drop down list. 

32. If you want to start your page number from some digit other than 1,2,3..., then you can very well 

specify it in the 'Start at' button, Click at the 'Start at' radio button and type in the desired number 

in the following box from where you want your, numbering to start. 

33. Click <OK> button to apply the desired format. Again click at <OK> button to save the changes 

and come out of the 'Page Number' dialog box. 

 

 

 

 

 

 

 

 

                             Figure 2.43: The 'Page Number Format' Dialog Box 

4.8 CLIP GALLERY 

Word 2000 has come up before us with enhanced graphic capabilities. There are many new clips put in 

this latest version of WORD. Moreover, added multimedia effects such as sound and videos in Word 

2000 are getting a very friendly welcome from the users. Our old clipart gallery has also got a new name 

in Word 2000. Now, it is called Clip Gallery. 
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Inserting Clips 

To place clips in your document, go about performing the following steps: 

1. Select Insert/Picture/Clipart'. A dialog box by the name 'Microsoft Clipart Gallery' is shown on 

the screen as shown in Figure 2.44. Now, from this dialog box, select the 'Clipart' tab. You will 

notice that your clipart gallery is indexed on major keywords. If you scroll down in the window 

under the head 'All categories', you would find a fairly long list of clips. So, in order to make our 

search easier, select any particular category in the category list. In the adjoining window, you 

would find all the clips relating to that category together. 

2. Search through the clips and decide an appropriate clip for your document. Select anyone desired 

clip and click at the <Insert> button. You will find that particular picture placed in your 

document at the current cursor position 

 

 

 

 

 

 

 

 

 

 

 

                               Figure 2.44: The 'Clip' Dialog Box 

Resizing Clips 

The clip that you have successfully placed in your document might not be of the exact size that you 
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want. It can either be too small or too big. So, to resize it: 

1. Select the clip by clicking anywhere on it. Eight sizing handles appear on the boundary of the clip as 

shown in Figure 2.45. 

 

 

 

 

 

 

 

 

 

                                                            Figure 2.45: Resizing Clips 

2. Take your pointer at any of these handles. The pointer will change into a double headed arrow. 

3. Click and drag the handle in the direction desired to make your clip big or small. 

4. Release the mouse pointer when the required size of your clip is achieved. 

4.9 PAGE SETTING 

 

Page setting includes putting your text neatly between margins. Margins are nothing but 

an Invisible frame within which the whole text appears. When a blank new document is 

opened, a default margin is always there. This margin is laid for sides, top and bottom 

of the page. You can always fiddle with the default settings of Word according to your 

demand and requirements. We will learn to set margins by two methods: 

Margin Setting through File/Page Setup 

The default setting of the top and bottom margin is 1 inch and in the sides, it is 1.25 inches. To 

modify the default margin setting, follow the steps given below: 
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1. Select 'Page setup' option of 'File' menu. A 'Page Setup' dialog box appears on the screen as 

shown in Figure 2.46. 

2. Click in the 'Top' box and erase off the current setting by using either the <Del> key or the 

<Backspace> key from the keyboard. Type in the desired number. Alternatively, you can use 

the top arrow to increase the margin and down arrow to decrease it. 

 

 

 

 

 

 

 

 

 

 

Figure 2.46: The 'Page Set up' Dialog Box 

3. Similarly, change the settings in the Bottom, Left and Right boxes as well. 

At times, you might want that the changes that have been made recently should apply to the current 

document only, then click at <OK> button. But in case, you want that the current document as well 

as any other new document that you open should have these page settings, then click at the <Default> 

button. The next step would be to click at the <Yes> button in which case Word is trying to seek your 

permission in changing the default settings for page setup. 

Setting Margins using Ruler line 

Ruler line is very frequently used to change margins. It is a quick and easy way to set margins but 

needs some amount of practice also. To set margin using the ruler line, carry out the steps discussed 
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below: 

1. Place your mouse pointer on the left side of the horizontal ruler line. Slowly, move the mouse 

pointer towards your right side till the place where your mouse pointer acquires the shape of a 

double-headed arrow. A 'Left Margin' tool tip appears on the screen as can be clearly seen in 

Figure 2.47. 

2. Click at that location and drag the mouse towards right side to increase the margin or on the 

left side to reduce it. 

3. Release the mouse button when suitable margin is attained. 

 

 

 

 

 

 

 

 

 

                 Figure 2.47: Figure Showing 'Left Margin Tool' 

In order to set right margin, the method is just the same as discussed in the above three steps. If you 

observe closely, you will find a thin gray line above the 'Right Indent' button which is in the extreme 

right of the Ruler Line. This is the Right Margin Line. Place the mouse pointer at this line and click on 

it. Drag the pointer in either direction to increase or decrease the right margin. Finally, release your 

mouse button. 

Now, let us learn how to set the top and bottom margins using the vertical ruler line. This vertical ruler 

line appears only in the Page Layout view. So, in a case if your vertical ruler line is not apparent on the 
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screen, then first switch yourself to Page Layout view by selecting 'Page Layout' option from the 'View' 

menu. To set the top margin: 

1. Take your mouse pointer on the thin gray line that appears between the darkened and white 

areas on the top side of the vertical ruler line. 

2. As soon as your mouse pointer takes the shape of a double headed arrow, click and drag it either 

upwards or downwards to attain the desired top margin. 

3. Release the mouse button. 

When you are trying to play with the margins, a line is shown across the page which keeps moving up 

or down according to the movement of your mouse pointer. This gives you the exact location of your 

margin on the page. 

4.10 APPLICATION OF A WORD PROCESSOR IN CORPORATE SECTOR 

A word processor finds immense usage in the corporate sector. This is a software that is specially 

designed to help the managers to design and prepare typed documents. It offers very handy tools for 

managers to work upon. For instance, MS-Word offers many pre-designed professional letters which 

can be used with little or no modification at all. Moreover, the overall impact of the document can be 

enhanced by using the advanced features provided by MS-WORD. 

Student Activity 10 

1. What do you mean by formatting text? 

2. How will you make the text bold and Italic? 

3. What do you mean by text alignment? What are the various types of alignments available in 

MS-word? 

4. When do we use bullets and numbering feature of MS-Word? 

5. How will you find a group of words in MS-Word? How will you replace them with some 

other words? 

6. How will you give numbers to you pages? 

7. How will you insert clip-art in MS-word? 
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8. How will you set margins using ruler? 

9. What is the application of MS-word in corporate sector? 

4.11 SUMMARY 

An operating system is an integrated set of specialized programs that is used to control and manage 

the resources and overall operation of a computer system. 

DOS is the most commonly used operating system. Loading of DOS into the main memory is known 

as booting. DOS commands are of mainly two types: internal and external. Internal commands are 

directly interpreted by the command processor, command.com. External commands are interpreted 

with help of external files (with extensions.com or .Exe) 

Storage areas on a disk are known as directories. A directory may contain files and/or sub-directories 

inside it. The full name of a file or a directory (including path) is called pathname. 

Wildcards special characters carrying special meaning. Two MS-DOS wildcards are‘?’ and ‘*’ The 

'?' can replace exactly one or none characters in a name. The '*' can replace number of characters in a 

name. 

Some DOS internal commands are copy, DEL/ERASE, REN, TYPE, DIR, CHDIR/CD, MK, DIR/ 

MD, RMDIR/RD, BREAK,CLS, DATE, PATH, TIME, PROMPT, etc. Some external commands are 

DISK COMP, DISKCOPY, FORMAT, LABEL, PRINT, XCOPY, etc. 

Batches of MS-DOS command stored under a filename with extension. BAT are known as Batch 

files. The batch files with the name AUTOEXEC.BAT is automatically executed by MS-DOS at the 

time of booting. 

MS-windows is a GUI based operating system. In windows operating system, multiple applications 

can be simultaneously run in different windows. In MS-windows, the screen upon which icons, 

windows, etc., are displayed is known as desktop. 

You can explore you computer through start button and taskbar, my computer and window Explorer. 

The taskbar is a bar, which is usually located at the bottom of the screen. The start button is located 

at taskbar. By clicking at start button, start menu appears wherefrom you can start program, open 
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document, customize you system, get help, search for items on your computer and more. 

Windows Explorer is another way of seeing what is on your computer. Windows explorer shows the 

computer's contents as a hierarchy. The programs available under Programs section of start menu can 

be started by clicking at start, then at programs and then at the desired program or group. To quit an 

open program, just check at close button (X). A folder is a location in which you can store files and 

other folders. 

To create new folders start find folder commands are clicked in my computer window. To find files 

or folders, start find files or folder commands are clicked. To rename a file, firstly the file icon or 

name is selected and then file-Rename commands are clicked. To move a file, the file icon or name is 

firstly selected, then edit cut commands are clicked. Then the destination folder is opened in a My 

computer windows and there Edit paste commands are clicked. 

To copy a file, firstly, the file icon or name is selected, then Edit Copy Command is clicked the 

destination folder is opened in a My computer window, and there Edit paste commands are clicked. 

To delete a file, a folder, firstly select the file icon or name and then either click Delete key or click 

File Delete commands. To create a shortcut to a file, firstly select the file or folder, whose shortcut is 

to be created. Then drag the file icon through right mouse button to desired location where shortcut is 

to be placed. And then select create shortcut. To shut down the computer, Start Shut down commands 

are clicked. 

4.12REVIEW QUESTION 

1. What do you mean by booting up?   

2. What is the full form of ROM-BIOS? 

3. What do you mean by default drive? 

4. How many parts are there in a file name under MS-Dos? What are file naming conventions? 

5. What are volume labels? How many characters can a volume label contain? 

6. What are wild cards? What is the use of '?' and '*' wild card in MS-DOS? 

7. What is the purpose of copy command? 
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8. To view a directory listing width wise, which command is used? 

9. Which commands lets you create directories? Give example. 

10. What is the use of switch /w in DIR command? 

11. How is X COPY a better copy command than COPY? 

12. What are batch files? What is the significance of AUTOEXEC.BAT file? 

13. Give some of the advanced features of window 98. 

14. What is the difference between copying and moving files and folders? 

15. When a folders is copied to another place, do the sub-folders in the folder also get copied? 

16. What is windows Explorer and give some of its functions? 

17. Differentiate between notepad and WordPad. 

18. What do you mean by dialog box? Also discuss its various components. 

19. What is the start Group? What are the different functions that can be done through this? 

20. Discuss some advance features of windows 98. 

21. (i)  Give procedure to create a new folder in windows 98. 

(ii) Give procedure for closing down the windows 98. 

22. What is the function of taskbar and recycle bin? 

23. Describe the functions of the Control Panel. 

24. What are the advantages of a word processor over typewriters? 

25. What is meant by text alignment? In how many ways can you align you text? 

26. What is meant by page margins? Which option will you choose to set the margins of your 

document? 

27. What are the advantages of find or replace features of word processor? 

28. Write your Bio-Data in MS-Word. 
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29. Prepare a business letter to you customer promising to attend to his complaint immediately. 

Use page setup, formatting features, etc. 

4.13 FUTURE READING 

Peter C. Jurs, Computer Software Applications in Chemistry; Wiley-IEEE. 

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, 

Editions De L’Ocean Indien. 
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After studying this unit, you should be able to understand: 

⚫ MS-Access a data base management package. 

⚫ MS-Excel as a spread sheet package. 

Here, we discuss following software packages which are required for general and special purpose: 

Database Management Packages 

Spreadsheet Packages 

5.2 DATABASE MANAGEMENT PACKAGES 

Business processes are always associated with a huge amount of data. To store, manipulate and 

processes such data, some software packages are needed, which are collectively known as Database 

Management Packages/Software/Systems (DBMS). DBMS is defined as a software that organizes 

and maintains the data in a database for providing the information. 

Microsoft Access is a Windows based Relational Database Management System (RDBMS). It has 

received huge acceptance by users because of its versatility and easy to use interface. MS-Access is 

best suited for maintaining any type of information. It can keep huge records of data ranging from 

keeping an address book to inventory details. Access finds its immense usage in registering telephone 

numbers, expense details, store or warehouse information. Whatever data is entered, it can be viewed 

from different angles using forms. Data can also be sieved and extracted based on certain conditions 

using queries. Reports help in analyzing the data and help you to come at certain meaningful 

inferences. The very frequently used operations can be automated by creating and saving macros. 

What is a Database 

A database is a collection of related information. An example of a typical database is a private 

telephone directory. It contains related information about each person like his name, address and 

5.0 LEARNING OBJECTIVES 
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telephone number. Other examples of a database include list of customers and suppliers, maintenance 

of stock in warehouses, collection of tapes in libraries, maintenance of members in a country club, 

etc. 

Components of a Database 

All the information stored in an Access database is kept in tables as illustrated in Table 2.2. 

Table: A table is a collection of some specific kind of data. It is the basic element of the database. 

Data put in a table is organized in rows and columns. 

Record: Each row is called a record and it contains the complete information about one particular 

item, e.g., in a telephone directory all the essential details about a single person like his name, 

address and city form one record. 

Column: Each column is called a field. It holds information about a certain type for all records. A 

field could be a name, address, telephone number, etc. 

Table 2.2: An Example of a Typical Table 

 

 

 

 

 

In the example shown in Table 2.2, the table contains four records and five fields. Thus, each record 

contains a complete and wholesome information about one item. Each column contains the same type of 

information for all the records like S.No., Name, Address, etc. The field 'Name' contains the 

information related to 'Name' for all records. So, you can have any number of records as well as fields 

in your table. You can add more records to your table. In the similar manner, you can also expand the 

field list. Your database can have any number of tables. The 'Relational' concept allows to build 

relations between different tables. 

5.3 STARTING ACCESS 2000 

In order to startup Access in Windows 98, follow the steps given below: 
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1. Click at the Start button. Select the Programs option. 

2. Select Microsoft Access option from the cascading menu. Access will be loaded in the computer's 

memory. By default, the name given to an Access database is 'dbl'. The extension given to a 

database in Access is 'mdb'. 

 

 

 

 

 

Figure 2.48: Starting Access 

Opening a Database 

In order to access any table form or report created in a database, it has to be opened first. A database can 

be opened by the following methods: 

Follow the steps given below: 

1. Select the 'Open an Existing Database' option from the opening Microsoft Access dialog box as 

shown in Figure 2.49. Choose a database from the existing databases and click at the <OK> button. 

 

 

 

 

 

 

 

                               Figure 2.49: Selecting the Type of Database to be Opened 
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The Access Window 

The different parts of an Access Window are shown in Figure 2.50. You are already familiar with 

most of the components of this window. You have already been introduced to title bar, minimize 

button, maximize button, close button, control menu button, menu bar, toolbars and status line. The 

term 'Database Window' has been brought up for the very first time before us. 

Menu 

bar 

 
Control Menu 

button 

Close 

button  

 

 

   

Title bar 

Maximize 

button 

     

Minimize 

button 

       

       

 

 

 

 

 

Toolbar 

Database window 

Figure 2.50: Different Parts of Access Window 

The Database Window 

The elements of an Access database are brought together in the database window. Everytime a 

database is opened, the database window displays information about the database and all the objects 

it contains. The database window comprises of three parts. You will find six object tabs at the top of 
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the horizontal bar. Each of these tabs help you select any particular object that has to be worked with. 

By default, the table tab is always selected when the database window is opened. It shows all the 

tables that have been created in that particular database. You can select any object by taking your 

mouse pointer at that particular tab and clicking it. Then, you will find the command buttons towards 

the right side of the window, These command buttons help you to place the database object in a 

different view, The <Open> button helps you to open up and see the selected object. The <Design> 

button shows the selected object with all the properties set for that object. The <New> button helps 

you to create a new object from scratch. This newly created object becomes a part of the current 

database. The features of a database window are as follows: 

Table: It shows the list of all the tables created in the current database. You can create new tables 

and modify the existing tables. 

Queries: It shows a list of all the queries in the current database. A query is nothing but a question 

about the data stored in the table. A query can be opened, modified as well as created from here. A 

query is used to extract certain information from a database. 

Forms: It displays the names of all the forms created in the current database. A form is used for 

entering data in the table. Forms can show data in more meaningful and structured manner. 

Reports: It shows the reports that have been created in the current database. A report is used for 

showing the data put in the table in an organized manner. 

Macros: A macro is a written set of instructions that does your work automatically. It helps to 

automate repetitive tasks. 

Modules: A module is a collection of programs which is written by the user. 

Creating a Database 

As we have already discussed, a database contains a large number of tables. The very first step for 

working in Access is the creation of database. So, as and when Access is loaded in the computer's 

memory, Figure 2.51 appears on the screen. 
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Figure 2.51: Database Creation Window 

1. Click at the Blank Database option to create a new database. Finally, click at the <Ok> button. The 

Figure 2.52 appears on the screen. 

 

 

 

 

 

 

 

                     Figure 2.52: 'File New Database' Dialog Box 

2. Access wants you to give a name to your database. So, in the 'Filename' box, type in the name of 

the database. Here, the name given to an Access database is 'Ruby'. Then, click at the <Create> button. 

Now, the Figure 2.53 appears on the screen. 
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Figure 2.53: The Database Window 

Creating a New Table 

A table contains all the necessary information. We will learn how to create a table using a wizard. A 

wizard takes you through a series of steps to accomplish your work. Thus, in order to create a table, 

click at the <Table> tab and then at the <New> button as shown in Figure 2.53. Figure 2.54 appears on 

the screen. After clicking at the 'Table Wizard' option, click at the <Ok> button. 

 

 

 

 

 

 

 

 

 

 

Figure 2.54: The 'New Table' Dialog Box 
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The 'Table Wizard' contains some sample tables as shown in Figure 2.55. Select the table in the 'Sample 

Tables' window according to your requirement. The corresponding fields of the table are shown in the 

adjacent window. You can put all the fields from the sample table. You can also decide and put a few 

fields in your table from the fieldlist. So, for putting the fields selectively, select the field and click at 

the single arrow pointing towards the right side. However, if you wish to put all the fields from the 

sample table into your table, click at the double arrow pointing towards the right side. In case, if you 

have accidentally put a wrong field into your table, then select that field and click at the single arrow 

pointing towards the left side. This will clear the field from your table. The double arrow facing 

towards the left side will remove all the fields from your table. However, if you wish to give a new 

name to your field, then click at the <Rename> button. A 'Rename' dialog box comes up on the screen. 

Simply, type in the new name. Finally, click at the <Next> button. 

 The 'Table Wizard' appears on the screen. You can give a name to your table. The name given to the 

table in the example is 'Mailing List'. 

Click at the <Next> button. Figure 2.57 appears on the screen. Access allows you to create a temporary 

form for entering data through the 'Enter data directly into the table' option. However, if you wish that 

the form should also be saved for future use, then click at the option <Enter data directly into the table>  

 

 

 

 

 

 

 

 

 

                                     Figure 2.55: Sample Table in wizars 
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using a form the wizard creates for me'. In the latter case, the wizard will automatically create a new 

form for you according to the fields that you have decided to put in your table. Finally, click at the 

<Finish> button. Figure 2.58 appears on the screen. 

 

 

 

 

 

 

 

 

                               Figure 2.56: Figure Showing the Name given to a Table 

 

 

 

 

 

 

 

 

 

Figure 2.57: Create a Form for Data Entry 

Click in the <First Name> box and enter the first name of the person. In a similar manner type in the 

rest of the appropriate details by clicking in respective box. Once all the details of a single record are 
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entered, click at the <Next Record> button. It will take you to the next record and there you can type in 

the details of the second record. The 'Next Record' button is also used for seeing the contents of the next 

record of the table. The 'Last Record' button shows you the details of the last record. The <Previous 

Record> button will take you to the previous record. The very first record of the table can be seen with 

the help of the 'First Record' button. Once all the records are entered, click at the Save As option of the 

File menu to save the form and give an appropriate name. Click at the <Close> button appearing on the 

extreme right of the screen to get back to the Database Window. 

 

 

 

 

 

 

Figure 2.58: Form for Entering Data in the Table 

Viewing the Contents of the Table 

The contents of the table can be seen by going back to the 'Database 

Window'. Click at the <Forms> tab and select the form name whose contents 

are to be seen. Lastly, click at the <Open> button. You can navigate between 

different records to see their details. 

Closing and Saving a Database 

In order to close a database, click at the 'Close' option of the File menu. Alternatively, 

click every  

<Close> button of the database window. It would automatically save your database and 

update  

the changes done to it.  

Exiting ACCESS 

To quit Access, click at the Exit option of the File menu. 
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Student Activity 11 

1. Define DBMS. 

2. What are the various components of a database? 

3. How will you start MS-Access? 

4. What are the features of a database window? 

5. How will you create a table in MS-Access? 

6. How will you view the contents of the table? 

7. How will you exit from MS-Access? 

5.4 WORKING WITH TABLES 

We have already seen how to create a table. A table contains the basic data stored on a database. A 

database can contain a single table as well as multiple tables. In order to open a table, go to Database 

window and select the table tab by clicking it with the help of mouse pointer. Now, you have to decide 

whether you want to see the table in the Datasheet view or the Design view. The Datasheet view shows 

you all the data and records present in the table. The Design view, however, shows you the properties 

that have been set for each field of the table. 

Opening a Table in Datasheet View 

To open the table 'Products' in the Datasheet view, click at the <Open> button. Figure 2.59 appears on 

the screen. It shows you the field names of the table at the top and the corresponding data below it. Each 

horizontal line of the window forms a single record. So, as many lines are there in the window, there are 

going to be those many records in it. 

In order to move around the datasheet, you can make use of either the keyboard or the mouse. You can 

select any data element by clicking it with the help of mouse pointer. Using the keyboard, press the 

<Shift + Tab> keys together to move from one field to another. Once you have reached the last field in 

the current row, press the <Tab> key again to go to the first field of the next record. However, if you are 

in the first field, pressing the <Shift + Tab> keys will take you to the last field of the preceding record. 

You can also use the up and down arrow keys to move from one record to another. In order to select the 

entire record, click in the left most column of that particular record's row. 
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                              Figure 2.59: The Products Table in Datasheet View 

If you want to add a new record in your table, just click in the last row of the datasheet and type in 

your data. However, you can also edit the data of the table. Simply, click in the cell (with the help of 

mouse pointer) which has to be edited and then type in your contents. 

Opening a Table in Design View 

A table can be opened in a Design view by first of all selecting the table in the Database window and 

then clicking at the <Design> button. Figure 2.60 shows the 'Product' table in the Design view. 
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Figure 2.60: The Products Table in Design View 

A table is opened in the Design view in order to examine its structure. It shows the fields present in 

the table as well as the data type and properties for each field. 

The grid at the top of the Design view window shows all the fields, their data types and some 

description about the field. The lower part of the window shows the other properties of the field that 

has been selected in the upper grid. At one time, the properties of only one field that is selected is 

shown in the lower window. 

You can very easily view the details of another field by simply clicking anywhere in the grid row on 

which it appears. The information in the lower window changes to match the properties for the newly 

selected field. Access shows the currently selected field by putting an arrow on the row in the left 

most column of the upper window. 

If the left most column of the grid displays. a key icon, then that field is being used as the primary 

key for the table. This means that this particular field is being used as a unique field. This field can 

never contain repetitive entry. All the data for this field is uniquely identifiable. Therefore, this field 

is said to be the 'primary key' of the table. Now, let us study the basic structure of a table in detail. 

1. Field Name: The Field name column present in the upper window specifies a name for the 

field. No two fields in the table can carry the same name. You can provide any name to your 

field. However, the Field name cannot have more than 64 characters. It can contain any 

combination of letters, numbers, spaces and special characters except periods, exclamation 

marks or square brackets. Field names can never start with a space. 

2. Data Types: The Data Type column is present next to the Field name column. It signifies the 

type of information stored in the field. The edit box for this column is a drop-down list box 

which contains all the available data types. Let us briefly explore all the available data types: 

(a) Text: It stores the alphanumeric data which contains a string of characters. 

(b) Number: Any kind of numeric data is held by this data type. 

(c) Date/Time: It stores the date and time. 

(d) Currency: It is a special numeric data type used for holding monetary values. 
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(e) Autonumber: This kind of data type is mostly used for primary key fields. Fields of this data 

type are read only. Access automatically inserts the next number in the sequence. 

(f) Yes/No: This data type can hold only one of the two values such as Yes/No or True/ False. 

(g) Memo: This data type is used for storing long text fields upto a limit of 64,000 characters. This 

data type is used, to store long comments or notes. 

3. Description: The Description column is present adjacent to the Data type column. This is used to 

give a short description about the field. The Description column provides complete explanation of 

the purpose the field serves. 

4. Properties: Each field has got its own set of properties. It further defines the fields and how it is 

used in the database. So, as you move from one field to another in the upper window, the 

corresponding properties in the lower window also change. Now, let us look at some of these 

properties: 

(a) Field Size: The Field size property appears only for the Text and Number data types. This 

property specifies the maximum number of characters that can be stored in the field for a single 

record for a text value. For Number fields, field size specifies the type of number that will be 

stored in the field. The available choices are Byte (a. number from 0 to 255, whole numbers 

only), Integer (-32,768 to 32, 767, whole numbers only), Long Integer (-21, 47, 483, 648 to 

2147, 483, 647, whole numbers only), Single (can hold a very large number and fractional 

numbers) and Double (stores numbers larger than single). The choice made here does affect the 

amount of space Access uses to store the field. Therefore, you should be very careful in 

deciding the field size. 

(b) Caption: The Caption property specifies a string that has to be displayed as the column 

heading whenever the field is displayed in the Datasheet view. 

(c) Default Value: The Default value specifies a value that will be put into the field if it is not 

given by the operator at the time of entering the record. 

(d) Validation Rule and Validation Text: The Validation rule property specifies a test that is 

performed on any data that is entered into the field. If the data does not pass the rule, then a 

message is shown on the screen. However, if any message is typed in the Validation text 

property, then that message is displayed, otherwise some system error message is shown on the 
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screen. For example, for a price field if you specify the validation rule as '>100', then any data 

below 100 will not be accepted and the computer will prompt you to re-enter. 

(e) Required: The Required property forces you to enter a value if it has been set to 'Yes'. You 

cannot leave that particular field empty at the time of entering record in your table. 

5.5 WORKING WITH FORMS 

All the data in your database is stored in tables. You can view as well as edit data in a table but forms 

provide a much easier and flexible interface to view and edit data. Forms allow you that view all or just 

a few record at once while also showing the field names. Forms provide an easy way to enter, change 

and delete records. 

Opening a Form 

First of all, open the database that contains the required form. Now, in the database window, click at 

the forms tab. All the forms of the currently active database are shown in the window. Select the 

Form name with the help of the mouse pointer and finally click at the <Open> button. Figure 2.61 

appears on the screen. Using the arrow keys, you can view the other records of the table. 

Creating a Form 

A form can be very easily created using the Form wizard. The form wizard is the quickest and the 

easiest way to create a form that is bound to a table. You can use the form immediately or you can 

make changes to get the form look exactly the way you want. Thus, in order to create a form using 

the form wizard, first of all, select the Forms tab in the Database window. Finally, click at the <New> 

button. A 'New form' dialog box appears on the screen as shown in Figure 2.62. 

 

 

 

 

 

 

Figure 2.61: An Open Form 



PC-Software   DCA-12-T 

CDOE GJUS&T, Hisar  186 |`  

 

 

 

 

 

 

 

 

 

                                Figure 2.62: The New Form Dialog Box 

From the 'New Form' dialog box, select the Form wizard option. Then select the table from which the 

information has to be displayed on the form. Click <OK> button to start the Form wizard. We will 

create a form on the 'Products' table. So, select the Products table to create a form on it and click at 

the <OK> button. You will see Figure 2.63 coming up on the screen. 

 

 

 

 

 

 

 

 

                               Figure 2.63: The First Step of Form Wizard 

This Form wizard dialog box wants you to select the fields from the table that need be added to the 

form. By clicking the single arrow pointing towards the right side, you can add fields one by one to 
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your form. You can add all the fields into your form by clicking at the double-arrow pointing towards 

the right side. After you have decided and put the fields, click at the <Next> button. You will find 

Figure 2.64 coming up on the screen. 

 

 

 

                                            

 

                                  Figure 2.64: The Second Step of Form Wizard 

This dialog box asks you to decide and to choose the layout in which you want to see your new form. 

By default, the layout of the form is columnar. Whichever form layout you choose, the left side of the 

window shows the arrangement of fields on the table. Choose the layout and click at the <Next> button. 

Figure 2.65 appears on the screen. 

 

 

 

 

 

 

                                    Figure 2.65: The Third Step of Form Wizard 

The next dialog box of the form wizard enables you to choose the style of your form. The style 

controls the color and the font of the data that is to be displayed on the form. It also takes care of the 

background color and picture of the form. By default, the 'clouds' option is active, choose the style 

and click at the <Next> button. You will find Figure 2.66 coming up before you. 
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                                             Figure 2.66: The Four Step of Wizard 

This is the last dialog box of the form wizard. Here, you are required to give a name to your form. You 

can straight away start entering data into your form or you can modify the form design. Hence, give a 

name to your form and open it up for viewing and entering data in it. Finally click at the <Finish> 

button. Now, you can see your form already on the screen as shown in Figure 2.67. 

 

 

 

 

 

 

 

 

Figure 2.67: The Form on Products Table 

Adding and Editing Records in a Form 

To add a new record, click at the <New Record> button available in the form that you have created. To 

edit or modify any of the field data, you are simply required to click that field with the help of mouse 

pointer and then type in the new data. You can make use of the <Tab> key from the keyboard to move 
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around the form and then edit any field by simply typing in. 

Deleting Records in a Form 

It is very easy to delete records. You can delete information in fields by selecting that field with the 

help of mouse pointer and pressing the <Delete> key from the keyboard. 

Saving and Closing Forms 

Access, automatically saves each record as you move ahead. To close the form and return to the 

Database window, choose File/Close option or Click the <close> box available in the upper right comer 

of your screen. 

5.6 WORKING WITH REPORTS 

Reports provide information in a very systematic, organized and compact way. You can view and print 

this information in any format and style. Reports help in taking managerial decisions effectively and 

efficiently. 

Opening and Viewing Reports 

Opening a Report is very much similar to opening forms. First of all, go to the database window and 

select the Reports tab. All the reports contained in the database will be shown on the screen. Select the 

report that has to be opened and click at the <Preview> button. Figure 2.68 shows a sample report 

formed on the Products table. 

 

 

 

 

 

 

 

 

 

Figure 2.68: The Products Report 
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Creating a Report 

A simple report can be created using the ‘Auto Report' feature of Access. ‘Auto Report’ creates a report 

automatically containing all the fields and records from the selected table. Each field on the report 

appears in a single line carrying a label on the left side of the page. You can create a report by first 

going to the main window and then clicking at the Reports tab. Click at the <New> button present on 

the main database window. Finally, click at the 'Auto Report' option. 'Auto Report' creates a single-

column or tabular reports. 'Auto Report' is the quickest and the easiest way of creating reports. 

Printing a Report 

Most of the times, a hard copy of the report is taken out and put in record file. It helps in taking very 

useful and quick decisions. To print a report select it from the Report tab in the main database window 

and then choose 'File/Print' option from the Database window. A 'Print' dialog box appears on the 

screen. Use this dialog box to choose the printer that will print the report, which pages to print, what 

range of pages to print, how many copies and other print properties. 

Saving and Closing Reports 

A report can be saved by choosing the File/Save option. When the report is being saved for the very 

fist time, a dialog box appears before you which asks you the name of the report. By default, the 

name 'Report l' is given to your report. In order to close a report, click at the Close box available at 

the right corner of the screen. 

 

Application of a Database in Corporate Sector 

The software packages called Database Management Systems provide a very high level language 

interface which can be learned very easily by an end-user. The manager need not learn the 

programming techniques at all. Moreover, small business information systems can be easily 

implemented in a few days using this package. 

Moreover, it becomes very handy for a manager to maintain data and prepare reports based on these 

data. A variety of reports can be generated depending upon the precise and specific requirements of 

the managers. It also allows you to create queries and provides you an answer to the manager's most 
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difficult decision oriented questions. 

Student Activity 12 

1. What is the difference between design view and datasheet view? 

2. What is a form? How will you create a form? 

3. How will you edit records in a form? 

4. What is a report? How will you open and view reports in MS-Access? 

5. How will you print a report? 

6. What are the application of a database in corporate sector? 

5.7 SPREADSHEET PACKAGES 

Business applications require a lot of calculation work. In manual system, it is done on a sheet of 

paper with rows and columns, which is called a 'spreadsheet'. Spreadsheet packages use the concept 

of an electronic spreadsheet. An electronic spreadsheet (or worksheet) is a very big sheet consisting 

of thousands of rows and columns, which is used to store information in the memory of a computer. 

Like databases, electronic spreadsheets have now become an essential tool in developing a 

computerised management information system. Income statements, annual reports, balance sheet, 

cost analysis and budgets are some of the applications where worksheets are typically used. 

EXCEL 97 is a very powerful and easy to use spreadsheet package which is being commonly used 

these days. It is basically an end user application package. It works very well with numbers and their 

complex calculations. EXCEL 97 helps to put and prepare your data in an organized, orderly and 

meaningful fashion. EXCEL 97 finds its major contribution in creating reports, using formulas and 

performing calculations. It is best suited for scientific and statistical analysis. EXCEL 97 can also be 

used to prepare Profit and Loss accounts, Balance Sheet and other Tax statements. It works well for 

both simple and complicated numbers. EXCEL 97 can do anything for you. Your imagination can be 

the only limit. It can be used for preparing analytical reports including statistical analysis, forecasting 

and regression analysis. Good looking and attractive charts can be created which depict data in 

clearer and meaningful fashion. EXCEL 97 can also be used to create relationships between different 

types of data. EXCEL 97 can do all the work of a full fledged word-processor but it lacks the 
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advanced features of desktop publishing. It also supports the high level features of object linking and 

embedding which means data from Word can be safely and easily put and linked with data in EXCEL 

and vice versa is also true. 

What is an Electronic Spreadsheet 

An Electronic Spreadsheet is a network of rows and columns. Each row is given a unique number 

whereas each column is identified by a unique alphabet or pair of alphabets. So, it can be stated that an 

electronic spreadsheet is a grid that contains cells. 

Popular Spreadsheet Packages 

The popularly used spreadsheet packages are: 

⚫ MS-EXCEL 

⚫ Lotus 123 

⚫ Supercalc 

⚫ Framework 

⚫ VP Planner Plus 

Uses of Electronic Spreadsheets 

Electronic Spreadsheets satisfy the needs of a large number of users and meet with their varied 

requirements. Some of the things that can be easily done with the help of an Electronic Spreadsheet are 

mentioned below: 

⚫ Arithmetic and Statistical Calculations 

⚫ Preparation of Profit and Loss Account 

⚫ Preparation of Income Statements 

⚫ Preparation of Tax Statements 

⚫ Reports 

⚫ Charts 

⚫ Regression Analysis 

⚫ Forecasting 

An Electronic Spreadsheet can do a great job with mind crunching numbers. Any kind of complex 

calculation can be done in a matter of few seconds. 

5.8 STARTING EXCEL 2000 
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The biggest advantage offered by Microsoft Office products is the great similarity between its 

applications with respect to the overall working, toolbars and menus. Since, we have already made 

ourselves familiar with Word 2000, learning EXCEL 2000 will become easy and less time consuming 

for us. 

To startup EXCEL in Windows 98, the steps given below can be followed: 

1. Click on the Start button at windows taskbar. 

2. Select Programs option 

3. Select Microsoft Excel option. 

 

 

 

 

 

 

 

                                     Figure 2.69: Starting Microsoft Excel 

You will find that the given menu options are very much similar to Figure 2.69. As stated in the 

previous lesson also, the menu options shown to find out in this figure might not exactly resemble 

those seen on your computer. So, you need do a bit of exploring job where actually MS-EXCEL is 

installed on your computer. 

Alternatively, MS-EXCEL can also be started up through the following steps: 

1. Click at the Start button. 

2. Select 'New Office Document'. A 'New Office Document' dialog box appears on the screen. 

Double-click at the blank workbook option or select one of the other tabs, such as spreadsheet to 

start EXCEL 2000. 

Once EXCEL 2000 is loaded in the computer's memory, a blank workbook shoots up on the screen. 
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A typical name given to a file in EXCEL is Workbook. The terms Excel Document, Excel Workbook 

and Excel File carry the same meaning and can be used interchangeably. This blank file by default 

gets the name - Book l. The extension given to a file in Excel is 'XLS'. A typical Excel screen 

resembles Figure 2.70. 

 

 

 

 

 

 

 

Figure 2.70: EXCEL's Opening Screen 

Screen Elements 

Let us look at different parts of an EXCEL screen which are shown in Figure 2.71. 

\ 

 

 

 

 

 

 

 

 

Figure 2.71: Screen Elements of Excel 
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Table 2.3: Description of Screen Elements 

 

 

 

 

 

 

 

 

 

 

 

 

A workbook has got three worksheets in it by default. New worksheets can be added to it. It is a good 

idea to keep all the related work in different worksheets of the single workbook. So, it can be safely 

said that a workbook is a binder and the worksheets are its sheets. A worksheet can be moved from one 

workbook to another. 

Student Activity 13 

1. What is an electronic spreadsheet? 

2. Name some popular spreadsheet packages. 

3. How will you start MS-Excel? 

4. Describe various screen elements of MS-Excel. 

5. Differentiate between a workbook and a worksheet. 

5.9 WORKING WITH DOCUMENTS 
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In order to work in EXCEL, you have to either open an existing file or create a new one. So let us find 

out how to create, open, save and finally close files. 

Creation of a New Workbook 

EXCEL offers a variety of ways by which new workbooks can be created. So, for creating a new 

workbook, you can follow anyone of the methods discussed below: 

1. A new workbook can be created by clicking at the ' File' menu and then selecting the New' option. 

2. You can also open a new workbook by clicking at the 'New' button available on the standard toolbar. 

3. If you are a keyboard person, then don't feel disappointed. Pressing <Alt+F+N> keys together will 

also achieve your work of creating a new workbook. 

Opening a Workbook 

If your document is stored on any of the storage device like hard disk or floppy disk, then it becomes 

possible to retrieve that document. EXCEL offers a number of ways to open your document which 

are discussed below: 

1. Click at the 'File' menu and select the option 'Open'. 

2. Alternatively, for opening a document, just double click at the 'Open' button available on the 

standard toolbar. 

An 'Open' dialog box appears on the screen as shown in Figure 2.72. In this 'Open' dialog box you 

would notice a 'Look in' box which is used for selecting the drive as well as the folder where your 

workbook has been stored. Double-click the folder to see the workbooks under it. From the 'Files of 

type' box, select the kind of file that you want to open. Suppose you want that only the EXCEL 

documents should be shown in the file list then click at the pull down arrow and from the drop down 

list, select 'Microsoft Excel Files' option. Finally click the workbook name in the file list and click at 

the <Open> button or double click the workbook name to open it up. 
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Figure 2.72: The ‘Open’ Dialog Box 

Saving a Workbook 

A workbook should be saved properly before closing it or quitting EXCEL for its future retrieval. 

Once all the text is entered, save the document with any of the following methods: 

1. Click at the 'File' menu and then select 'Save' option. 

2. The other way of saving your files is by clicking at the 'Save' button available on the standard 

toolbar. 

When the workbook is being saved for the very first time, the 'Save as' dialog box comes up because 

EXCEL needs some additional information from you. EXCEL wants you to give a name to your 

workbook. If you want to save your workbook with a name that is already given by EXCEL, simply 

click at the <Save> button. However, if you want to give some other name, then erase off the existing 

name from the 'Filename' box and give a new name to the workbook. 

The 'Save as' dialog box is displayed only once till the time you don't give a name to your workbook. 

Once the workbook has a name, next time if you try to save your file after making a few changes in 

it, then the 'Save as' dialog box will not appear on the screen. So, if you intentionally want to change 

the name of your workbook, select the Save as 'option from the File' menu. Replace the name of the 
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workbook with a new name in the 'Filename' box. It will create two copies of the same workbook—

one with an old name and the other with a new name that you have just given. It's a good idea to keep 

saving your workbooks after every few minutes. The reason is if the computer goes down or a power 

failure occurs, then the chances of recovering something in the document are high. Unsaved new 

documents are the most vulnerable. 

Closing a Workbook 

It. is extremely easy to close workbooks in EXCEL. So, for closing a workbook, click at the File 'menu 

and select the Close' option. If you have made any changes in your workbook after saving it, then 

EXCEL prompts you to save your workbook before closing it. Thus, if you want that your workbook 

should be saved before it is closed, then click at <Yes> button otherwise hit the <No> button in the 

dialog box that appears next. A case may arise when you want to continue working in the same 

document after issuing 'File\Close' command. Select the <Cancel> button. It will allow you to work 

again in your document thus cancelling the issued command. 

Exiting Excel 

EXCEL offers a large number of methods for shutting itself down. You can follow any of the below 

mentioned approaches: 

1. Click at 'Close' button present in the upper right corner of the title bar. 

2. Select 'Exit' option from the 'File' menu. 

3. Press <Ctrl + W> keys together. 

EXCEL will close all the currently opened workbooks on its own. EXCEL wants you to play a safe 

game. It will again prompt you to save your files before quitting like it did while closing your 

workbook. 

5.10 DATA ENTRY AND EDITING 

A cell contains the data entered by you. At any time, one cell is always highlighted which is called the 

currently active cell. The address of this currently active cell is shown in the 'Name' box which lies in 

the upper left corner of the screen, exactly above the column letter A. You can place your data in any 

portion of the worksheet. Take your cell pointer at a place wherever you want to put your data with the 
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help of either the mouse pointer or arrow keys. Enter the data. Once you have finished typing in the 

current cell, press <Enter> key. Now, to go to the next cell, either click it with the help of mouse pointer 

or move to that particular cell with the help of arrow keys. Similarly, in order to select a group of 

continuous cells, take your mouse pointer at the cell from where you want your range to start. Click at 

that cell and then drag your mouse pointer diagonally to the opposite corner. Release the mouse pointer 

when the desired range is made. All the cells in the range become highlighted. 

Inserting Text 

Generally, when you startup EXCEL, it is in the Insert Mode, which means as text is typed in, the 

following text is pushed towards the right side. So, if you are only interested in putting new text in the 

cell then, take your cursor at that particular location of the cell and start typing in. 

Sometimes, old text has to be replaced with new text. Take your cursor at a place wherever any change 

has to be effected. Type in the new contents and erase off the existing contents with the help of <Del> 

key. However, if the EXCEL is in the 'Typeover' mode, then the old contents are automatically replaced 

with the new contents. If you want to put yourself back to the insert mode, press the <INS> key once 

from the keyboard. 

Editing the Cell Entry 

Many a times, the contents entered in a cell have to be modified and new contents are required to be put 

in it. So, for making changes in the cell entry, first take your cell pointer to that particular cell. Then, hit 

the <F2> key or double-click at that cell with the help of mouse pointer. Make the necessary changes 

and press the <Enter> key again. 

Moving and Copying Text 

The contents of a cell or range of cells can be moved as well as copied to some other location in the 

worksheet. Copying cells mean duplicating the contents of a cell or range of cells at some other 

desired place. Moving text means removing text from one portion of the worksheet and placing it at 

some other location. The procedure for copying and moving text is almost the same with a little 

difference. For copying cell contents, follow the steps given below: 

1. Select a cell or range of cells. 
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2. Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu. 

3. Take the cursor to the cell wherever you want the text to be pasted. 

4. Hit <Ctrl + V> keys. Alternatively, select the 'Paste' option from the 'Edit' menu. 

You can also use the 'Copy' and 'Paste' button available on the standard toolbar for copying and 

pasting text. On similar grounds, for moving the cell contents, select the 'Cut' option instead of 'Copy' 

from the 'Edit 'menu. Rest of the steps are the same as that of copying cell contents. 

Deleting Text 

A passage of text can be very easily erased by selecting it and pressing <Del> key from the keyboard. 

You can also delete a single character by positioning the cursor at that particular character and hitting 

the <Del> key. 

If you want to scrap off only a single word from your document, select the word by double clicking it 

and hit the <Del> key. You can also delete words by following commands: 

l Press <Ctrl + Del> keys to delete next word. 

l Press <Ctrl + Backspace> keys to delete previous word. 

Inserting a Row 

In order to insert a new, blank row in between two rows, follow the steps given below: 

1. Take the cursor where a new row has to be inserted. 

2. Select ‘Rows’ option from the ‘Insert’ menu. A blank row will be inserted above the current 

row. 

Inserting a Column 

To insert a blank column, the steps given below can be followed: 

1. Take the cursor where a new column has to be inserted. 

2. Select ‘Columns’ option from the Insert menu. You will find a new blank column inserted to the 

left of the current column. 

Deleting a Cell or Group of Cells 
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In order to delete a single cell or group of cells, follow the steps given below: 

1. Select the cell or range of cells that is to be deleted. 

2. Right click your mouse button. 

3. Choose the 'Delete' option from the menu that appears. 

Clearing the Contents of a Cell or Group of Cells 

To clear or erase off the contents of a single cell or group of cells, carry out the steps given below: 

1. Select the desired cell or range of cells from which the contents are required to be cleared. 

2. Right click the mouse button. 

3. Choose the 'Clear Contents' option from the popup menu that appears on the screen. 

Clearing the contents of a single cell or range of cells is different from deleting them. When you clear a 

cell or range of cells, the contents are erased, leaving the cells blank. However, when a cell or cell range 

is deleted, the other cells re-adjust themselves to fill in the empty space created by deleting them. 

Changing the Row Height 

You can change the overall look of the whole workbook. You may require to change the height of a row 

for adjusting text in case a larger font size than default is applied onto it. So, if the font size is made 

larger than the cell height, then some part of the text might be hidden. Now, to change the height of 

rows, the steps given below can be applied: 

1. Select the row whose height has to be changed. This can be done by either clicking in any cell of 

that particular row or by clicking at the row header. 

2. From the ‘Format’ menu, select the 'Row' option. Then, choose 'Height’. 

3. Enter the height of the cell that you want to achieve. 

In order to change the height of a group of rows, select all those rows. From the 'Format' menu, select 

the 'Rows' and then the 'Height' option. Key in the desired row height. All the selected rows will have 

the same row size. 
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Changing the Column Width 

On similar grounds, the width of a column can also be altered. Column width can be re-adjusted 

according to your own special requirements. Thus, for changing the column width, carry out the steps 

given below: 

1. Select the whole column either by clicking at the column header or by clicking at any cell of that 

particular column. 

2. From the ‘Format’ menu, choose the 'Column' option. It will display a 'Column’ Width dialog box 

on the screen. 

3. Type in the new column width. Finally, click at the <OK> button. 

5.11 TYPES OF CELL ENTRIES 

EXCEL can very smartly make out the type of data as you type in. You can key in values and formulae 

from the keyboard. Values can contain text, numbers or special characters. The formulae can perform 

calculations based on the values present in other cells. You can apply any font type, size .and alignment 

pattern on these values. Let us discuss the different types of cell entries in detail: 

Text Values 

We can put both text and numbers in a cell. Any entry that contains text, numbers or any special 

character is recognized as a text entry. A text purely in alphabets is mostly used for giving titles and 

identifying information such as Salesman Name; Sales (pieces); etc. Generally, a text entry is given at 

the top and left side of the worksheet. A number entry can be formatted to text in a case when no 

mathematical calculation is required on it. By default, a text entry is left aligned. Looking at the 

alignment of the entry, you can easily make out the category in which EXCEL has placed your data. In 

order to apply any particular type of format on your data, select the cells and activate "Cells" option 

from the "Format' menu. Choose any of the formats to apply it on the selected text. 

Numeric Values 

Any entry is treated as a numeric value if the first character entered, is a number or a mathematical 

operator such as + or –. Numbers are typed directly. A numeric value can contain any of the following 

characters: 
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0 1 2 3 4 5 6 7 8 9 + - ( ) , / $ % . E e 

 

By default numeric values are right aligned. These numbers can also be formatted depending upon the 

kind of presentation you require. EXCEL has some pre-defined formats for each kind of numeric 

value. 

Formulae 

EXCEL offers a very powerful tool to use existing data values to calculate new values. Formulae 

establish relationship between two or more cells. It performs a mathematical or arithmetical operation 

on these data values. The formula can contain numbers as well as cell addresses and can be created 

using the arithmetic operators like + (addition), – (subtraction), *(multiplication), /(division) and ^ 

(exponent). The formula entry can be made by beginning the entry with a +, @ or = sign. While 

entering a formula, key in an opening bracket followed by cell address. It must end with a closing 

bracket. 

Let us now create a simple worksheet and learn how to put labels, values and formulae in it. Follow the 

steps given below: 

1. Take your mouse pointer to the cell C2 and type in "RUBY BAKERY PRODUCTS". Then, press 

the <Enter> key. 

2. Go to the cell D3 either with the help of arrow keys or by clicking it with the mouse pointer. 

Thereafter, enter "Jun-98". Press the <Enter> key. Similarly, typein "Jul-98" in the cell E3 and 

again hit the <Enter> key. 

3. Similarly, enter all the data as shown in Figure 2.73. 

4. Now, we want to find out the total sale for the month of Jun-98. This requires the entering of a 

formula in the cell D9. So, take your cell pointer to the cell D9. The formula entry shall begin 

with a + sign or an opening parenthesis. 
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Figure 2.73: An Example of a Single Worksheet 

5. The formula can be entered by two methods: 

(a) The first approach is to type in the cell addresses in the cell where you want to see the result of 

the formula (like +D4+D5+D6+D7+D8) as shown in Figure 2.74 and then press the <Enter> 

key. You will find the result of the formula at the cell address D9. 

 

 

 

 

 

 

 

                                   Figure 2.74: Figure Showing the use of a Formula 
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b) The second way of entering a formula is by Pointing method. In this method, first of all, enter a 

+ sign in the cell where the formula is required (here, in our example the cell address is D9). Then, 

move the cell pointer to the cell D4. You will find this cell address appearing automatically at the cell 

D9. Thereafter, typein the + sign again. Move the cell pointer to the next cell. Keep repeating it till the 

complete formula is keyed in. Finally, hit the <Enter> key. Now, you will find the result of this 

formula at the cell D9 as shown in Figure 2.75. 

 

 

 

 

 

 

 

 

 

                              Figure 2.75: Figure Showing the Result of a Formula 

5.12 COMMONLY USED FUNCTIONS 

EXCEL offers a variety of in-built functions which are very easy to use. These functions simplify 

operations like finding out sum, average, maximum, minimum, count and so on. All these functions 

start with the @ sign. The syntax of a function is given below: 

@FUNCTION-NAME<RANGE OF CELLS> 

where, 

FUNCTION-NAME is the name of the standard in-built function as offered by EXCEL and <range of 

cells> specifies the cell range on which the action of the function has to be performed. Let us discuss 

some of these functions one by one. We will take the example of the workbook as shown in Figure 
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2.76 in explaining these functions. 

The @SUM( < range of cells> Function 

This function adds the values of the cells specified in the range. For example: 

@SUM(D4:D8) 

It would show the added up value of the cells D4,D5,D6,D7 and D8 as 210. 

The @AVG( <range of cells> Function 

The @AVG function finds out the average value of the cells given in the range of cells. For example: 

@AVG(D4:D8) 

It would display the average value of the cells D4 through D8 as 42. 

The @MAX( <range of cells> ) Function 

The @MAX function determines the greatest value out of the specified range of cells. For example: 

@MAX(D4:D8) 

It shows the highest value, 71, contained in cells D4 through D8. 

The @MIN( <range of cells> Function 

The @MIN function ascertains the smallest value amongst the range of cells provided to it. For 

example: 

@MIN(D4:D8) 

It will give the result 13 because this is the smallest value contained in cells D4 through D8. 

The @COUNT( < range of cells> ) Function 

The @COUNT function counts the number of entries in the given range of cells. For example: 

@COUNT(D4:D8) 

It will give back the answer as 5 since there are five entries in the above specified range. This function 

can be useful if you want to find out the number of entries made in a particular range especially when 

the worksheet is very big. 
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5.13 ABSOLUTE AND RELATIVE CELL REFERENCING 

You can very well copy formulas in EXCEL. As and when a formula is copied, the cell references in 

the new formula are changed. The new formula corresponds to the position it was in relative to the 

original formula cell. Let us once again concentrate ourselves on the Figure 2.74. Now, if we try to 

copy the formula given in the cell address D9 to D10, then the formula is going to become 

=E4+E5+E6+E7+E8. This is called Relative Referencing. In this case, since the references are relative, 

the formula automatically adjusts with the new value. However, sometimes you may require to make 

the reference absolute or fixed. This means that when the formula is copied to some other destination, 

then the formula should not change. This is called Absolute Referencing. Absolute Referencing can be 

enforced 'by preceding the row or the, column letter with a ($) dollar sign like $D$5. Now, when you 

try to copy this reference ($D$5) to any place in your workbook, then the reference is not going to 

change. An absolute reference works well for a constant that can be used in a formula stored in a cell. 

If the row letter is preceded with a dollar sign, then only the row is fixed e.g., D$5. When D$5 is 

copied to some other location then, the column letter is going to take the new reference address but the 

row number would still remain 5. In the similar manner, column letter can also be preceded with a 

dollar sign e.g. $D5. This will make the column fixed while copying but row is going to take the new 

reference. 

5.14 NUMBER FORMAT 

EXCEL has got some pre-defined formats that can be applied to numbers. These number formats differ 

in terms of number alignment, placement and other accompanying symbols with it. When the number 

format is applied to cells, the numbers are rounded off to the specified number of decimal places. As 

and when the numbers are rounded off the change is reflected only on the screen. However, in memory 

the actual form is stored. At the time of performing calculations, the actual number stored in memory is 

used. For example, if you round off two numbers 5.6 and 3.2 in two different cells, the display on the 

screen will be 6 and 3. However, if you try adding up these two numbers, the sum that will be shown 

on the screen is 9. The Table 2.4 shows the different types of formats that can be applied to numbers. 
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 Table 2.4: Pre-defined Number Formats 

  

Format Explanation 

  

General For all numbers on which no formatting is to be applied. 

  

Number For numbers in which number of decimal places is to be specified. 

  

Currency For converting numbers into monetary values. 

  

Accounting point For all those monetary values that are to be aligned at the decimal. 

  

Date For showing date in different styles. 

  

Time For showing time in one of the many styles available. 

  

Percentage For converting your numbers into percentage. 

  

Fractions For converting numbers into fractions. 

  

Text For those numbers which are to be treated as text. 

  

Scientific For converting numbers into scientific notations. 

  

Custom For creating your own formats. 

  

Any of the above mentioned formats can be applied to either a single cell or range of cells before or 

after typing in the value. In case, any specific format is applied to blank cells, then any entry that is 

typed in those cells will be automatically converted to the selected format. Let us proceed further and 

learn how to apply a few formats. In order to format numbers, follow the steps given below: 

1. Select the cells that need be formatted. 

2. From the 'Format' menu, choose cells option. A 'Format Cells' dialog box appears on the screen. 

3. Click at the 'Number' tab. 

4. Select the format that you want to apply. 
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5. Finally, click at the <OK> button. 

Autofill 

Autofill tool offered by EXCEL helps you to repeat a cell entry. It looks at the series entered by you in 

adjacent cells and tries to complete it for you. For example, if you want to enter the labels for all the 

twelve months of a year simply, type in first two entries, i.e., Jan. and Feb. in two adjacent cells. Then, 

highlight both the cells by selecting them. Take your mouse pointer at the bottom right corner of the 

selected cells. Your mouse pointer is going to take the shape of a + (plus) sign. This plus sign is called 

Autofill handle. Drag your mouse pointer either across or downwards for those many cells till you wish 

to continue the series. Autofill keeps filling the series till the time the mouse pointer is dragged. So, 

you are saved the effort of keying in the labels of the rest of the months. The output given by Autofill 

is shown in Figure 2.77. While using Autofill, you can drag the mouse pointer up, down, right or left. 

Look at some of the examples of sequences that the Autofill feature can identify: 

 

 

 

 

 

 

 

 

Figure 2.76: The 'Autofill' Handle 

(i) Monday, Tuesday..... 

(ii) 10, 20, 30..... 

(iii) 1, 2, 3..... 

(iv) AI, A2, A3.... 
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(v) 5:10, 5:20.... 

 

 

 

 

 

 

 

 

Figure 2.77: Figure Showing the Output given by 'Autofill' Handle  

Student Activity 14 

1. How will you create a new workbook in MS-Excel? 

2. How will you save a workbook in MS-Excel? 

3. How will you edit a cell entry? 

4. How will you delete text from a cell? 

5. How will you insert a row or a column in a worksheet? 

6. Describe various types of cell entries. 

7. List some commonly used functions in MS-Excel. 

8. Describe absolute and relative cell referencing. 

9. What is the function of Auto fill option in MS-Excel? 

5.15 CHARTING WITH EXCEL 

As the common saying goes 'A picture is worth a thousand words' is found true by almost all of us. 

Any kind of message can be best said and understood through its representation in pictorial form. A 

chart or a picture gives a bird's eyeview of the entire scenario in a single look. So, let us see how we 
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can utilize the EXCEL's power of making charts. EXCEL supports many different kinds of charts 

according to the vast and varied needs of the user. EXCEL also allows you to link your charts with 

your data. So, as and when some changes are made to the data, these are automatically reflected in 

your chart. 

 

 

 

 

 

 

Figure 2.78: Figure Giving an Example of a Worksheet 

A typical worksheet showing data arranged in rows and columns can be safely used for creating charts. 

Thus, enter data in a tabular form with proper row and column headings. EXCEL is very good at 

figuring out an appropriate chart on its own. 

Let us first of all create a worksheet with the data given in Figure 2.78. This figure gives the number of 

sales made by each salesman in a particular month. 

To create a chart, select one of the cells in the table and press F11 key. EXCEL would automatically 

create a chart for you as shown in Figure 2.78. This is the easiest way of creating a chart. 

Let us find out how to create charts using Chart Wizard. A wizard is a tool offered by EXCEL which 

takes you through a series of steps to complete a particular process. So, while working through a 

wizard, it shows a dialog box which asks for more information. You can either accept the default 

settings or you can give in your own information according to your requirement. Thus, to create a chart 

using the data given in Figure 2.78, let us begin by selecting a cell within the table. 
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Step 1 of the Chart Wizard 

 

 

 

 

 

 

Figure 2.79: Step 1 of the Chart Wizard 

A chart can be put in the worksheet by two methods. One is to click at the 'Chart' button available on 

the standard toolbar. The second approach is to select the 'Chart' option from the Insert menu. A 

dialog box shown in Figure 2.79 appears on the screen. 

Select the 'Standard Types' tab. Now, select the kind and type of chart into which the data has to be 

converted from the 'Chart Type' box. Then, select the chart sub-type from the adjacent window. 

Finally, click at <Next> button. 

Step 2 of the Chart Wizard 

A dialog box as shown in Figure 2.80 appears on the screen. This dialog box gives you an 

opportunity to decide the data orientation (i.e., which data label has to be shown on the bottom axis 

of the chart). In our sample data, we have two labels ‘Salesman Name' and 'Sale'. If you want that the 

'Salesman Name' should come along the bottom axis and the 'Sales' along the left axis, then click at 

'Columns' radio button. However, if you want to change the orientation, click at the 'Rows,' radio 

button. This will make 'Sales' come along the bottom axis and the 'Salesman Name' along the left 

axis. 
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Figure 2.80: The 'Source Data' Dialog Box 

Data range included in the chart can be changed very easily. Click at the 'Collapse' dialog icon which 

appears at the end of the 'Data Range' text box. A collapsed dialog box appears on the screen as 

shown in Figure 2.81. This will make your worksheet apparent again. The data that has been selected 

for creating a chart is shown by dashed lines. In case, you want to use a different data range, then you 

can select that particular data from here. Click at the 'Expand' dialog icon which is located at the right 

corner of the collapsed dialog box to go back. Now, you have the desired range and orientation. Click 

at the <Next> button. 

 

Figure 2.81: Step 2 of the Chart Wizard 

 

 

 

Step 3 of the Chart Wizard 

A dialog box as shown in Figure 2.82 appears on the screen. Click at the 'Titles' Tab. It will   
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label 

 

 

 

 

 

 

 

                   Figure 2.82: Step 3 of the Chart Wizard 

Step 4 of the Chart Wizard 

This is the last step in the process of chart creation. All the necessary details required by the chart are 

given in Step 1 through Step 3. The fourth and the final step asks you whether the chart is going to be 

displayed in the worksheet where the data is located or in a separate worksheet. So, in this last step as 

shown in Figure 2.83, you have to decide whether the chart is to be embedded as an object in a 

worksheet or it is to be placed in a separate worksheet. Let us find out the difference between these two 

types of charts: 

 

 

 

 

 

 

                                Figure 2.83: Step 4 of the Chart Wizard 
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Figure 2.84: Different Components of a Chart 

1. Embedded Charts: These charts can be linked to the data based on which the chart is created. 

So, if any changes are made to the data, the corresponding chart also changes. 

2. Chart Sheets: These charts can also be linked to the data. The only difference is that these 

charts are placed in separate worksheets. The chart is put in the middle of the new worksheet. It 

leaves very little scope of moving the chart. 

Finally, click at the Finish. 

The different components of a chart are shown in Figure 2.84. 

5.16 MACROS 

The very word 'Macro' gives the impression of a huge big giant. Macro is not the hero of a horror 

movie but a small program that carries out pre-defined and prerecorded series of steps by giving a 

few keyboard shortcuts. So, we can state that a macro is like a recorded movie which can be run any 

number of times. Macro is just a way of doing your work in a series of steps which it carries out 

automatically once it is triggered. It can be very easily said that a macro is like a batch fie created in 

DOS. It contains a series of commands. So, as and when a macro is called and run, the instructions 

given in it are executed one by one. 
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A macro automates your tasks, thus saving a lot of your precious time. ‘Macro’ can just do anything 

for you. Your imagination can be the only limitation to it. EXCEL offers macros in two languages, 

Excel Visual Basic and Excel 4.0 Macro language. You can use either language to create macros but 

Excel Visual basic is more difficult to use. Moreover, you also need know Excel Visual Basic 

language itself. So, throughout our session, we would concentrate on learning how to create macros 

using Excel 4.0 macro language. 

Creating and Naming a Macro 

A macro is very easy to create. Before proceeding further, first decide the steps that your macro is 

supposed to carry out. Suppose you want to write a macro that would cut a range of cells and paste it 

at some other location. Thus, in order to create a macro, carry out the following steps: 

1. Select 'Tools\Macro' option from the main menu. 

2. Select 'Record New Macro' option from the cascading menu. It would display 'Record Macro' 

dialog box as seen in Figure 2.85. 

3. Name the macro under which you want to save it. Name to a macro can be given in 'Macro Name' 

box. A long name upto 255 characters can be given to a macro. However, you cannot include 

spaces in your macro name. Your macro name can have only numbers, letters and underscore 

character. But There is one limitation to it. The macro name cannot start with a number or an 

underscore character. 

 

 

 

 

 

 

                     Figure 2.85: The 'Record Macro' Dialog Box 
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4.After assigning a name, you are required to give a keyboard shortcut to it. Giving a keyboard shortcut 

is absolutely at the discretion of the user. A keyboard shortcut is assigned only if the user wants to 

execute the macro using a keyboard. However, if any lowercase alphabet is given in the 'Shortcut key' 

box, then the macro can be executed by pressing the <Ctrl + 'alphabet'> keys together. However, if an 

uppercase alphabet is used, then you need press <Shift + Ctrl + 'alphabet'> keys together. Suppose you 

give the alphabet 'C' in the 'Shortcut key' box, then this macro can be activated by pressing <Shift 

Ctrl+C> keys together. On the contrary, only if 'c' in the 'Shortcut key' box is given, then in that case, 

the macro can be activated by pressing <Ctrl + C> keys only. 

5.Now, we proceed on to the 'Store Macro in' box. If you want to use the macro that you are now trying 

to create in the current workbook only, then select the option 'This Workbook' from the drop-down list. 

However, if you want to make your macro available to other workbook, then select 'New Workbook' 

option from the drop down list. 

6.In the 'Description' box, give some relevant and important details about your macro like the date on 

which macro was recorded, the owner of the macro, the purpose for which the macro has been created, 

etc. Thus, any kind of descriptive text can be given in this box. It enables you to remember all the 

important things about your macro. 

7.Now, as and when all the relevant details are filled in the 'Record Macro' dialog box, click at the 

<OK> button. A very small 'Stop Recording' toolbar will appear on the screen. Till this point of time, 

we have only told Excel that we want to create a macro. It is actually now when the process of 

recording starts. 

Recording the Macro 

You can now proceed on to record your macro. Just perform all the essential steps to complete your 

particular task. For this example, in which we have to cut a range of cells and paste at some other 

location, do the following steps to record them in your macro: 

1. Select the range of cells that has to be cut. 

2. From the Edit menu, select the 'Cut' option. 
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3. Take your cursor at a location where you want to paste this range of 

cells. 

4. Again, from the 'Edit' menu, select the 'Paste' option. 

5. Click at the 'Stop Recording' button available on the 'Stop Recording' 

toolbar. 

The macro is now ready to be executed. This macro is by default made available to all the worksheets 

of the current workbook. However, if you want this macro in other workbook, then select 'New 

workbook' option in the 'Record Macro' dialog box. Don't forget to click at the 'Stop Recording' 

button once all the necessary steps to be included in the macro are over. Otherwise your macro is 

going to become unnecessarily big with unwanted steps in it. 

Saving the Macro 

The macro that we have just created in our previous example is made available only to the current 

workbook. But, if you want that this particular macro should be made available to other workbook, 

then choose 'New Workbook' option in the 'Record Macro' dialog box. EXCEL will then ask you the 

name of the new workbook in which the macro has to be saved. 

Using a Macro 

Till this time, we were on our path of creating a new macro. Now, let us learn how to run or execute 

a macro. You can run your macro in any of the following ways: 

1. If a shortcut key has been assigned to your macro, then it can be activated by pressing 

<Ctrl+'key'> or <Shift+Ctrl+'key'> depending upon the case of the 'key'. 

2. A macro can also be run by selecting 'Tools\Macros\Macros' from the main menu. Then, click 

at the macro name that you want to execute. Once the macro starts running, you can stop it 

abruptly in between by pressing the 'Esc' key. 

Deleting a Macro 

If a macro is no longer needed, then it is advisable to delete it. In order to delete a macro, click at the 

'Tools\Macro\Macros' option from the main menu. A 'Macro' dialog box appears on the screen. Select 

the macro that has to be deleted. Finally, click at the <Delete> button to complete the process. 
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Editing Macro Options 

Many a times, a macro requires some changes to be made to it. You can change the shortcut key or 

description that has been given to the macro. Thus, in order to make changes to your macro, click at 

the 'Tools\Macros \Macro' option of the main menu. A 'Macro' dialog box appears on the screen. 

Click at the <Options> button to show the 'Macro Options' dialog box. Make all the necessary 

changes and finally click at the <OK> button. 

5.17 IMPORTING AND EXPORTING FILES 

EXCEL allows you to import data from databases created by other programs such as Lotus 123 and 

dBase. So, this makes reading from and writing into files created by other spreadsheet and database 

programs possible. It can help you in sharing information with other spreadsheet programs like Lotus 

123, Quattro Pro or Multiplan. EXCEL takes all the responsibility of converting files from other 

worksheet database programs automatically as and when the file is either saved or opened. The 

'File\Open' command reads the file extension of the files created by other programs. In the similar 

manner, when you try to save files, the 'File \save as' option helps you to save your file in other types 

also. Files can be exported by clicking at the desired file and then selecting a required file type in the 

'Save as' dialog box. Files can also be imported which are created by various versions of dBASE and 

Lotus 123. You simply have to pick the file using "File\Open" option. EXCEL can also open plain 

ASCII text files. Let us import the file 'Shruti.Txt'. Start the EXCEL program first and display a 

blank workbook. 

1. Open the file 'Shruti.txt' by selecting 'Open' option from the 'File' menu. Figure 2.86 appears 

on the screen. 

2. Click at the <Next> button. 

3. A dialog box by the name 'Text Import Wizard Step 2 of 3' appears on the screen. It guesses 

where the columns should be put as shown in Figure 2.87. 
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Figure 2.87: Step 2 of Text Import Wizard 

4. In case you want the columns to appear at some other place, then move the line by clicking it and 

then dragging it. You can also remove a line in case you do not require it by double-clicking at that 

particular line. Then, click at the <Next> button. 

5. A 'Text Import Wizard Step 3 of 3' is shown on the screen as can be seen in Figure 2.88. This 

dialog box allows you to set the Data Format for each column. You can also leave the data as it is 

without changing the data format. Finally, click at the <Finish> button. 
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Figure 2.88: Step 3 of Text Import Wizard 

5.18 PRINTING A WORKBOOK 

There could be a number of reasons for taking a printout of the workbook that you have just created. 

You may be required to give the yearly status of the overall working of the company to your boss or 

you may want to keep a copy of the workbook for your own future reference. EXCEL offers a very 

easy way of printing the workbook. You can very well control the overall look of the whole printout 

and modify it to suit your own special requirements. You can preview your document before taking a 

final printout. It will give the overall look of how your printout is actually going to look on paper. So, 

for previewing the workbook, activate the 'Print Preview' option of the 'File' menu. The Figure 2.89 

shows a preview of a worksheet. Now, after previewing the workbook, you are ready to take a 

printout. So, proceed with the steps given below: 

 

 

 

 

 

Figure 2.89: Figure Showing Preview of a Worksheet 
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1. Open the file whose printout has to be taken. 

2. From the 'File' menu select the 'Print' option. A 'Print' dialog box appears on the screen as shown 

in Figure 2.90. 

3. Choose the printer that you want to use out of all the installed printers on your system from the 

'Name' drop down list. 

4. You can select the pages of the workbook you want to print. Through the 'Print range' option of the 

'Print' dialog box. For example, if you want to take a printout of all the pages of the current 

workbook, then click at the 'All' radio button. But sometimes, you require only selective pages to 

be printed. For that matter, click at the 'Pages' radio button and type in the starting number of the 

page in the 'From' box. Similarly, enter the page number till which the printout has to be taken in 

the 'To' box. 

5. Enter the number of copies you want to print in the 'Number of Copies' box. 

 

 

 

 

 

 

 

 

                      Figure 2.90: The 'Print' Dialog Box 

6. The 'Print What' option lets you to decide in printing, either the selected portion of the worksheet 

or the whole workbook or just the active sheet(s). 

7. You can also see the preview of the workbook by clicking at the 'Preview' button. 

5.19 APPLICATION OF A SPREADSHEET IN CORPORATE SECTOR 
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Electronic spreadsheets contribute a lot in the day-to-day working of corporate sector. All the 

managerial reports, price lists, etc., are prepared with the help of electronic spreadsheets. It helps the 

management to take quick decisions. It is able to answer the important 'what if' questions of the 

managers based on which they can design and develop various marketing and sales strategies. These 

days almost all the managers make use of spreadsheets extensively. 

Student Activity 15 

1. What is a chart? 

2. How will you create a chart using chart wizard? 

3. What is a chart sheet? 

4. What are embedded charts? 

5. What are MACROS? 

6. How will you create and record a macro? 

7. How will you import an access file in a worksheet? 

8. How will you print a workbook? 

9. How will you save a micro? 

10. What are the applications of a spread sheet in corporate sector? 

5.20 SUMMARY 

A database refers to the collection of interrelated data and database management systems (DBMS) is 

a computer program that manager a database effectively and efficiently. MS-Access offers many 

features like tables, forms, queries, reports and data access pages to manage data, A new database can 

be created either through wizard or by clicking File New command or New button or by pressing 

ctrl+N. While designing tables, you have to decide about field names, field types, field size, field 

properties and primary key. 

At field level these validation techniques maybe used: Input mask, validation Rule and Text, Default 

Value, Allow Zero Length, Required and Lookup values. The input Mask property specifies and 

controls how data is entered and displayed. 
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A word processor is a package that processes textual matter and creates organized and flawless 

documents. The word processor offers very useful features like speed, powerful editing and formatting 

features, permanent storage, Graphics, object linking and embedding spell check and mail merge etc. 

Tables can be inserted in a word document through Table button of Standard toolbar and can be 

manipulated through the Table drop down menu. Also word provides quite many drawing features that 

can be used to include the desired graphics in the document. 

A spreadsheet is a software tool that lets one enter, calculate, manipulate, and analyze set of numbers. A 

worksheet is a grid of cells made up of horizontal rows and vertical columns. A worksheet is a group of 

worksheets. Three types of data can be entered in a Worksheet (i) Number 

(ii) Text, (iii) Formulas, charts are the pictorial representation of worksheets data. Various chart 

types in MS-Excel are: areas chart, column chart, bar chart, line chart, pie chart, XY (scatter) chart. 

Chart in MS-Excel are saved in two ways: (i) embedded chart (ii) Chart sheet. Embedded chart is a 

chart object that is placed on a worksheet and saved with that worksheet. Chart sheet is a sheet in a 

worksheet that contains only a chart. 

5.21 KEYWORDS 

MS-Excel 2000 

Absolute Reference: Address of a cell or a range of cells with no reference to other cell in terms of 

row and column addresses. 

Cell: A Cell is a box at the intersection of a row and a column in a worksheet where data is stored. 

There are 65536 x 256 = 16777216 cells in a single worksheet. 

Column: Columns are combination of all the vertical cells joined together in a single vertical line. 

Fill Handle: The small black square in the corner of the selection of a cell or range, which changes 

to a black cross pointer when placed at the corner of selection. 

Formula Bar: Formula bar shows the formula instead of the result, if there is one present in the 

current cell. 

Formula: It is an expression that performs operations on worksheet data. Formulas can perform 
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mathematical operations, such as addition and multiplication. 

Full Screen View: A view in which the entire desktop space is occupied by the current worksheet. 

Headers and Footers: They are text, page numbers, date, document’s title or file name, or the 

author’s name that are usually printed at the top and bottom of each page in a worksheet respectively. 

A header is printed in the top margin, footer is printed in the bottom margin. 

Name Box: This box shows the name or the address of the currently active cell. 

Normal View: A view of a worksheet in which no reference to pagination is displayed and print area 

is not specified. 

Range: A group of cells, optionally having a name taken as one unit of cells. 

Relative Reference: It is address of a cell or range of cell with respect to a given cell. 

Row: Rows are combination of all the horizontal cells joined together in a single horizontal line. 

Workbook: It is a group of worksheets, which can be stored as a unit. A workbook is stored on the 

disk in form of a file with extension .xls. 

Worksheet: It is the working area of MS-Excel. Each worksheet of a single workbook has its own 

identity and is separate from other worksheets. 

Workspace: It is the working area of MS-Excel where workbooks, worksheets and other related 

objects may be opened and manipulated. 

MS-Access 2000 

Action Query: It is used to perform an action on records that meet the criteria specified in the query 

object. 

Application Programmers: Computer professionals who interact with the system through Data 

Manipulation Language calls, which are embedded in a program written in a host language (for 

example, COBOL, PL/I, PASCAL, C). The programs are referred to as application programs. 

Attribute: Piece of information describing a particular entity. These are mainly distinguishing 

characteristics of the individual entity. 
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Auto Number Data: A data type that stores an integer that is incremented or decremented 

automatically as records are added and/or deleted. 

Built-in Functions: Small programs that perform simple calculations or data formatting by taking 

optional arguments. These functions are already created for the users and they do not have to create 

them. 

Currency Data: A data type that stores monetary data. 

5.22 REVIEW QUESTIONS 

Unsolved Questions 

1. Fill in the blanks: 

(a) A——structure in DOS resembles on inverted tree. 

(b) ——command is used for formatting a hard disk or floppy disk. 

(c) —is a special kind of batch file which is executed as soon as the operating system is loaded in 

the computer’s memory. 

(d) Windows supports file names upto——characters. 

(e) The find option of the start menu help in —a particular file or a folder. 

(f) The files once deleted in windows can be restored from the—. 

(g) Word processing included——and——text to give organized look to the document. 

(h) ——menu is used for enhancing the look of the document. 

(i) Copying means——the contexts of the document while moving means——text from one 

portion of the document and placing it at some other location. 

(j) A——is a collection of related information. 

(k) A——is a written set of instructions that automate repetitive tasks. 

(l) These are ——rows and——columns in an excel worksheet. 

(m) The formula entry in excel can be made by beginning the entry with a ——,——— or sign. 
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2. State: True or False: 

(a) A file name with no extension is invalid in DOS. 

(b) RD command removes all the files and sub-directories under the current directory. 

(c) MD command is used to create a new file. 

(d) XCOPY command is used to copy the files present in sub-directories. 

(e) Windows contains a disk compression program which can essentially double the hard disk 

space. 

(f) Scan disk reconfigures files on the hard disk 

(g) Page setting includes putting your text neatly between margins. 

(h) A report is used for showing the data put in the table in an organized manner. 

(i) You have to save the records, you enter after certain internals in Access. 

(j) Excel allows to import data from databases created by other programmers. 

Answers (Unsolved Questions) 

1. (a) director (b) FORMAT (c) AUTOEXE. BAT (d) 255 (e) locating (f) Recycle bin (g) typing, 

manipulating (h) FORMAT (i) duplicating, removing (j) database (k)Macro (l) 65536, 256 (m) +, 

@,= 

2. (a) False (b) False (c) False (d) True (e) True (f) False (g)True (h) True (i) False (j) True. 

Detailed Questions 

1. What do you mean by booting up? 

2. What is the full form of ROM-BIOS? What do you mean by default drive? 

30. How many parts are there in a file name under MS-Dos? What are file naming conventions? 

31. What are volume labels? How many characters can a volume label contain? 

32. What are wild cards? What is the use of '?' and '*' wild card in MS-DOS? 

33. What is the purpose of copy command? 
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34. To view a directory listing width wise, which command is used? 

35. Which commands lets you create directories? Give example. 

36. What is the use of switch /w in DIR command? 

37. How is X COPY a better copy command than COPY? 

38. What are batch files? What is the significance of AUTOEXEC.BAT file? 

39. Give some of the advanced features of window 98. 

40. What is the difference between copying and moving files and folders? 

41. When a folders is copied to another place, do the sub-folders in the folder also get copied? 

42. What is windows Explorer and give some of its functions? 

43. Differentiate between notepad and WordPad. 

44. What do you mean by dialog box? Also discuss its various components. 

45. What is the start Group? What are the different functions that can be done through this? 

46. Discuss some advance features of windows 98. 

47. (i)  Give procedure to create a new folder in windows 98. 

(ii) Give procedure for closing down the windows 98. 

48. What is the function of taskbar and recycle bin? 

49. Describe the functions of the Control Panel. 

50. What are the advantages of a word processor over typewriters? 

51. What is meant by text alignment? In how many ways can you align you text? 

52. What is meant by page margins? Which option will you choose to set the margins of your 

document? 

53. What are the advantages of find or replace features of word processor? 

54. Write your Bio-Data in MS-Word. 
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55. Prepare a business letter to you customer promising to attend to his complaint immediately. Use 

page setup, formatting features, etc. 

56. Prepare a table in which the budget comparison of three years is made. 

57. What is data and why is it required? 

58. What is information and how it differs from data? 

59. Differentiate between a query and a report. 

60. Differentiate between a form and the datasheet view. 

61. Describe various ways of creating a table in access. Differentiable between a formula and a 

function. 

62. Differentiate between a formula and a function. 

63. Differentiate between a table and a query. 

64. What are the purposes of forms in Access 2000? Explain with appropriate examples. 

65. Can an Excel chart be inserted into an Access report? How? 

66. How many rows and columns are there in MS-Excel Worksheet? 

67. What do you mean by range of cells? 

42. What do you mean by cell referencing and what are different types of referencing? 

43. Why is formatting necessary? 

44. What are the different types of data that can be entered in MS-Excel? 

45. What is the difference between copying and moving a range? 

46. What is the different components of chart? Explain. 

47. Define embedded chart. 

48. Define chart sheet. 

49. Explain various types of charts available in MS-Excel. 

50. Which types of files can be imported and exported from MS-Excel? 
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5.23 FURTHER READINGS 

Sanjeev Gupta and Shameena Gupta, Computer Aided Management (Using MS-Office 2003 Tools), 

Excel Books. 

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, Editions De L’Ocean Indi 
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5.1 INTRODUCTION 

 

After studying this unit, you should be able to understand: 

⚫ How to create a presentation on PC using wizard or template. Or a blank presentation? 

⚫ Components of power point screen. 

⚫ Auto content wizard. 

⚫ Different views available in power point.  

⚫ Displaying the slides. 

⚫ Saving a presentation 

PowerPoint is a presentation software package included in Microsoft Office suite. It is used to create 

professional quality presentations. A presentation is a structured delivery of information. Presentation 

can be reproduced on transparency, paper or on-screen. PowerPoint features can be used to work on 

slides, organize presentation contents with outlines and generate speaker notes and audience handouts. 

Teachers, professors, politicians and sales representatives make presentations to sell their concepts. 

Some other notable presentation software packages are Harvard Graphics and Lotus Freelance. 

PowerPoint 2000 helps you structure the ideas and information that you may want to convey to your 

audience. It lets you create the contents of your presentation by typing/inserting text, pictures, sounds 

and animations. With it, you can add visual images, supporting documents and audio recordings to 

enhance your presentation. PowerPoint makes the creation of any presentation simple by providing built-

in professional designs called AutoLayouts and templates. You can also create different versions of. a 

presentation for different audiences and build your contents in either a text-based outline view or a 

design based slide view. 

3.2 CREATING A PRESENTATION ON PC 

Before you start creating presentations, you need understand the layout of the PowerPoint screen. The 

PowerPoint screen displays several toolbars and other basic screen elements (refer to the Figure). 

5.0 LEARNING OBJECTIVES 
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The components of a PowerPoint screen are:  

Menu Bar: It is similar to the menu bar in other Microsoft Office applications having File, Edit, 

View, Insert, Format, Tools, Window, Help menus. 

Toolbars: Toolbars are collections of buttons that you can click and activate some of the most 

common commands in PowerPoint. These commands can also be activated through menus. 

 

 

 

 

 

 

 

 

 

 

 

Status Bar: It is located at the bottom of the PowerPoint screen. It displays the number of the current 

slide and the name of the template on which the presentation is based. 

Vertical Scroll Bar: It helps you to scroll through the slides in a presentation. 

Slide Buttons: They are located at the bottom of the vertical scroll bar and help you to display the 

previous and next slides. 

3.3 CREATING A NEW PRESENTATION 

PowerPoint offers a variety of ways to create a new presentation. You can create a presentation by using 

wizard or a template. You can also create a blank presentation. 
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Starting AutoContent Wizard 

Everytime you start PowerPoint 2000, the PowerPoint dialog box is displayed which offers methods of 

starting the session. You can use it to choose the method for starting your PowerPoint 2000 session. The 

main choices are Creating Blank Presentation or Opening an Existing Presentation. 

The first option in the PowerPoint dialog box under Create a new presentation using is the 

AutoContent Wizard. The AutoContent wizard is a guide composed of several screens that help you to 

create a professional presentation quickly and easily. It basically takes you through series of questions. 

You can choose options to create a good presentation. 

The steps to create a presentation using the AutoContent Wizard are: 

8. Select the AutoContent Wizard option from the PowerPoint dialog box. A dialog box as shown in 

the figure is displayed. 

The AutoContent Wizard can create 8 to 12 slides with suggested content that you can change. 

9.  Click on the Next Button. 

A dialog box as shown in the figure is displayed. 
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Press a category button for the type of presentation you are going to create and then select the 

presentation that best suits your need. 

10. Select the Presentation style in the Next screen as shown: 

The given screen shown on next page helps choose the type of output you will be using and the wizard 

will select the best color scheme for your presentation. You can change the look of your presentation by 

applying other color schemes available in the format menu. 

7. Enter data into each text box and click on the Next Button. 
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The information entered by you will be put into the presentation by the wizard for you. You can always 

change this information later. 

4. The Next screen will end the AutoContent Wizard and in turn your presentation will be created as 

shown below. 

 

 

 

 

 

 

 

The Presentation Created by the wizard for you will be seen in the Normal view as displayed in the 

figure below. 
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3.4 POWERPOINT VIEWS 

Microsoft Power Point comes with different views to help you while you are creating a presentation. The 

two main views you can use in PowerPoint are normal view and slide sorter view. To easily switch 

between views, you click the buttons at the lower left of the PowerPoint window. 

 

 

 

 

Normal View 

Normal view contains three panes: the outline pane, the slide pane, and the notes pane. These panes let 

you work on all aspects of your presentation in one place. You can adjust the size of different panes by 

dragging the pane borders. 

Outline pane 

Presentation in normal view 
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Notes pane 

Outline Pane: Use the outline pane to organize and develop the content of your presentation. You can 

type all of the text of your presentation and rearrange bullet points, paragraphs, and slides in this pane. 

Slide Pane: In the slide pane, you can see how your text looks on each slide. You can add graphics, 

movies, and sounds, create hyperlinks, and add animations to individual slides. 

Notes Pane: The notes pane lets you add your speaker notes or information you want to share with the 

audience. If you want to insert graphics in your notes, you must add the notes in notes page view. 

These three panes are also displayed when you save your presentation as a Web page. The only 

difference is that the outline pane displays a table of contents so that you can navigate through your 

presentation. 

Slide Sorter View 

In slide sorter view, you can see all the slides in your presentation on screen at the same time, 

displayed in miniature. This makes it easy to add, delete, and move slides, add timings, and select 

animated transitions for moving from slide to slide. You can also preview animations on multiple 

slides by selecting the slides you want to preview and then clicking Animation Preview on the Slide 

Show menu. 

At any time while you are creating your presentation, you can start your slide show and preview your 

presentation by clicking Slide Show. 

 

 

 

Slide 

 

Sorter 
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toolbar 

Presentation in Slide Sorter View 

Change the Size to the Panes in Normal View 

Do one of the following: 

6. To change the size of a pane in normal view, drag the right border of the outline pane or the top 

border of the notes pane. 

7. At the lower left of the PowerPoint window, click Outline View to enlarge the outline pane or 

click Slide View to enlarge the slide pane. 

What Happen to Slide View and Outline View? 

Slide view and outline view have been combined in normal view. 

If you would like to use the old slide or outline view, you can add the command to a menu or toolbar. 

(v) On the Tools menu, click Customize, and then click the Commands tab. 

(vi) In the Categories box, click View. 

(e) Drag the Outline or Slide command from the Commands box to the menu or toolbar you want to 

add it to. 

If you are adding the command to a menu, when the menu displays a list of commands, point to where 

you want the command to appear, and then release the mouse. 

Student Activity 1 

6. What is power point? 

7. Describe various components of a power point screen. 

8. How will you create a presentation using Auto content wizard? 

9. Describe various views available in power point. 

3.5 CREATING A PRESENTATION USING A TEMPLATE 

A presentation template is a saved presentation file that contains predefined slide and title masters, color 
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schemes and graphic elements. The presentation templates also includes masters with pre-formatted 

fonts and styles. 

The steps to apply a template to a new presentation are: 

12. Select the Template option from the PowerPoint opening dialog box. The following screen 

appears. 

 

 

 

 

 

 

 

13. Click on the Design Template tab to display various design templates. 

 

 

 

 

 

 

 

 

 

(j) Select the template and click on the OK button to activate the template. The New Slide box is 

displayed as shown in the figure below. 
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(d) Select the layout from the New Slide dialog box and click OK button. A slide 

as shown in the figure below will be displayed 

 

 

 

 

 

 

 

 

 

 

Template is a general term used for a pattern, which will remain same throughout the Presentation. 

All the slides will have the same background as selected by you. 

3.6 CREATING A BLANK PRESENTATION 
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The third option in the PowerPoint dialog box is creating a blank presentation. The steps in creating a 

blank presentation are as follows: 

(d) Select the New option from the File menu. The New Presentation dialog box is displayed. 

(e) Select the General tab and double - click on the Blank Presentation icon. The New slide dialog 

box is displayed. 

(f) Select the suitable layout and click on the OK button. 

A slide as shown in the figure will be displayed. 

 

 

 

 

 

 

 

 

3.7 OPENING AN EXISTING PRESENTATION 

The steps to open an existing presentation are: 

(j) Select the Open an existing presentation from the PowerPoint dialog box. The list given below 

activates. You can select from the list provided to you or you can select from the Open dialog box as 

shown below. 
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d) Select the appropriate drive and folder. 

e) Type the name of PowerPoint file to be opened in the File name text box or select a file name 

from the list. 

f) Click on the Open button. 

3.8 DISPLAYING THE SLIDES 

There are several ways to navigate from slide to slide when you are editing your presentation. The 

method you choose depends on what view is currently active. The Keyboard or the Mouse can be used 

to navigate through the slides whichever you find easy to use. 

Using the Keyboard 

To navigate through the slides in your presentation, employ the shortcut keys listed in the Table 8.1. 

Using the Mouse 

You can also use the mouse to scroll through your presentation. In the Normal, Slide, and Note page 

views, the vertical scrollbar also contains Previous Slides and Next Slide buttons. You can click the 

buttons to move to the previous or next slide. 
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Table 3.1 

 

  

 

 

3.9 SAVING A PRESENTATION 

You can save the presentation you're working on - whether it's new or you've saved it before - and you 

can also save a copy of it with a different name or at a different location. You can save any presentation 

in HTML format so that it can be viewed on the Internet. You can also save a presentation so that 

whenever you open it, it always starts as a slide show. 

The steps to save a presentation are: 

(h) Select Save from the File menu. or 

press Ctrl + S 

The Save dialog box is displayed as shown in figure below. 

 

 

 

 

 

 

 

• Enter the File name when the Save button gets activated. 

• Click the Save button.  

3.10 CLOSING A PRESENTATION 
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To close a presentation, select the Close option from the file menu. If the current file is unsaved, 

Power Point will display a dialog box with Yes/No options. Select Yes if you want to save the file, 

No if you do not want to save the file or Cancel to return to your file without saving it. 

Student Activity 2 

• Write a step wise procedure to create a presentation using a template. 

• Write a step wise procedure to create a blank presentation. 

• How will you open an existing presentation? 

• How will display the slides of a presentation? 

• How will you save a presentation? 

• How will you close a presentation? 

3.11 SUMMARY 

The application software that can professional looking visual aids is called presentation. Graphics 

software. MS-Power point can be started by clicking at start programs Microsoft power point. A slide 

can contain one or more of these component: Titles, Graphs, Drawing objects, clipart and pictures. The 

slide components that are used for reference are: Handouts note, on lines. A new presentation can be 

created through one of these methods: (i) Auto content Wizard (ii) Blank presentation. A new slide can 

be added by either clicking at common tasks option of formatting toolbar, and then selecting new slide 

option, by clicking at insert menu’s new slide option. A presentation in power point can be viewed in any 

of these views. Normal, outline slide, slide sorter, slide shows and notes page views. 

3.12 KEYWORDS 

Design Template: A set containing graphics design and color scheme of a presentation. 

Handouts: Compressed versions of the slides in a presentation. 

Outlines: Summarized version of slides, that contain only tiles and main text. 

Presentation Graphics Software: A software that lets one create professional electronic presentation. 

Slide: An electronic page in electronic presentation 
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Slide Show: Electronic presentation that can run on computer screen or a protection device. 

Speakers' Notes: Small images of slides along with explanatory notes. 

3.13 REVIEW QUESTIONS 

Unsolved Questions 

• Fill in the blanks: 

Power point is a ____software. 

The ____is a guide that help you to create a professional presentation quickly and easily. 

The normal view contains three panes:____,____and____. 

____view allows you to see all the slides in you presentation on screen at the same time. 

____is a pattern which will remain some throughout the presentation. 

(viii) State : True or False: 

The two main views of power point are normal view and slides sorter view. 

You can preview you presentation by clicking slide show. 

The presentation templates does not include masters with pre-formatted fonts and styles. 

The keyboard and the mouse can be used to navigate through the slides. 

Slide view and outline view have been combined slide-sorter view. 

Unsolved Answers 

• (a) Presentation (b) Auto content wizard (c) The outline pane, the slide pane, the notes pane (d) 

Slide sorter (e) Template 

• (a) True (b) True (c) False (d) True (e) False 

Detailed Questions 

• What is a slide? 

• What is a slide show? 
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• What is an outline view of slide? 

• Describe various panes of slide in normal view. 

• How will you open an existing presentation? 

• What are the basic components of a slide? 

• What is the use of slide sorter view in power point? 

• In which pane can you insert speakers notes. 

3.14 FURTHER READINGS 

K.K. Shahjahan, MS-Office, Excel Books. 

Sanjeev Gupta, Shameena Gupta, Computer Aided Management (Using MS-Office 2003 Tools), 

Excel Books. 
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